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ATV THEDEE

Dorico 3.0 TEASNh-EHN A —IRarTo U #EeIC R OE av Ty
DU AEDEBREMNATHE. AT UV RITE®D Dorico DREICEEEE
BNET, CNICIEFEREA T arnlaryFoo 24 (Condensing) IO R—ThH
bATAVEEBLEY . FEKIAVTIIVIITL—TOIL—Y—%. 20T
DOV HERDBEROERICEDLSICEIY B TEINKFITIEETSHLLTE.C
NETO—DEDUBTHRITTEET,

ATV FEDERDER: OV TV AEDEBRIEREERTBICIE,
FEE-FICOYBAT. EENMTIEONAMEIZHEITATLERIRLET, FEIR
FHEDFEAVTUL T EINTEREDEDTHCTHERVFER A BEDREICHE
HETEZIVTUVUTHEDERERIE 1 DT, TN ETADEFERICIE,
FEEFLEIRTOAVTUOIVUT T L= LT T avdFFHarToiy
TOBREEERTCEFET  BULMEDTATLEZ 1 DBERLTHLIEE
(Engrave)l » a7 AEDEE (Condensing Change)1Z:ERLT. K
TOFATETERTIEET .

i

Notation Options

BAT7ATQERIZIEZ. TRTOAVTUI T IL—TNYRARRTENET 44
7O OERI. 5854 T a2 (Notation Options)1ETFEBITaAVYTYIVYT
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(Manual Condensing)l® 2 2O avIzahnhTWET , ARIOEADEY
avIZlE, ERDURNGEIRL-OV T oo T I —TFICRESN TSIV T
DUV REDERRABINRRIINET R ETIE. EDaVTUIUT T IL—
TSR ATar NBRESNTOVELVRED 2. A 4705 ORAITIETATOHD
UhA—LAEMICESTULVET,

AVTFUVU T N—TERRIZEDD: AT ULV HEDERERENIVT
VG N—TITERTAICIE. ERIQOURNTCAV T U T IIL—TEFRRL
TFIVIRYIREAVIILET AV T UV VT AERDERORRICOAV TV
TJION—TEEHBE AT aVITRBEREMALEA>1-ELTH, BIRLIHE
DEENSHLWNIL—AAFBENET, LY. TN EDT IV aVEET
BLLEKHET BV TUV T RRNBRONSEELHYET,

AT aVDEE: RHRICEHDAVTUIVT T IL—TERIRT BE. FOH
MCHMRREA T avE. OV TU U AR ERIEROMENSERTESE
Y. DR R TEMGREA T av(E, M4 T a2 (Notation Options) ID4
A7 CIA—IIRESNF=TIHILEDA T av B RMENDHESL. 70—0D
NKYBTDEEICER SNV TUO VT AEDERIRRESIEHINVTLSEG
BLHYET . TNENDOERIERTIE, BEA T avIicav Ty iL—7
CLICELHEEZHRETHILL ABLRELLENILLTESL . TOBRTEN
BATL AV NETHLR TSI HIE T B-DIC thDEFIRREERTHIEN
WEISENHYET,

ZTOHRTENGA T avDEEZ LEZTLHICE, JRUBEAF T avOEADR
AVFEFUIZLET, TJtYh (Reset) IZ:ERL T, fLikAToav a4 T3
> (Notation Options) IDFAF7RAY THEEL-IA—DTI+ILMEICR T M. TE
E (Change)l&#&IRLT. 2OV TV 0 L—TIZHLIMEFIRELET .

LPE—.2N

[E25kA 7> 3> (Notation Options) IDIMaAYF 24 (Condensing)IDR—J(Z
HBIA T AV ERLEDOMNa T VT HEDERE (Condensing Change) IS
AT7ATICERRENFT O WEEDFRANOOELY | LYUFRICEHINFET,
FEg}TALTIIUY FEHTAVT UV TR AVTUI VT TN—T DRI
—V—IZDWT. AVTUI VT EN-REROEDFER (RFEA LRAEEIETR
E) ICEIY L TEMNMEETEET . CNICIF—FEDRHREHENHY . ChdiF-ch
TWVEWRETIE, IV T UV VT AEDERFATOIEHETEEE A,
RERE ATV TN—TIZRTHTRTOTL—YV—HrEROLT hh
DESICEY L TONTVIRELNHYFET  ALEROFTEN LRAZOFEERICT
L—Y—D4KEd 1 ANFEYVETOATUOETNIE, FRENTRZOFEIZTL
— Y —%2EYLTHRILETEF A ATV IT T IL—TIZET HTL—F—
#HELEEDHMODERTERTEZT A AVTUVVITIL—TIZELTWVENTL
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—V—%EYVETEHILETEFE R A, DFY. TL—V—FELGZaVTUIUT T
W—THEBBTEEFLEA, ALEBROTRDIV T VT TIV—T TR avTy
DU ENIRERDOBIIERTET  FTIL—Vv—mar 7o ShiziERH
SRADAVTUS VT INFRERICEHTHILL LEPAKREDERICESILEL
TEFEH A,
HEDORBMNBLIERLGIEROBNVELLDIFEIV T VT EEELE
B.COAVTUL VT DEBRFIROEERVIVETHRSBENE R A 3BHA.
ATV REDOEREREFACMEICHBERVIVEER T HILT, FHLLVE
ROBHDELICEMILGLES8HTHIELTEET,
FEAVTUVVIERETAICIE . AT VS BEDZEE (Condensing
Change) |O& A4 7R OIFETIAV T4 (Manual Condensing) 933>
<. layFov24 A% (Condensing approach) IO D RAA v FEFIZLET,
a2 72207 L%L (No Condensing)IZ18ES HE. ZDAVTUIUT T IL—
TDaAVTUL VT EEBIRTDOAME (F-IERODMERYIY) M4 TIZTEET,
MJ&vhk (Reset)IxEET 5L, BV TUV VT DERICEREET . FEITHE
LEBADEYLTEHITEETSEEIE. FRITIVTOYYY (Manual
Condensing)IZEELET,

[FB)TaL T4 (Manual Condensing)lZ:&IRd &, avToivd 5L
— BT 2T — VD TOERDYRNIRREINET . FA(T7ATEHEELT
AVTUVU T AEDERETREERTHEHIZIK. TIL—T0eTIL—v—%4
BIVRFDERDOFEEICEYHTT, ERIDIVRANEEICTILELHYET,

Manual Condensing

Condensing Approach No Condensing

Trombone 2

Trombone 3

ERIDVARDTL—Y—%FIRL. 2 DOYRMAIZH B> R2VEBLT, TL—
Y—ZBIRLEFEICEY B TEHD BIRLERICEIVETED, (COHEE. TOD
EROFENLAZOEMICENWVETONED), FEERIOURADRIDFE

[CEYHTET (COBEL. TOHROFEN LAEOFHICEIYETOAET).
BRIOVRAMIEZERNFELLGEVGE(E ERNMERSH ., ZDEROFEN
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LREQEBISTL—r—HEY L TORET,

BRIDYRNDTOTI3avN—DRIVEFERTHE FERODIEM, EROHIRR
(EDERICEIVETONTL—V—RBIRTERDYRMIRYFET), Ff=(3:#
RUETL—VY—DHIR (RARICEDTL—VY—ZERIDVAMIRLEY) HT14
AFEY,

FEHALTUVUTERET HE TNDNEEELTEERFALLDITAAIE IRE
L= DFEORAEITEINES  ALERICEVETEIL—V—0D56. HFEA
THEEZOFMICET SO (BEHNNSL) TL—V—OFH. FENLAESE
DEFICBITATED (FSHKEV) TL—V—DEFFELYLITRYRLELND
BETH->TH MEDOEEGFRCERIZOUTUI VT INET  SBIT.2D 2 D
DTL—V—%2RLERORLERICEYLTHIBE., ThOoDEETE—DFER
[CERESN. TL—V— 2 TR HERIETL—V— 1 IZETHEFD LIZRRE
NEJ RAKRIC, ALERORLERICERLS)ALEFODTL—V—ZEY LT
B8 ENoDEFITE—DFEICEE NGO, EHDI/DMERSNLIED
BIFBITHEADAKLEDIGEENHYET .
FHAUTUOLUTIZEBVERENEZON TSRO EEIZEAL TS,
BEWRGLEREZTLEI L BERGHERENYDNRIRENET, Dorico O HENLE
FRFHTY D, HoWHKRTHNM PIBERSZLECT EABRISNTNE
T LOLFEAVTUL VT EFERTHE. OMVITKEBRERERIBZIZELN
TLEWFET,

ATV HEDERIEROFERICIILEIREEZHL. BETIHAIL. R
BNAHEREBILTRINEDERICEEDHDIIEESTTOLET BIcav Ty
DG N—TERRICEDIIEFICEED . AT AV DEECFEOV TV
TJOEEFTEOLLBENIELHLTAHA T ZEN, BEDZDOHAETHLLVIL—X
ZRRT 5111 T R EBLGHERE/I-OICTHAHIEELHYET,
BEDAVTUV VT HEDERERE: AVT U VI AEDERIA 7O %
EFHEMBED—BLOERD LICHAFARTEINET BFEOITUIUT
FEDEBRERETHICIE BICHAREZ T LI DT ED . HAFEERLT
[Return] ZLFET, AV TP UI HEDERZRIRT HIZIE. HAFEEIRLT
[Delete] Z#LFET

FRMDAV TS DRER: Dorico 3.1 TIE, ZDMLNOADHENILT
DUV HREICIMASONTULWVET , TNBIZDWTODERSEH (X 20 R—UFS LT
Sy,

MEmmEL—Y
MBI ENBEAMENRIESNELE, ChICITEENDABREE. EAXRBR
F.BLUA VY - T Ir—FOREMNARBESOEHBENEEFNF T S5
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= BEE—RIHICRBREL VA BMENELT, ChISEYBRBOEEA
BRIBITA o TIRTY SO AILISREN, BELTEET,

BBUSL—VERT: BBL—VERTT BTG, ETBET—FITGYEL, R
ISRBOREEITHIA RS LA MNSYIERBALET . BikIc ER R %Y
Uy Bl BBREL—VARTENET,

‘ ik T |
ot s - *pp

tROBWVE TR RSNIEEE. E—DBRBOEILLIMRES LIFTEHELZE
LTWET 1 DODBEEIFET / DSTHILTADILYITURERL, RLVTRT
FIWIFUR AvY T TA—F W T RRIFET =V EADTAIXIUR
LRYET,

BIBBELANILEZOB TEILSEIREMEBES . L—UICB L TIEASS
BRED 1 DORAUNTRIRSINET . TN TN DEEICITABREERET 5
BETHEFRAMIEDEINILMFNTNSZLIZHEFRLTIEZSW, ChITKYEEE L
DEUBFEBELLILEYET,

B SL—UITIE ERICSERINLABERRL-LDOARTENET . Chld
KWRICESTIK, BBEE—FICKRTENSEBILBEEREICIE—BLEMGENHY
FI,. HICERIICEBESZEYETEEES. CALIEBEERICE 1 EybD &5
ELTREENFT . TNETNOFHORBELENICEHETILELNHDIGE. £
DAVARYILAV S TEEROERMBEZA ML TIZSLY,

BRAEDHRBILSDOHESE: BEE—FDORBLSL— U TRBRERETHLT. T
ADIIMDBEEHRABTEFT . EAILRBEHRIBILS ORBME DR T AL
B, FFAY T TA—FIOHRRGEEDRBLAILICH T HRET, SLEE
—FDBRBRESONRICEHELEFE A LML, FEX AV YT TA—FID
BRTHE. FRRTHNYF7UROBIBAIRERES DUERE . REDEIEDH
BITH I 5mEIL, BB E—FTRTENIRBESDUNESSUVRSICEEEZS
AFET . WMOT EAILEBEFTDET /ITHIGT HRAUME EITRSVTT5HE.
BAERDOBBLALEZEBMSEDHLFITEETN, A7 LDOERBESDIHEIC
EEEHYEE A,

BREELAILIE -6 (/) D 6 (RK) DDLU TRESN, 0 [FAYTHILTIZHIE
LET, BBRESL—VFROEWVERET -3 (ppp) M5 3 (M) DL THEAS
N NN DOFERFEEMEONLUDICIEK L=V L TORVEERENERSNET,

L—RATRAVNELETITRSY T $5E BEDBBLANILNRAULDBERIZEK
TENFEY,

RIS I TRICERLGDHETHRELET,
= SEHIREBEES: LTITFSVIT45L BAERDBRBLANILHAEESNET A,
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REE—FORBRESORTIIBBLELA. EHICERSYI TEEEA
BBIIE [Al] ERLEHSEEDRAF—EHALET).

EPERAES5RE S PR BEFE IR THEE L TICFSY/ 35L& HRLETE
IR TREOBEROEBLAILLERSNETA., LEE—FDOEBRES
DRTRIZIEFELFRA FIREBIEERICRSYI TEEFRHAN L TNAUR
IWEEIZRSYI LT, BB RBLAIICEDZETERLT HILETEEY
(BTHREICRBURBESHHEETIEE. TNIYEITR T /NAUFILEEE)
IEBILIETEERA), BIEHIEBREEDHEICREMRB LS I RIEE.
BREAEBREE DR TREDBRBLANLERELTL, BEMNAEBTES DA
LARLIEFEESNFER A,

AyH T TA—F T AvY T JA—FIORBMHEDRIBL AL, &
[2H5ATT HRBLANIICE LGS -OMETEEEAN. JLYI IV RDLT
1EXIVFFERFZTOFOHEAEDLEDOFR A BLURTHREFELLE.
ETFICRSYI L THBE LOBBLALERETEET AV YT Jr—Fz
DHPJEB IR TREIX. VTNEERIRSYI LTHBERETEET,
COmMEFREE—FDEBESONRICEEEEZFT .

SRBDIRTIES: BBORBESICIE. WETELRAUM 4 DHYFET 8
BHDIEFFL AL, KEWADEBLAILIZEAMNI LFE, KEWLAFDEFLA
LV HYDIRFBLANILICAN S TR DOBRRAU M ZLTRHOY DREE
LAIVIZEIZET D RAURTY 8O DIRBLANILDORAUMIETIZFSYIL
THRETEET, CNIERDYDBBLARIVICHLEELFT . LEBO®REI
THRBOTOVNWTNHODRAULELETIZRSYST F5E KEWADRFLA
IWERETEET . LRSIV TERNOMBNELR TREDRIUIMES
[CRSYT 3 5L BRBDRBIEENOBELOEILOMKRERETEET . CO
REICKVEB T FDOBERBESONEANEEINLLEIHYFELA. BBD
BB ORBAEEX. ZRICFSYIT LTOBEETEEEA (BEICIE [AlY]
LGNS EBEDORMNF—EFEALEY).

EAXRBES: #HEXRBILESICIL. BETELRAU 3 DHYET 1A
HDRBLAIL RO DEBLAILHSEHOYDRBLARLICAN>TLERSE
T TRERIET 2RIV ZLTRHOYDEBLANILTYT , RIDABLA
ILELUBRDLYDEBLARILIE, ETFICRSYS LTHRETEET . EARES
B DRBMEIX. EAICFSYI LTOBEIEITEEEA BN [Al] =i
LENSEEDRENF—%2EALET). LOALERFIETEORMIBRA M
BHOYDBRBLALIE, ELLLERIZRSYI LT TEET ., LRFEET
BOBRBRAUE, BHYDBRBLANILKYEEICIERS YT TEFBAD. F
CHRIEBICFS YT LCIREMAEILICTHIEIETEET R TREDRAUME,
FRFEIR LD RDABESTLYVEETIERIVI TEE R A,
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AT TE—F I BBORBRS BLURERUBRESOTRAOMEE
FUMACHRET BITIE, R—LALT, KYBLUR LT YR O EERELTH:
IO

BAERDOADIEBZEM: CCETIFIAT, ELEE—FRTESNS, DFEYHIRF
LI-EEEICHENSBBESOHRERICOVTHRRTELLEN BEE—RTE. BE
[CIERBREN THEEIZFIRRSNGNEBFEEMT HELTEFY,

MEY—ILEFERATHE BBEEL—VITHBEI)—N\URTESADHFET .

HRAREVERLEEEL—VISR>THIZTRA U A—%8MN T & BBLETRTD

DXLT)YRDRTUBIZHRDEBRA DB EASINET , A hZIEDO BT,
DALT YR DR G EEBYGEICHRELTEEELLS, EIRE TIE. KL

RAVMEI—FEDRBERIFLET (ABRLEDORODKRAUPETRLEBLANILE

REET) LALRAUEEERLTHEIVYIDIAVTF AN AZ 2 =D RDAR

UhETERENIZZERE (Make Points Linear) 1% E{R3 52T, REELEILIZE

BHTEET (BHBRORDKRAUMZAN>TEBKRICEOHSNIZEEHLES).

SAY—IVEHRYHE FIBMEZY )y IL TR TMEE TSV T 3417 T,
HRHRBFMNORDIEFZFETODEREMLIRBOBITEANTEET  MIHARETIL.
FIARA U MIEBERMAICEILSE BT RAUMNEI—EDRBERFELET .
LWL, BBEREDMDRAUEERE. CABFEIIVIDIAVTHFRAMMZ1—%
ERALTEETEET,

REE—RCTANLIABREEEZRMT HIEBRLEORAUMNE BEE—FDORE
Y—IVEIESAY—ILEFERLTEBMLIZ RS VNI EEEShDE BE LD
BELVET,
BAEE—FOL—UREICETE—EICRIFORAEEBERHICEREDRAUMC
DWVTOFMIE, 27 R—UESRBL TS,
BMPBDRBIEEHLUREES R EBHREDHELE: Dorico TlE, BEDRB{BILE (RT
FIWIFUREGE) BIVHEERXRIBELS (FAILTET/IHE) NEEMICELEICR
BREN DKo = EbIT, AvY - To T+ —F O ERERAREREMNELIR
BENDELSITHYELTz (IB/N—230 T, BB ICKAIEIEDRIF LMBAIC
RMENFERBATLE), FLRI7ALVY7ORFOBERKIC. BERDESRRE
Ipt.sforzando JZ#H D TESKSICHYEL Iz, CDEH. HUTILSA4TSF)—IZX
THIVIFURDBERBENEFEFNTVDEZEIF. TIVRT Ly avwyTaERAL
TENERITTEET,
FERBELURIILTOEBES: MBSV EDK, f2E2E/3—Hviarn
—LDESITEHRDOENMERICRIHF—SINBEDTTH ., TOBEERFICEENE
BESHNELLRBEINSELSITHYELT,

BT EDRIE
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Dorico 3.1 Tl&, ALK DHFESIUVHMELAZABEMNEXABIMTHT=HD
BEDY—ILABASINELT,

BIRU-FEIENZA 5 FTENEMTH5/EEZE 1 DFLITEHEIRLT,
%% (Edit)] » T8 (Notehead)] » THIEPWELIYE X (Toggle Round
Brackets) Z - (XM BEMEYIVE X (Toggle Square Brackets)1Z#ERLET .
CDA-2—THEZHERICFERTLEE L. [RERTE (Preferences)iDF (470
J DI x—IR—KFL3—kAyk (Key Commands)|DR— T, ChbDAZ1—IF
BICF—HR—F2a—brhvbEBlYBTEHIENTEET,

HHIWNIE. TaNTFanRR)LIZEMESN-TIEMFZ=DRHFE (Bracketed
Noteheads)17 IL—F DFHLWLTO/TATHEIRXRA )L (Bracket style)1Z&4 I
LTIk (Round)lE7IEMMUA (Square) ] OWLWT A EEIRTHZET. ERLRIA
TOFENERRTEET,

MBEITEMZM T2 MBFEER Y DFBEICIERIFEMEFFonFT, 2FYL
BITIWCTHEDNSS 1 FEFICHEIMZEMITHENSICELTETY . MIEEARICHE
MERTBICE, FTMBFEERT AT A TOFELERLES . T OERETD
EEAROBERICE>T. MEEKIC 1 HOFENEERY . FlE 2 HULD
EIlZEROH V- RETHERTEANE THANNBBRIICHIBENET,

COBOEMEIL. FEA T avIicEmESn=T{FIl{E=DHHFEE (Bracketed
Noteheads)IDR— DI EBE A RO (Vertical Extent) 129 3av(2Hd14T
La TE—DENEERT5HKAETE n B (Use single bracket for intervals
up to and including n staff positions)JIZ&k>TEEINET, MHPRETIECH
(X 8 E.DFY 1A VF—TIZRESNTLWET,

FRHEHMICENES T55E81E. HFLWMELO—B TIZRSHEEZRIRLT. 7
0/874/3% )L DT EIR{FZE D FFEE (Bracketed Noteheads) 7 /L—F TlEI%E S
&l (Break bracket)1Z#IZLET,

BATOEIN-BEFITEMETT5: ZATOLEHANEZBERFDSL 1 DOFELT
[CHEMZEF T ENTELGLTIIE S =6 FEITEIMZFTHIATURE HFEE
—FTIEERFDOFEDH . SLEE—FTIELERLIZAMDDENY DR YID FFEE
DHAHZHIRIHBYET  LOLESZIZIE, ZATOLINFELEICHL 1 HOE
MEFERATIENBELRIEELHYET  COEEE. TO/NT/IRILOTFRF
D FFEE (Bracketed Noteheads) |V IL—TTIRLDDENRYDETHEETD
&30 (Bracket until end of tie chain)1ZA4 > ICLET . kY. FALHBIDHEIR
DEADDENYDREDFEORICEESNET,

BIREMEDRE: AENSSVAEINTSEEET—FTERHICHEETEET AE
MZEIRT HE. 3 DDNURILARTENES , LTFDNVRLTIHIENDEES
MOHEERHTTE EAFDN\UFLTREROA—TOEESVERETEET,
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ETFTDONUFILIE [AI] ZHLGEALC ETOXRNF—2FERATHLEB8HTE. EA
FDNUFILIE [AI] ZRLENCEADRHNF—ZFAL TR TEET, [Tab]
I EBRPONINLENYBZONET . chITHL, AIEINERRLIZEER
RENBNVEILIEETD 2 DT CHFEELROEHEZREHTITHLD T,

RBRIME2AEZBETHICIE. TONRTANARILOTNFERAEDFFEE (Bracketed
Noteheads)1DJ IL—T T, IEFEMART ¢ (L bracket body) IF =L HIFEMART
4 (R bracket body)1D 70/ T4Z&ERALET,

BEAFTay: BEA T avIicEMEShzIBlFFZDRFE (Bracketed
Noteheads)|DAR—(Z(E, FFEDAENMS FUAEINOBIENLEA T avh A
BEINTOWET, ERELEEICRESNELED, FEMOARSORAKDRE
WELRDHEIZIE. TFHAY (Design) o arDA T a &R L TS,

STEDIFIAEDFHE: FI—RAOREEREDEREFITEDOMATRRLT
WBHEEITERITEINZE[ 5L BIRPDRRIATIZOAEMARIRENET
BTEDILVIESEERLTVSGE . FIMFSTEICOABRSNES  FE
DERODEFEERLTVDIGE . FFIRIIREDEROAISERASNTT

RTETHMELAREZAFENTIEDIGE. TLTADOILYIESICEB OEINE XK
TYHEL. MBERICL DOREGITFENMZERATEHELTEET . L FE
AT arvDIERMAEDOHTE (Bracketed Noteheads) IDR—S DIFHALY
(Design) 1222 avIcHh b3 TEOE—DILYFESICERIN S HIENDO MR
(Round bracket appearance for single fret numbers in tablature) 1Z{#EHLZE
ED

BERBIVEER

Dorico 3.1 TI. 3 D TAUEER T 5= DR NEFHBEENBAShELS -,
EROBIZMCEERR (TIRCAREDISICERE). B0 A AIEIEmAENIZfF
CRHR (TIV B RDESICERE). TLTERRO LT HHINIERADEESNT-
MEBICHERBE CTEEERTT . oD Y—ILOBEEERET DL SHIZEFK
REETERDLIIHYET,

KEMZIE, Dorico [THEITHREFEE., DFYEENDHENMEIZHFEL. £
DEEBEDERFLEIHMEICHLTEREESNDILDE, KFE, DFEYHEDLEI, SIA
FYBDRBTEDLZLD. ZOVWThh—HERGESNET,

SAUINRIL: RBEE—FITHISSAU R BINESNELE, ZO/SRILIEE
BlOY—ILKRYIZAD OV TBHIETHRITET . SR ILIKTKE
(Horizontal) J&TEE (Vertical) 1D 2 DDEILavIZHEIShTWVET [BE
(Vertical) JZo>avIZld. 1 DOERFIIERDERICELNENETDREIZFH<
BIIOREAFEEHTIROH SN TET, [KFE (Horizontal) 1 2o avIZlE, 5
DOETFEEIEINEL HENEEFOFAIELFEAIFSETORE, 200>
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AUBEEHTROENTNET

EEROER L DDEROE—DEHOMBICEEREIERT HICIE. BEEKE
EBMTHHED 1 DUEDBFEERLT. S/ ARIILOIEE (Vertical) 1ty
Lavho ERTEIIVDEEEV)VILET . SAVITEBMICHBEOEEE
TRCEHHBEICIWRDET

1 DDERD 2 DOFEHIHIN-BEROMNEZHEAICINHLIEEREZERT S
[CIE RRETHEFRHID 1 DULDEFFEERLT. HHT I/ DIEEEY
JyILET . FAVIEBIRPORYVDOUEIERESN. MADERICET HMED
BREIANTZEHBEICIROFT

BHOERICELDDIEEREERTDICE. —BLOEROELICETIEN
#R®IRL T, [Ctrl] (Windows) Ff=IE [Command] (Mac) ZILIEAL—F T D
ROFEICEISDEREVIVILTGERL. BRI SV DEEEVVILET,
BRUEROMBLHBEICIRDDTAVUDNMERSINE T, TAUNENDHERD
BIZHIR EHL. BHEDIAVARIIILAVMNIE T HHEREEDONET N, BL15T
L—V—IZB T DIV AIIILAVMIEOONEE A,

EEROGBE O MPRETE. BEEREEITTNAET S 1 DFLIEER
DEDROINEDOERET TR TEEEAICNDET . IBFDERFTSIUEBRHLED
BE. TANTNRRILIEMSNIZ-TEER (Vertical Lines)IDT IL—TIZH B
I EER4 (Top position)1FE =X FE4S (Bottom position) D TANTAEFA I
LET. D 2 2OTANT4IE, BEHKED LIHS LV TEHDT IAILMIEN LD
ENLEDERMBERLET, =X LT LS (Top position) &2 )& mMEE 5
ETAVD LIRS NBORSE LYERME 2 D2, 2FY 1 AR—X LIZHKEIL
F9,

EEROMBVIE: FALEEMEICHEBOEERETIERLIZBE. ThLARTRIN
ZENLEICHAIITTOIEEZ. TO/NTANRIILOTEER (Vertical Lines)1DT
IW—TI2&HATF] (Column) IOTANTATERBTEET, 01N —FBLEAIT. HIE
NENBIZEERICIEELIBELET .

KIS FHEEER: VHRETIE. EMERNETIIEFICEERTRTT L.
EEREERTFOARICERESNET A TEHEFFMD 5> (Line before
grace notes)|ZAUICT 5L BEERAZDMEICHDIT N TOEMEFLY LA
[CREILET .

FERICTIRANEZEM: BEERICTIRANCTEREZ G T20ELHSHHEES. TON
TA4IRILDTEELR (Vertical Lines)IDT IL—FTIFF R (Text) IO TH/ T«
EAUICLT FAVIZRRT BT HFARAMEAILEY . THFAMIEITERERDO I+
k (Vertical Line Font) 1M 74> b RAALILHMERSN ., ChlEl%F (Engrave)] »
[T RRBL)IV (Font Styles) ITHRETEFE T, MIHARETIE. THFRAMIZ1Y
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RFAISHLTKEF AR RFZ SN, THSEICRRESNET,

TXRANDKEMBEZERELT, SAVRTADERFFHAIZRRESE DI,
[FXRAFDEIE (Text position)IDTONTF4ZEFUIZLTIE (Left)1Ff=ETH
(Right)JZZIRLET . TXRAMDRIEERER (EMNSTITERR) SEBHICIE TRE
(Reverse)1&xAUICLET , COTO/NRTAIZIE, FAVITRIGD X v T HDIHE
F. TNEREGSEIDMRLHBYFET . EALLRAZTDOXRHNDIGE . RizSE 5L
THREDXMIZEHDYET,

EERONBOLEE: EEROEHEFAO—EYLMIRAESNTOEEAM,
FAVRT A ERIED Ty TE LEETHILEITEY . NEREKRIBICTHRITAXTE
FY,

FAVRTA (FAVDRAEEGDEEES) 2 LEZTBITIE. TONRTA/IRILD
FEEE (Vertical Lines)IDY IL—TTISLURT4AXE4IL (Line body style)]
EAVICLT. BRSNS VNI DDAV REAIVERIRLET

FAOOFEIFEEEEA TR vy TEEREEEBMT B2, TBRMLEDFvy
7 (Start cap)l (GAVDTRIA. REESNhTWSIHE (E#) EIEMBROF vy
(End cap)l (GA> O LBIA) OFTANTF1EAUICLT, AEShIzFhc T b
DI7vY K., F=IEEILRERIRLET,

HEEROIER: HMEBERZERT HRTIZE. TKFE (Horizontal) 203> LERD#
IO — L TERT BRI TERELET.

ENDBDIEIZ. SAVDEIHENENITUTD 3 20FTLavhHYFET,

=  FEAICECEE (Attach to notehead): ChERBIRLI-BIOSA VL HEEFRAELT
SEUEBICEREINET MV OFBRAITIE. S/ D EmIFIEOE RN SH
1aL. A0 DRIHAITIE. SV DEHNFEOER TR TLET . 100
IHARESNI-FEDERMENELDIE. SV DRIEDMELRERICED
YET,

= IMERERICERE (FIARTRELIG]) (Attach to barline (where available)): Th#
BIRTDE 10DV T O DIHANEHRER LI EBIZHEBEE . TDLRED
ER.ANE. FEARFOERLO SRR FELIEERITRT $5DTEAGL 54
D DIHANEHRICHIZSNET

»  DXLODOEEIZEE (Attach to rhythmic position): ShzEZIRLERIDS 1>
DiilE. ACHLEDEF. T, FEIAKRFOERMMILMBFEILEEZRTERTL
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ES

LROFTavE SAVEERT HRNGERT DV ENHYET . ROT7 LOER
FOIAVEERLTAT L avE2ZBL LR LK ZEEARBEN DD FRI
ER T BMUIZRYET,

[FFEEICECE (Attach to notehead)1ZFEIRLTWDIEE. SAUEEE T HFEEE
EIRLT (HEEFENENELGDIER. BULHER. BEGDMVAMyILAVMIEL
TOWTERXRTIN, ALTL—FV—ICEY B TONTULBRELHYET). FH
TEHZAVDFEEE /AR VILET , FRBAIOmARFEEICH Do h # i
(FHROFENTWNVEWSAUEERLIZIGE . AR ETIESAUITKEISEY &
BEDERMEICRRVET,

INEIRFE (IR EDMEICRESN=54VICDONTIK, AV ZFRIRT SHEIZH
BT ATLE 1 DETRRT M. SAVDERTERSOMEIRDUEIZHET AT
LERBRTIMLT. ENDLERAT MV DEEE/ RNV ILETS,

BEROTIL—aVDER: LT FTHEERETERT L. MRS/
FILDRRENET . NURILEVIVILTRIVITHE. FAVDRRAEE L
TaAL—aVEERTEFET . MMOT AT LERK. [Alt] ZRLENSERD K
F—ZFEAL TSI 2 ARZRTRICHBETE, [Shift]+[Alt] ZHRLEGALER DK
F—EFERALTIIODTAL—aVE EBTEET,

BEEOEEMEDEE: MHKE G, RIS DO TUOVEUOEBIRIIEE
DEICRBENES, SAVERRDTICRET BIZE., TONRT/RILOTHEE
#& (Horizontal Lines) 1M % JL—7 Tl & (Placement) IO T O/ T4%4 (LT,
[T (Below) E = (XM Z DR (Inside staff) JOWVFRUNIHZELET, SA%
MR DOAA (Inside staff)JICERET D& DHARETIESAUMNE 3 fRICHRHF
ATCREREINFET . SAVDEEMEZ A DERMEICHENTHICIL, TBIRME
(Start position)IELUT T L& (End position) IDTONT4ZFAUIZLET &
RPDEFFICHRDITONTUOEIMERBOMEL., TF] (T#RE (Edit)] » TRER (7
YN IDTIHIEDF—HR—Fa3—rhvbh) ZLTUYBZ D EELTEET,
HERICE T 21EER: YHRETE, BEREERIRDOToh. TnAET 55k
RICOARTEINET N, ERICE T HEBRBERTEFS . -ELENEEFIC
BLET A LI TEY . ENDARTREINDIERD LICLHIEETETERE A HERICE
FEHIAEERT BICIE. [Alt] ZHLGALN\RIILHDFERT L1V DEEEY
JyILET,

BERORIHEOME: NMIRICEESN-EERIE VE—MENERZEDIL—IL
[CHWVFET . ENLDTIUDRIFD TV IEIRIE . ZII2HH/NETHRDIFLEIC
ST, BITPMEHRICSHLTELWMIBICEBESNET,

hIZHL VA LDMEICRESN-EERIE. FETIEE. 10 0RIKER
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CLEBIZHIEFPLHNELORMMBLEICEEINET , MHARETIE. 51>

FREDEFELIIMBFTOEERTERTLETA, Z5TIIELSGAUERDEFFI-

FFNBFOEMETHIETIHEE (L. TO/NT/IRILOTHEEHR (Horizontal Lines)

DT IW—TTIKEHL T ELIE (Horizontal end position) D FO/F4%ZFIZLT,
TRIZHSEFDERITR T (End immediately before following note) JIZEREL

F9,

BEROTIFIMIBEZRETHADICHERESNSG. BRICETHBERTEIL. &
ExXTavicEmEnt=-ISA42 (Lines) I DR—TITHZIET,
BHERICTRRMEEMN: BHERISTRRNCEREMF FI2RELAHDIHEE. TAN
T4/ IL DTSR (Vertical Lines)1D T IL—TTIFF Xk (Text) IO TH/ 8T+
EAUICLT FAVIZRTTBTHRARAMEANLEY . THFAMIEITERDO I+
k (Horizontal Line Font) IO 74 kXA ILHOMER S, CHLILli§8E (Engrave)l
» T4 RRXAA)L (Font Styles) I THRETEET . MEARETIEX. THFRAMESAV
RTAIZH L CEEARICHRBIVTRRINET,

THXRAFNDEEMEZZEELT. JA/VARTADLFLETICRRIEDICE. [TF
AFDALE (Text position)IDTANT1ZAIZLTIE (Above)1FEIEIT
(Below)1Z:#&RLFET

BERONMAD LBE: SAURT L (512 ORMELADKTHS) & LBET IS
(. FO/8F4/3R L DT HEHE#R (Horizontal Lines) DY IL—TTISAURT4R
24 )L (Line body style) 14 >ICLT, ABESN=FHLVTIHLDSAREA
WERRLET

SADRAIFEZIEEACxr vy T ERTEILEMTBICIE. TBIBREED Xy
7 (Start cap)] (A DE. REESNTWDIGE T#) F-ETRIFEOX vy
(End cap)l (A DA OTONT1EFUICLT AESh iR Thdh D
TvY K FERERERRLET,

BET—FTOIAIODHEE: BET—F T EHREEEROMIRICNAUEILN
Rneh, [Alt] ZRLENOXINF—Z2FEAL T, RinDLEZE BB A RIZHER
BTEET ([Ctrl]] £fzIZ [Command] F—%EBMT 5E. 1 DBENNEE KECT
EFEY) [Tab] 2EATEHE FAVBMHEBDN\IFILHASRFD/NANVEIL, ZELTSA
UIRTANEERZIRFICUIVEBZONE T FAURTA+ERIRP(I, [Alt] ZHHL%
DOXRIF—ZFALTIIUEREBBTEET,
ERFIROTONFAVDIAE—TURR—R I EFICROToN510 555K
DR DEEIZIE—TURR—RIF B2, AU DTENTLSEFEERL
TIAE—RICEDILELHYET,
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WER

ERRFRC S
BERF R B D AEIL: B SZAFEML T TRAKAIFEINTIRAN D ESIHYEL
=, TEGBFEEH (Accidental) IO T A/ T 4IZ(E, TR (Show) 1. IFERR (Hide)l.
IR3EI (Round brackets)IELUTHAIEI (Square brackets) |IDEIREMNTE
Fllz, FoN—FE=V XD FFEDERBESITOVLTE, [/\—FE=Y X (Harmonic)]
TIN—TDIEEEEE (Accidental) IO TO/NRTF4Z&FERAT5&. AIFME-ILAIE
IMCHESOHET

EXZRAEDTaLb—2ar DI — )L ERRORUBERLS: —BRITIEEICL 58
FEBDTaAL—2avDIL—ILICE T ARG E DA T av DY Tykhs,
HEATavDIBEES (Accidentals) IO R—JIZHBHTEF =R
(Modernist) 1DtV avIZiBmMENEL -,

= E—/IMRIZHZIRLEDAVE—T DOEF (Notes at a different octave within
the same bar)

= RONMIRIZHBIRLAV2—TDEF (Notes at the same octave in the
following bar)

» ROIMIRIZHIREDAV2—T DEF (Notes at a different octave in the
following bar)

NEDFHATLavITko>T, IV XD H K%t Durand Salabert Eschig | D#wkE
HARSAODEHEH =B DHIIILGYET,

7—T4Fal—ay

BRSNS DT —T4F¥aL—LavDME: BEF T a0l 7—T4Fal—3
> (Articulations) IOR—U OIEBESRIE (Vertical Position)J222av(E, 7
IWA—FROREYATAIVEDLSIZ 1 AR—RKYBEDORENT—TaF2L—>
AVERERRORNAICKRRTEINEINERETESFT T a  BEADLYKRELGT
—T1¥2L—a>DOALE (Position of larger articulations in the staff) 1A% Y
FLUEMN. ChIEELESh, 7T—T4FaL—2aV T EITRERORAIICEKRTT HHE
INEIEETELFHLLEY 3V Tl (Advanced Options)JICEEZ oh
FL1=,

AL TOBIBNIEBERFICHTE7—T4F2L—2a> DEE: 24 DDHEHY DR
FHBLERTHBENDELLIZT—TA4F¥ L —avERRIINMEETESLE21DD
EHYTOEIE (Pos. in tie chain)]DTO/NTAIE, LAT IR EICELDHREN
TEGELIGS =D 1 DDLAT IR CINEREFIIEEZERTTHE FBELZT
—TAXAL—LIVERTI DT R TDLAT I EEEZITET .
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INER R

BUVMNAER: AFETETE. EROPRFELIELBERULELV/NIRNSESE
BECERASA, BEIKBORICHEIL—XDHNIIEL., FERMALEEA
NBIELERLET, SLEE—FDON/NEHIE/NEH (Bars and Barlines) /3R /LD
[INET#R (Barlines)1zosavIz, INEIRAATTHERR (L) (Short (top)) 1A Fif=I
EMENELE, BFEORELVMER GEROFR 2 MZRULD0) ITERIFLL.
#FLLER (L) (Short (top)) IO /NEifRIF . ERD L 2 MERYIVET,
[Shift]+[B] DRy TA—/ \—IZlshorttoplEANTBHIETE, FILLVINEHRAAT
FERTEEY,

KEW (TS5 vk) ER$ER (TLAR)

LAT7ORZEDRFEMDT7TO—F: HFEXF T ar DI KFMEFHE (Brackets
and Braces)|DR—DI7FO—F (Approach) I av IO SN TN A
ToavE VA7 AT oar0HR—TXIBEWRESRIFEI (Brackets and
Braces)JIZBEILELTz. CCTIELAT ORI EIZ, EDKSITHRICKIEMEDIE
iM% (T2 RIRTEFET, Dorico D IBNA—230THERLETOD I ERCE,
TOCzIbDONEBDNEDLLLENESIC, BIFEDOEELF T avnIRTOLAT Ik
[CHEASNET, #IZ, Dorico 3.1 THRELETODzIEIR/N— 30 THLV-S
B, KEMEFFEMNCE TS AR O R ENMEASNET,

COEFEICE ST, TBHERT IL—T DKL 1 DFEFRRESNSHES (When only
one staff of sub-bracketed group is shown)1DA T a> DiREETEMEAE L
L. BNA—=230 TRR—EBOERICRREING O S EHEIARRIENSLSITHY
FL1=,

HEOSIIZEDIHIFIDEIR: Dorico DHEARTENDFTHE I+ Bravura [Z[F
FIENDTHF AU 4 BEAEIATEY. ChiEHENELNLHEEO—F L
DERDE 5 BHS—BFTOERDE 1 HETOEFIEONT, BEIMIZTY
BHUET, BEAT a0l KFEMEHIEI (Brackets and Braces)|DR—
DI TFHALY (Design)l o avIZ#FH LLIEE#IERE (Advanced Options)1DHJ
o avMEmMEh, CSTIEFIELD 4 BEOTHIV TN ENEERTSES
DLEWMEZRETEET . BMATLavThER BX)IOJRRKR/IAVEYKE
WR/SVIZIZEELERFENZHEFALET (Use flat brace for span larger than
maximum ‘Larger brace’ span)](d. F1HEXE TIEA U IZG-THEY . ThiFEE
IEEDHAPEIMCFELEPIFENDOTHFAOZERALGVWESIEET 5-00E
MNTY,

A—RFAT7T 5.1

A—HF—ERINFA—FBRER]EESE S A—FITFARERGESNLHEFLS 1
DUEERENT: (F2EAETAF— Ttha—kh ok 3 ENERRSIh) FUTFIL
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DA—FBREEBRLIIGE . LEAFARGERLIRIFTTVSELTE. FAIEDD
—RIZHIET 23— FHIROBERHEL T, COIA—RFBRERTINDIESITHYEL
fzo DFEY.FBULI-T 7LD BIRAMRBICR RENLGNMEETHH>TH. AP
FILOI—FRRIFRREINET,
SH[CA—H—FEINF-O—FRRIFIA—RE LT 45 S5.L%REIR (Choose Chord
Diagram)1DA A 7O TR LB TR RINDT=H . BHELI-O—FBIKER S
[CHATEET,

No23—DIA—REAT TS L: NoPa—RADI—RFBRKIE 4 KOTELELERID
DHILINEREZ .5 BILYIDLIRESD 5 AHDKIFTLIIERESZGELDN
—hRBITY . D18 Dorico TlE, NV Pa3—ADI—FEATHISLDRRIZ 4 K
DELHERIOBUDAEFERATHLIITHYFEL,

A—REAT7 TS LDEBRTL vk Dorico DEARE TIX, a—KF A7 TS LD
BILYRDRRICETSETHFICRETFRNMr JZF =2 DA ERASN, 1=
RT3 fr)EB AT IS LOBRIZKRRENET , —BOHRMIZE, TLUVAE
SN GEDO—THFEFERAL. FATIVSLDERICRRTTEHLDELHYVES,
CDVRTLEFEATEIEE. JUFD—FBLDTLYMIGRILERTHDTIEA

LENUSNDILYNERETRT HEELHYET .

CORTERAICHIET BI=ODFLWNA T avMn, BEF T aoDa—FE4(47
5. (Chord Diagrams) | OR—I DIZLyhEE (Fret Numbers) 153 avIc
BMEhELZ, JLYMESEBREICRT T HIL VNIRRT AICE. BFEE—FTO
—RFAT IS LEZEIRLTEITILY )T Bh [Return] F—F|LTMa—F4 4
775 LDO#E (Edit Chord Diagram) #4705 ZHE. TBKRILYFES DA
T4k (Starting fret number offset) INEZZEELEY,

A—RFAT IS LDRAE: —HOXEI—HAIKIZIE, I—RFAT T I LEFT I
LFOHMETIEGL FYMREDEBREIZLTECLDOAHYET , FIiLLVA T ay
[M%E (Orientation)ITl&. FAC VbR DI—FF AT S LERAETIZT HHE
MEICTEINMEETEET .

A—RAAT7 IS LREFDEDF1—=27: FEE—RTI—REFATI LD
SEEZHCE, TT2—ERICEEREWSIZAHBROEYFO LI FEIMFET
FABBEDE Y FHRRINET,

BWREINIzO—FI AT IS LIT13—: [§E (Engrave)l » TMO—F4A(T7I 54
(Chord Diagrams)1h\hiREN ., I—FRDSA TS —DEEZE KYSIZEMIZIT
BZABESLELIz. #1475 ELADIATIY— (Category)JA=a1—TIlL. B
ETHDAVARYILAVEDIEDAE (4 K. 5 KFE(E 6 K) ITHRVDI—FRKEHE
BTEFEY . [HFTU— (Category)JA=a1—D T DY ANIIE., TDIHEDAEIZZ
BIBDAIVRARYIAVID T RTOIA—F KRNI RNTvTENE T, ChIZT T
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HEBOMHERESAII)—E . BENDTOAD I INCREFIIERLEA DT
LDIA—FERNAYR LS TRREINET,
FATI)—DENZTNDOIA—FBKRITGERSATWSI—FRBIZIE. ThEhEt—
BOUTNGRTERALIZEES. FEFyMI—FREVRD O3V A RBEN TLY
FT . I—FBROELE. BABGRE /AL —THEZBIETIVRRIIILAU D FY
DIZR>THBETEET, I=EZIETE major, open position]®a—FfZKIL, T
MADRBIESTHEZTLYMIB®D 1 DT DI RTDIXE/AL—THIZHLD
IR OTLICBBEEAIET MDA y—a—FIZHLFERTEEY . TDT-
& . f=&ZIXTF major, open position]IEVRMIEENFEA. ZOTI—FIE.TE
major, open position |OA—FRRERVIIZR>TLICEETEHILTHLND
=TT [Fa—=2% (Tuning) IOFOYTEHUEERTHE BIRPOZOK
B CRRATELSFESF LTV AEZEALESED . ERLEZO—FERK
MoBoNDI—FEHERTEET,
A—FBRVANTFEDT Va0 N\—Z2FATHE AP REFHRIERTEETY,
[TV ELTHRTF (Save as Default) IRE2Y (27 42a2) €09 07 5 ER
LTWB1—H—FRDI—FHKNI—FBROTI+ILESA T —IZBMSN,
LIRS 2T R TCOFR IO IMCHERTESSSILRYET  E7 a0,
BIRPOI—FBEDBTIHILELTRESN TOEWSE X FIRETRRSNE
Yo BRPDA RSN T IAILELTREFSNTVSE E7MAVIEEY DR
SNTRTRSNFET . RELET 74D SI—FRREFHIBRT 521, TTI4ILE
ELTR?E (Save as Default) J/RAVEBERLET . E7 (2D RTHFIREIC
RY. 3a—FRIKNT IHILEDSHIBRSN =2 EERLET,

HIRTEADIFA—F—ERDI—FBIRDATT . TN LISHETHIER (Delete) /R
AUMNBERITGEYET,

AT HEN 3 KITRESLBNA—RFTATITILIK RYVITRS>TETICBET

BILIEEETEERA, TOLIHI—RESOBRMEFAINSHE(CEOTL

5158 . [A—K&4F7%45.L (Chord Diagrams)1Z4 A4 7ASIZREND RELERT

Z2ERRTINET,

HHA—FBREMDI—RE LTI SLIZER: I—REATITSLEARETAXL

=58 ELGSI—FRRICUVEZY, FET—FTO—FBRERELEYLE).
[¥REE (Edit)] » Ta—K4 14745, (Chord Diagrams) » [RyF33%a3—FiEs

[2f,%&aE— (Copy Shape to Matching Chord Symbols)1Z:&IR3 % &, £BD

XA—Fa1—=UTEERT IR LAV DRILA—RIZRRTHTRTOH

—REATISLIZ. hRERAALEREERMRTEET,

2—FES

O—AJ)La—KEES: Dorico DaA—RESIFHEERIZBOFONTWET, 2FYEFN
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ENDI—FEBTE—EANT AT EBIRULZAVARYILA D /=M B EIR
[CRREINFT LOLRKRERETIE. FoH T ILOBEDAU ALY ILAVZE
BHA—REBTERTRTIEELHYET . EXIE FRVRMIL—FDIGEEE
DRAL T ER/RET DIGEHRETT , CNITKIET H1=6IZ, Dorico 3.1 [ZIFA—
HILI—FEEEDHEENBEASATVEYT , ChITHETELL BRIDAV XYL
AV OFTENDEDTT AV ARYILAUNIIET A—/N)L DFEYHERICHRD
(Fonf-a—REESNERMICERTENETHA . O—HIL DEYSVRRSILAY
MOt tza0—FREENEEORLHEICFET H5HEE. A—A/La—RE
ENRRINFET,

A—AILI—REBEANTBICE EEEY [Shift]+[Q] L TI—FEERYT
F—\—%BE. [Alt] ZRLAMAS [Return] ZHLTRYTA—N\—%2HBEELFET,
A—ALI—REELZERLTANTIEEE, RyTHF—/"—HFALTLSMIC
[Alt]+[L] ##]LT. O—hIa—FRBEBEANE—FEAYITEFT Y O—/\)LO—
FEBANE—RIZRTICIE, Ry TA—/R—ABINTULBREIZ [Alt]+[G] Z#LE
T, [Alt] ZHLTWBREIERYTA—N—DE—FAREELET, ERESNDI—F
SEENT O—N\ILIZEEHNA—HIIZEEMISE LT, Ry TAH—nN—IZRTEND
TAAUDELLET,

. AT/CH| . AT/CH|

o) o)

1”4 0 7 4 Q
A3V A3V
e e
HERICHD T A RRY LAV ZHR DT

AV RRGILAVMIE Do f-a—RESENAASNT-TAP Y4 Dorico 3.0
LRTTHAWZIBE . AV XY ILAV MO TNtz a—REF [ERRSNhFEE A,
ZOHEITODIIMERELTERET DL, ChoDaI—FETa2 V0 oHl
BRENFET,

JE—FF—DEARBTDRI: BEA T3> DIa—FEEE (Chord Symbols)]
DR=DDFTarA—FONL—rEBIVFVI—FORBZREFDORE
(Enharmonic spelling for chord roots and altered bass notes)ll&. a—F®DJL
—rYEf BEU B [TRBHE . TN ENBHEIELT F LU C &EXRTSELNS
LDTIMN Fb BXU Ch ITHBEASNASLIICHRYELT=,

add F&AIIWEL—ay: FEA T30 OIa—RES (Chord Symbols) 1D R—
TSOIANAEL—3Y (Alterations) o av(c, #FHLWLWA T3 lTadd Shi=&
D58 (Appearance of added notes)1ASEMEN, EEADF ILEL— 3 (T
NIEEVENWEENI—FICHEETIILERITRT IO T IBELNEITAIEL LS
L—avdhYFERA) & add SNE-BEORADNFEET H53—FREBDORVEIETE
TEHLSITHYFELI,
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ATy

HALUrDTL—Y—: SRitEA T arnlar T4 (Condensing) IDR—
DY AL rDTL—— (Inactive Players) IDto>avIz, BEODA T IV
TR THLLA T av i BmEnELz, BFEOA T a HBERTH A
LobrOFL—Y—marT2% (Condensing for players inactive for the
whole system)ITIEH AL LD TL—N—I[ZDWNT, TITATHRIL—Y—LE
HETRTTD QFRYVTITATHIL—VY—LRBRDIRNELD) . BB DL
[CEIYHBTOND (EHDEREZFERTICTIHRETHNILERTICZES) H. RL
AVTUIUT T IN—TOERITERINILOAEHONED, BETEET,
FLWA T av & avTo P L—TICET S 1 AULEDTL—Y—h 4
BO—EOATHALUMIGHZREDHRNEIEETHLDTY , DEYBEIZED
EHAILURNDTL—N—DR[FETIT4THETL—V—DERIZEHLETET
TEN. ENELR[FEERRICLTTITATLETL—NV—DERDAHAERTT S
MEETEFET . KT EERRICTEIE. TIOTATHTL—V—DEFIFERLIC
BE—DFEHMELTEARAGREDARTRIESNIELELIT. HALUMNDTL—Y—
DRI ERTRICEIEROBBMHLEBICIETEICTL—VY—IRNILAEMSIh, ZD
MEBETEDTL—N—DTIT4T THAINMWREICKRRINET  HITHAL U
DITL—NV—DRFERRTHEEL. ERICBVETONETRTOTL—V—
PERELFARFOTNA DR TRESINSGZD. TL—V—IR)LERTT D
BEIHYFER A LEAST, T—V—INILERFORTEED /NS XIZEL
TEREEETEET,
AMIFTAaVETHEO—BTHALUFOTL—Y—Dar Ty
(Condensing for players inactive for some of the system)1T9,

Hide rests and label active player Show rests and omit labels

TMABZEIERTRICL, 7OT14TDTL—V—%S5R)LHT (Hide rests and label

active player)]&BiRT 2L, BFED 2 DDA TLar THRENERRIZEDIRR

ZRETEEY,

= [YALUrDTL—VY—DURFEIERTRICT SHHESE (When hiding rests for
inactive players)]l. KFEERTIZTIDITKRBFINNERDOCE TIRES
MNNETRDE TR DO LHEEDH (MNIDRIBLELE T HEICHEIRFD
#H%IEFRR (Hide rests only at the start or end of bars)]) &3 5h . EDLL
BEDAKFTHERTICTED ([T RTOKRFEIERTR (Hide rests at any
position)]) £ 5MEETEET, —EBBOHRMTIE. HALUrDTL—Y—
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DRFIF/NEOBIRREEF TR THEIZHDLDDAIERTIZT DM R
S LEOBEEGSTVET  CRICEILIEERFETL—V—INILORTEED
RBEENFVRERBICE, VMHOBRMELE T HEICHIARFDHEIER
7~ (Hide rests only at the start or end of bars) 1#ERLET,

= —HOEBRYTIE. YLD TL—Y—IEKRFLA—EU LD RSFEFDIS
BIZOHERTIZTIONMRELDTBELG>TWET 2R IX TL—v—
DARAH 14EH 2 HLHGWMER IEARFERTL. ChEYRGHHEE DA
FEERRICTIIENTFENET T [ERTZEZHA T HSRFOEEDE/ME
(Minimum length of range of rests to allow hiding)I1ZERT %&. IERRIC
BARFDOREODR/IMEZIEE TEEY . IR ETIEENDREDAKRFTHIE
FRIZEYFETH, BEOKRICL>TIE. ZORETANGRFICES 1 8L
2 ICR/MEZRTE T DL RELLEDHIGFELHYET,
BROIL—V—DTL—Fv—3A)L: BES T avnlavFooyy
(Condensing) IOR—JIZFHLWA T avIL TN FTL—rv—HFBEDRIZEM
(Appended after single player number) 1A EBMEh ., B TL—v—FED
BICIETL IO KSICEYARZEEMLDD. 2 DULEDTL—VY—F S DREICIZEY
FRZEEMEITL2IDRIIRRTESLIITRYEL =, Ch(FT—)LFETBehind
Bars | O#REIHEIZEHT LD T,
FULBWAD R AR DTL—Y =5 BIEDA VAL AV SGIEDH
REBLDTN—TF2avT oo TERTTHEE. FINIVITA VARSI IL AV DR
e BEIRLTESEZEML-LDEFERT H5ELIITHYELT,
HARELDAVT UV VT ETEIT I —TOERINIL: ThZhAR— DAV R b
IWAVNEERTHEHRDARELY IL—T (;=EZETHorns 1+31&THorns 2+4 )
[TV TEEFTLTEON BRIV B H S5 FEFT T a0 DIHBERS
RJL (Staff Labels) I OR—CDOIRABEOYVAEBZNEETIESDOHRSAL
(Staff labels for identical adjacent solo instruments)IDA T3 (ZH LY, 35
KINNWVET IW—TITESDLIIHYFEL =,
ERINLBELVTL—NV—SRNIIETH0—IHFETIETHF: a>To
TJEINIETL—V—DRERIRNILEIVTL—N—SRN)LIE, FEAF T3
FINJL (Staff Labels) IOR—SDERFEDA T avIzkd, 7IE7HFLO—T
HFEDELLEERATANDIBEICHSILIITHRYELT,
AVTULUTENT: A BEEDOEEDERRS: FEDTT—ENANDIEEHR
BLDTIWN—THAV TV T LGS TH—I\—tDF I 3—THBHRAGELERE
FTERGELLELNRN—FDAFTERESNMERINES LAY FELT,
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FEEF

Fov I ABOFIR: FEE—RFTTATLERIYI LTRRUBELRETHLEEF
VT ERIBLTMNS [Shift] 2T & TATLOBENESYILTWSAR (£
TEEDWLT D) [THIRESNET .

ROvarvmtyh: HEE—FTHIRTERL., DFYRYIY, ark OV TUY
VOREDER . BLIUVBEFDAR—V VT DEBUNDT AT LEEIRLT
[Delete] F—%#F &, MR (Edit)] » IR aL %) Eyk (Reset Position) 1%
BIRL=DERBRIZ, TATLDRTRA 7Y DBIBREINET,

242H)T

FE—DEFHIE FI—OTOMDILIYNERICEFDI«VH I TEANTS
B, [Shift]+[F] ORYTH—N—IZTtIZA DL T EFOHREERTAXFOIT]
ERTTEDLIIRGYELL=,

RMZDIERES: FEET—FOMEDOIERES (String Indicators) IOR—2 D
[BAREL D48l (Open string appearance) IOA T avIZBmaEnt-T{griEE
MEA (Zero as indicator) I1ZFRT H&. MICHAZHFOEAERRTEDLD
[T7RYELT=,

BICHRFRT BI85 B EA T a0 DI74204) %5 (Fingering) 1R
—CDIBEIE (Position) i3> DA T a  IFEOERIZHZS7142H)05 D
22 [a)E# (Collision avoidance for fingerings to the left of noteheads)lIZ. #7
f=ICTEEAMICA TRy, BIZEE (Offset vertically, allowing in spaces)1®
BIREAEBMENFEL -, COXTLaVZEIRT L. FHEOERICHET127Y)
VU BICETFITTATERRBITPREMA SN DD TII G, TESE(FHEICHR
WA CRESNET,

XE—D5TH

RURQER: V) —RENSTERORURDERHT HHE . AURFATHET
RREVEDGHYIZIEOFARUFELTRREINET . FEE—RFTEHVEDGEAY
DRUREZENETNERICRETEET,

ETS—hN\—0DiEE: BEE—FOEMBT/ARILICIETFS— (Guitar) 1o ay
DFLGEMEN , FA—ARUREERTEIRIVNIZIIBE#THEELIC.ETS—
FN—EREEWDTHR—ITELONDFHA T avhBMSnELI. ETS5—
FN—IZ&BRUREERT HE ZTEICITRBELTRTRSINET . BEZDRIE
THEIZATEOREZDOTETHIESNAETH. EMEITRURSEDHILELTE,
COEERIELEMEIC ATEORERO LFTHIESNET,
BEDIAHAIDTIZEBZXE—ARURIE, TANRTFANRRILDIFE—RDE

(Guitar Bends)l1to>avIz®HbETF—k/N—%ER (Use vibrato bar)1d 70
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INTAEF T BET ETS—MN\—IZKBRURIZEBRTEET,
EIHE/ RN DIFE— (Guitar) ]I avDFRMDA T av(Zik. ETS—F
N—%FERATIEHEE RTHREERTEDSLDITMA T, ET 53— A— (Tav7)
EETS—bNN— (RY—D) B’HBYET . ETS—M— (Tav7) (X, TavTIZEH
SNBBEREFERATYT (3F) OHT V BDOEBEDLIZKRRLET, BRE(E. 7O
INTAIRILDTEME (Ornaments) DY IL—T(2H AT EE (Interval) 10 FA/N
TATCREITEFT,

N—EZHR
N—FEZHROBE: BAN—FEZJREAIN—EFEZJRADBPELVEYFTHES
NBESIHBEELLIC, BEADEER EMpt.naturalHarmonicl1ZH T 5718
B4 T /N1 (NotePerformer %&) NN—FEZVZRAADOERYIUFEZARELTL
BBE . TNNMERSNETS,

BRAN—FEZVX: HREZDOIVFRAVMERT 1 DOERFELARTIND. B
AN—FZVRDRED/RWLDHESNFELIZ, Dorico [FZDEVFEEERTED
—HEVZKITHIET DV TFRHEETHRT HEIITHRYEL (RBESNLGZYFRS
UMZEoTIE FRKYEVKDFIYVEWEREF. FzlE 1 DBLEO KYELE
DNBEERITBELHD=0), CNIFTORT/RILDIEX (String) 1IN T /T4 T
tEETEET,

A
EEMERBOHE FET—FOTRADSIOEEMEREL ., EEDREIS
FALATIFDEREREDEILICHL ., #FFSNAOTRYEL =, FHMllE 29 R—
POERDAR—V U TESRBLTIZEN,

MEADRR—L 24" Dorico Tl BERFDKFEARDAR—L UG ERTTEHEE,
BEADKEARMDR/NVEMENBELGHEZTRBEINEST A, GAICIEIEAGE
DEEDAR—S VT EFFHTITESLE O RERERELVET . TOLSHE
EEBEDE=OIZ.LATIF T avDIEFDAR—L S (Note Spacing) DR
—JIZ HLWA T au TRERDAR—REER (Make space for lyrics) VB
MENFELz. TEADKEARDAR—ZADEY B TEFHTITESIGEIX. ZOF
TLavEFIICLET . EL. FHTORFEDAR—L VT ICHEEMNTEDHY
DRV E . SOFTLavEFTICLTLESERENFERICHEA DL
=0 FENBETY,

I—h—E&UVE(LO—F
HEDEFIETORALO—R: LAT7 O TavDIv—h—ELUES LO—
F (Markers and Timecode)IOR—JIZ HilLWAT a4/ LO—FERTR
(Show timecode) I EBMEN, B/ LI—RDRRLEBEZFALI—FERDT
(Below timecode staff)] (BAFDENE) LTHHBDBARAIED LF/-(XT (Above
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or below start of system)] (#4 LA3—RFXFHEERORBEEICR TSN, 21 L
I—FDERERTTIVDELHYFELTA) NOBEARBZKLSITHYELZ, FILWLAT
2 aU T MBREIBE DA 7ty (Offset at start of system)1Z&EHT 5L,
EBORMBMEBICRREINDZA LO—FDTIHILMIBZRAH TEET,

INEREHIRR T BIRICY—h—EE T S RTLMYIERIL [Shift]+[B] DRYTH
—N\—ZFERALTPMEZHIBR Y HEE, BIBRSNA/DEHIZT—H—NEFELTTE,
R—A—IFHIBRENGENKIITEY FEL 1=,

BRI+
Petaluma Text [Z &k E&HF 525 Petaluma Text &2 75 vhEES (U+266D). 7F
2FJ)LERE (U+266E) B LU v—TiE (U+266F) DXFDH A XEMBENHE
SnFELT -,
Bravura IZ&AEEFEE S Bravura & U Bravura Text B/ \—23> 1.32 27y
FT—rENFLE. COT7YITT— Tl . EEESOAEINMOY A XEERL,
Extended Helmholtz-Ellis Just Intonation DEERSEESICEFENE—SDERTES
D) 7BEDRBNTEHONELT,

MusicXML OEZHL
i B EGRFEE S AN, MusicXML [IZH R—hESNA MO B NEFBIEELEH T,
EFHINDESITHYELT =,
T—T4F¥aL—3ar: 7T—T14Fa2L—3> M MusicXML [ZEEHEINB KT
YELT=,
O—K5EE: O—FE8A MusicXML [TEZFHINBESI2HYELT-,

AVARYILAVRDBRE: TR TOEFIBRAET TELLETHINDKLSIZAHY,
MusicXML 77/ LEZFHLBFICBRAEBINELLIEONELSIZHEYELT-,

X AT —T4FaLb—3v: KA 74— L . R9—T . EXU0TOvTOO¥ X7
—T4F¥aL—230h MusicXML IZZ2EFHEINBESTHYELE.

JIN—HIL—: YIN—ILI—I D MusicXML [ZEZHEh B ES5I1ZHEYELT-,

MusicXML DEEHAH
BERESIE: 4 HEFOFDMD 12-EDO [ZBIHVERIEIE DA AANHEIN
FL71-,

BEHRDAN
BEAEMBORE: a7 LOBFFEERL-LE, S LORBESERRLTE

Dorico 3 /\—2avV ERE 24 R—2 Steinberg Media Technologies GmbH



Dorico 3 /\—L a3V ERE

@ steinberg

AEINBDISINTHYELZ, BRORBEE—EDARBTHESNIANFELMGE
X BERTEOIFEHFDOAHERE (Note Input and Editing) IOR—Z DEFHLLE
TOaviBRLULEBEHROBEIC—EOR)1—L%EEA (Use fixed volume to
play selected notes)|Z#AIZLT. 0 (/M) A5 127 (RK) DEE TR 2—L
ZHRELFET ., oIS, AEREROETFERINLI-LE BB THERBEETRBR
LTEEEINSSIITGYFEL -, 1A LRER T pizz. IDEREDHEICHS
BREERTLHE. BETHEASNSEFA—bOYIUREFERALTHETED LS
[CHLOTWET, CIFSDECH BE LDOEYFNELSZN—FEZIRIZIETHIEL
TWER A N\—EZJRADFEEZRIRT & EERAFENEVFHEICELESH
F79,

TEBFVNCERL-BRZRETHLE ELWVESBUENBEINHEEMEN
MELELIz, SHIZHFHDOAHS, [Shift]+[Alt] ZILAEASKENF—0 L TZE
FALTRIZANT HEFDRRIREZEET HE MY BRL-UICERSN-E
ERZEORENBESIET,

BEU{HTBED LZEZE: Dorico D IBN—2a> Tl BRUNDTATLDIE—T Y
FR—ZXLDENMEIL. EEITFRIEBTL Iz, BRENBRBZE, TaL—230%
BOT7AT L (BRFERGEEES. ML, AT LR, EREAZOIEAGL) (LHIBRS
NFETH. TaL—2avEF BN TATLDEZL (BEHERERS. EILTUMN L
DOEFICMAKIED 1 FEi4EE) 1£5%Y DD, Dorico TIXZEDEDTATLIE 1
MATIZ L DULMEFRISNAEL =8, — BRI EEZ LSRR DEEICH-TULVEL T,

SEDOT7YTT—rT. KY—BLEBMEICERINELz, TaL—av ik
WZATLIE, BCAEBIZREDT A TLNR—R EINDELEEINFTTH., &5
[IR—RNEDEFRIZHIRBDTATLIETTRTHIBRSN, aE—TIZH 21741
TLDHDEDKSIZERYF ITONET,

oA CEERF D B A E ML TREE (Write)) » T#8EA (Transpose) Iz, FiLL\A T
AV FTVFERIZN) TV —T 1759 E#THLIICEEZ#Z (Respell to
avoid double and triple sharps and flats) AN BAISNELT-, 12-EDO LE #2114
DHAHRED AT LTRESN-EEERATIEE. EROREICTEL LU=
ERBREEOFEAZEZLC. MDOYIZER 1 DR DERLEZEEL TIZEEDRIFGESZE
EATEHREBICHAET BT, COFToavEFUICLET,

COATavid, ERICEEEZBRALE T 1=V VO BRTHRRAETHICLT. R
BT EHMIL T 5-OICLERATEET,

BADDGENAYDHDFEEESRA: BFEET—FRT.ZADDEANYICEFNSEL
DHEDEBERETDRILEEETESSIIHRYEL =, ZADDOLEAYDH DR
EEETHFBELRIRL, F—HR—Fa—thvk [Alt]+[=] TLOEFEFEALT
ESBZ . [Alt]+[-] TTOERZEALTESRAZITEVET,
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EHYSLDOHEIR: HFa<w RTRE Write)] » IFaL—SavE@E (Edit
Duration)] » FRODBFAFETIEHE (Shorten to Next Note) 1A BMENFELT -, Th
(FROBEFOFBMELYEEFTHUTWIERE. ROBFICHETEIRIET
BT BILTRLFEMOELGYE>ERMAEHIRT HHEETT .

BERBITEROBREZDOAN: REZEDIFEFDOANLMEE (Note Input and
Editing) IOR—JIZ I TESBFVNAE 1 REFFERTHITRFAICERETAHFHL
WA T avEEREERIRT 23 —0O% (Number of keys for techniques) At
BINENFEL:, MHARETIE. BEDITERITIVEL TSN TV LR EDERRK
FZERTTBEHIZ. 1 AVF—TDEFHNEV L TOATVET AN BEEEEOHK
BENAVARYIWAVMIHLTINE T TRBVGENHYES . COGE. &
BOERHEAEEETSOIC. 2 75— TULEDEYLTERETEET,

HEBRTINDRERGDIAVAMYIAVNEAEBET HEE AV AR AV EITR
BIGERLCWVEREEERIE T ALIICAYEL, ChIZEY . FYFADRID
AVARRYIAVNMIBEIL TIED AV AR LAV MR fEEIZ, ZDAVRARy)L
AVPTRERISERRL TV ERBCAICERLET  ITERTUMNIEBOESRRIE
TYNERDEBD AV ARYILAVIDHDIGE (F2EAIETX—F T ARTRI LA
TF—RSLDEYMNEE) FYRADA VR ILAVREEBE T HEE . BEHID
AV RARGIVAUNTEIRLIZDERBUEN B RD AV AMIIILAV DR EIZTY
EVIEhTWSBE. BERZEDRBRREIBHED AV ALY LAV UERES
nFEY,

R—=ULAFTIk
YRE—AR=TDEIrDHRAAAEEZHL: FET—FOHAIDNARILDITRE
—R—S Dt yk (Master Page Sets) 1o ar D7 o av N \—IZHLGEMSH
ARAVEFERLT. YRI—R—C01yha702 o ESHLTHOTOD
IVNMIZEHAFERDIENTEDLIITHYELS =,

TARAA—R—UDEMTL—L: Dorico DIB/N—230 Tld, YRE—R—JFHEE
DEBEEREDEHIZ, KBOEMTIL—L (MA,MH 12E) #EDFEITTHEL #
NENDOERIL—LFI—UDFTRTOYREI—R—JICELEDIL—LEEFD
ELREBEELESNFELE SRIDTYTT—FTCIOEENEMINEL, Sk &
HIL—LFI—DNTRTOIRI—AR—JICRALHDIL—LEFODLEEHY
FEA TNTNRDIREI—R—V[CRRINDIEINETNOEHTL—LFz—UIC
1 DU EDEMIL—LARIFEATONIEHHTT,

AVARGIVAVNEEDETED: BLERLD 2 DDAV AR ILAV R DT
RAVMEBE . TOAVRRYIILAVIDERER DO EH/NEEIEO LD IR EL
KRN ELSRESNDES1C. RODEHRICAMN>TRFTYTENET, LHALSE
DT7YTT—MNIEDET, CORFTYTEMEFT O—/3)L (FRERICHDIHohT) 8
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FRBEFERATAITOCHMCRITINIERBET. TPz /MzO—hIL (LD
AV RRGILAVMIR DI ENT) BFREN 1 DTEHEETSHTODIMTIE A
VARG AVREITRAV DR T TEMEIET N TESIZ/EYFE LT, Dorico 3.1
Tl B—AILEFREEPFEETIHEETHO>TH AV RMIIILAVIEITRA UL
ETEDAVARYILAVEDRDINEHRIZA N> TR F VTS EHIET, CORREIC
XL TLET , (STEAM-9865)

E7 /ORIy

VTAVDEEE: BEA T DIRF LR (Pedal Lines)IDR—UI2H HIKFAL
B (Horizontal Position)1t2avIZ FILWA T a  THFEICHTHITAID
fiI& (Position of retake relative to notehead) IAGEMEN , RFIILDTAH%
FHEOERZIZTZ2M. PRFZICTINMEETESLITHYELT:,

WERE

TIHWEDTaL—2ar: $TRTOEREEA, S 0HEYIRLA Dorico 3.0 A
SEMENEERBEOVWTNMAZEZFRALTT2L—23avERRTEDLIITH T
=& . %E (Engrave)] » IRZ|HE (Playing Techniques) DI F24IILhDT 2
L—33aY (Default duration) DA T av EFICERAGEAY, BIRShFELT =,

EMEFOEERRE: $EA T a0 DEERE (Playing Techniques) |OR—
DI TH A2 (Design) €0 avIz #Hid T as TEMBEFICERTEI)II2ELS
EERUEDORRIEE (Scale factor for glyph playing techniques on grace notes) |
PBMEN ., EMERIEREEZEALILEIC. RRBEEREELITHNEINETE
TEDESIHYELE,

BETUTL—F

IHORTLwiaryTenR—hyiareyI07yTT—r TASIIMIEHED
BETUIL—FOFERANEEINTWSEE ., TAD VMBI UIZRTFINT
WABETUTL—MFvosh . BETUTIL—FADIVRTL Y30y T
BEUNR—hyiavvyI N BETADIIMTCHERALTOS LD LY /N—Da 0 F
BBV EhET . N—DavESNEN-HEE. TACI VMDD IR
TLviarveyFen—hyiarey I NEFNICKYFHFLLAN—3VIc7yTT
—rEhET,

BEE—F

—EICREBEORA I EEBHICEBTDORIUN BEE—FOA—FA—230L—
VICT—AEBMT L. —EICREBFORAVNEEBHICERDORAUIEEIRT
EHIINHBYELz, —EICRBORAVMIELBESN. L—2DRDKRA B
EFC—EDNBEEFEHELET, — A BREMNICERORAUMNIA—T LD 1 HELT
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Ebhh. L—rE® 1 GOBEERDORDECHFEBHICHEBENET . EhTh
DRAVMEIRT LBAEICRBITEES
1 T

— I EEORA BRI T DA
IR ORAURDIE. A DDA EL MR AR RSN, Z0O(E
ST HLERLETA . BEMICEEORA LI HE TR HEHET
RShET,

RAVEDAATREREICUYEBEZONETT ATV IDERY—ILEFERALTR
AUREEIRL, HEVVYILTRRENZAVTIRAMMZ2—DSTRDARVMET
—EIZRE (Make Points Constant) 1EZIETROARUMETERBEMICER
(Make Points Linear)JZ:&RLET,
F—rA—=2a3>T—2NAE—TURR—=X: F—bA—=30L—2DOT—42%0E
—LT.BACA—rA—23V DRIDME ., FERGEHIAVARYILAVMNIRT BF
—h A= 3 L—UITR=RAITERLIINZHYEL 2 ATV DERY—ILEE
ALTT—4RAUrEFEIRL. [Ctrl]+[C] (Windows) F71=[F [Command]+[C]
(Mac) Z# 3 h. A2V vIDAVTFRAMAZa—miblal— (Copy)I1Z:EIRT S
ET DYV TR—KRIZOE—LET . R—RALFBIZE, 2R EAR T4 RT LA
EEDIL—5—FV )V THLGELT. BEANYNER—AREDMEIZEYIL R
—ANEDL—2FE D)L TAVTHFRMZ2—STREY T (Paste) 1%:&1R
TEIN SV IANYT—FH) L TR—=REL—2FFIRLTHS [Ctrl]+[V]
(Windows) E7=[& [Command]+[V] (Mac) ZHLET , £f=. F—K—Ka—rHy
MRIZEALT. BRLE-T 9 RAUME . RALL—VDEZDOMEICERT S
LETEFET,

EETURE-—RDOERE: TURDFEAHLTYVRELTFICFSYI LTEETUR
DIEZEHRTET HLEE. [Shift] ZRLEASIZERATDIRE/NETE, ERLGEDEE
ENBHBITHYES,

B4 LESYIDIRI: 8L LS DE/—RIZETO—DFURARTRES
FITH. IV TFEITNSHEIRNILTREE—FTOTURERERERT TR
MRITTDESITHYELIz, CNIZKYTO—RNDELEBEFIBIELOTRYET,
IVRRAVIDEEFAT7RT  TTVRRALUMDEEE (Endpoint Setup) ¥ 47 H
TIZRRENDAVRARGILAVRBIZ AV ARG LAV NERRY T FH — /I —[ZFR R
ENBHEEHR TIAL BREE—FOIRAMZERSE (Edit Names)I|F(7OY TEE
LE-EXBROBEKEIMEREINSLIITHEYEL -,

F—T4ATOC O DEEERE: Dorico MoA—T4A TP UIZ MIDI ARURE
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FEETERWMES (THAMRELITE AIERSATULELD, Bz Ty
L—rMABIREN TS =8), ATF—FRAN—[ZZEDFNZARIARTINETS,
NEIVVITHE. BREDIEIEERAS1=OIZTT/INL RE&E (Device Setup) 5
4787 BNEEET,

FadzorI7 ML

FLLON—a w2 R F: BEREDOF—KR—F23—khyk (Key Commands)l
DR—=TDIIT7AIL (File) IDHTIY—IZ, a—bhyMMIBIYHTRENTES
HFLOOTURTFHLLVANA—D3 %R (Save New Version) 1A EMENELT =,
FEHLLVA—2a %87 (Save New Version)ll&, 7Oz EOEZEIZF vy
RAVMEERTHAF R VTG AHETYT  AavFERUHT L TASIID
T7AINBICEEAUVIAVNT HRFNBMEIN T, TOC O RAEMEIZKF
BShFzd, HEN—CavEELICENOTODcoreRY | BHE/A—Ca Fo
EFE—UHYFEEA. CLAINIITRRIZ T TREF (Save As)IDHEEREIZ, B
[CHRTOSIIORDI7A L2 E BN T TS HEEE B IL =1 (T D EF
Ba—bAYbTHHEERAFET,

b & AT
iET DRIy A BFEA T A DIER (Notes) IDR—UDIRSYL 2 HF
88 (Rhythmic Slashes )12 3> (2, FILWA T a  TURIO RSy 2@z
g ERSYS A DR D/MIIZI11%2 R (Show '1' on first bar of slash
region abutting earlier slash region) A BMENEL =, COFTav (X, EHE
BOZDOMDBELMR YD LEHRE LIRSV 2 ORYYLLE T, /NETAD U
1ICRIBEICERALET . IEIRETIE. COF T2 avEA TI2H->TLET,

BREE—F
TIAIEDIS—rL ATk TERTE (Setup)l » TFIHIEDIS—bL AT I EE
X (Create Default Part Layouts)lIZ&> T, FL—Y—MWTL—¥—/SRJLIZY R
FRIRENDIEE T, /S\— L AT IOMDMERENESELIITIEYFELT-,

ERODAR—LUT
ERDAR—I VT DFABLEHE: Dorico DIBN—3TlE, BEE—RIZHEITS
ERLABEOEEARDAR—UY (BLUHADSAUDBRELME) 1S5S S5
B AENERASNIMEEORBRMAEOVXLLEDOHEIZROIFONET . Ch
[ EBROAR—=2 VT ORFADRENHHBEDFIBIED. =LA FEERTE
DEBPLEEDEALHIBRICK>TELLIZGE . ChoDRAEFHEIBRINEIL
EERLET,

Dorico 3.1 TIE, LAT7IRDELITHT DN DREAKYHRFINOIALY,
ADOYIZEIL—LDEREMEDHENZRSNET  EAMBRDOFKRMENE
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ELTH, EEIL—LICRBOBEAFETSRY. ELTEEARDAN—Y
TOBRADIAVITH T HRBENERSN-ERAEET HBRICKRTSNTNS
BRYF., BARIFERASNE T BERNERNIL—LICHEELGELG>THH T, 5
BIXBEHMIZHIBRSNFT

EMENORTER: HFEF T a>0M3T# (Tablature) IOR—I(2FHLWNA T
LAV TEMFE B DMEE (Grace note scale factor) IABINEN . 2T 5ED LS5
[CREREDREHELIERLIRREREZIBETETALIITHRYELS,

MEDRA: BEXFTLaoDI2TEH#E (Tablature) IOR—SDIAA (Ties) o3
NIZFHLWA T as TREITEHIT5244 DO (Number of ties in chords)1A%:E0
SN, BATOENINEZILIRESTRTIZ 1 DTIIMERTT D, ThELH
BRI 1 DOAAIZTHRENEETEET , BB DB IEHEEE Guitar World (S
ERAShHRERATT,

LEJ4TLAA: ZADDENYDREDEFICLET«TLALDRRMEESN
TWBIBE. BEF T arDI4FT5E (Tablature) IDR—JIZH BB/ TOHEAN
=3 TEDESFF (Tied notes in tablature) IDA T aVIZHWVEE (FIERTRIZES
BETHOTH. LETATLAMERTT BOICFAATOEANI-F RN RRSN
79,
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Issues resolved

@ steinberg

ID # Component Issue
Arpeqaio If an arpeggio sign or vertical line crosses two staves, the line no longer draws
STEAM-10155 sigpnsgg incorrectly if the note on the lower staff is higher than the highest note on the upper

staff.

Staccato-tenuto articulations no longer sometimes end up incorrectly separated in

STEAM-9767 Articulations tablature.

STEAM-9802 Articulations ~ Accents are no longer moved too far away from ties in tablature.

STEAM-9984 Articulations  Vertical offsets for articulations in Engrave mode are once again correctly applied.
STEAM-9661 Audio engine Under some circumstances, Dorico could crash when closing the application when

Vienna Ensemble Pro is loaded. This problem has now been fixed.

STEAM-10111

Audio export

Cancelling audio export no longer prevents further playback or audio export within that
Dorico session.

Changing the global space size at a system or frame break no longer incorrectly

STEAM-9883 Barlineg affects the line thickness and spacing of the barline at the end of the previous system.
Under rare circumstances, the beam groupings produced by Dorico could differ
STEAM-9695 Beaming between inputting and subsequently copying and pasting; this problem has now been
fixed.
STEAM-9979 Beams Spe_cn‘ylng 1/4 space slants for small intervals now more t_:pnsstently produces the
desired slants after beams have been snapped to valid positions.
You can no longer create a system or frame break, or add a bar number change, to
Breaks the final barline in a flow, which prevents an extra bar from being created at the end
of the flow.
Chord Cycling through alternative chord diagrams now correctly only affects chord diagrams
STEAM-9782 . . :
diagrams on staves using to the same tuning.
Chord Cycling through alternative chord diagrams no longer gets stuck after cycling to a user-
STEAM-9820 . X
diagrams defined chord shape.
Chord The Notes in chord diagram read-out in the chord diagram editor now correctly
STEAM-9826 . >
diagrams shows accidentals as necessary.
STEAM-9834 Chord The option to omit the 9 interval from 11 and 13 chords was incorrectly being applied
diagrams to 9 chords. This problem has now been fixed.
Chord It was not possible to add fingerings to the first fret in certain chord shapes in the chord
STEAM-9936 ! . . . )
diagrams diagram editor. This problem has now been fixed.
Chord Changing the tuning for chord diagrams for a player and then undoing that change no
STEAM-9980 di longer results in all the chord diagrams for that player showing a completely open
iagrams
chord.
STEAM-10008 Chord Advancing the popover after using a MIDI keyboard to input a chord symbol with the
symbols input option set to Keep popover open now correctly inputs the chord symbol.
STEAM-9894 g‘n%%ls Glyphs added to chord symbols using non-standard text fonts are now correctly saved.
Chord Selecting multiple items one after the other in the Project Default Chord Symbol
STEAM-9915 - . . . :
symbols Appearances dialog no longer results in the display being dramatically zoomed out.
Comments Dorico no longer incorrectly attempts to select a comment in the Comments panel

when you are trying to grow the selection with Select More or Select to End of Flow.
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ID # Component Issue
STEAM-10042 Condensing Tied notes are now allowed to share a stem when mid-phrase unisons are disallowed.
STEAM-10076 Condensing Amalgamation for tied notes now works correctly.
STEAM-10125 Condensing In some rare cwcumstapcgs, Dorico could crash whe.n opening scores with particular
combinations of tuplets; this problem has now been fixed.
STEAM-2215 Condensing Adjpstlng 'the posmoq and shape'of dynamncg and slurs in Engrave mode in large
projects with condensing enabled is now considerably faster.
STEAM-9664 Condensing C_ondensed_ transposing instruments no longer incorrectly use the concert key
sighatures in a transposed layout.
STEAM-9844 Condensin Under some circumstances, signposts for hidden items like chord symbols could
STEAM-9840 9 unexpectedly disappear when the music is edited. This problem has now been fixed.
When a condensed staff reaches a system break in the middle of a bar, it was possible
STEAM-9862 Condensing for a bar rest to be split into individual rests either side of the break; this has now been
fixed.
STEAM-9902 Condensing Edits in one flow no longer sometimes cause display prpblems in condensed music in
later flows, such as system items unexpectedly appearing on every staff.
STEAM-9968 Condensing Tuplets no longer sometimes appear twice in condensed music.
STEAM-9981 Condensing Mlcroton_al or other custom accidentals no longer prevent amalgamation when
condensing.
STEAM-7176 Cues It is now possible to respell tied-in at the start of a cue in part layouts, as well as in the
full score layout.
. Under some circumstances, Align Dynamics would not always update the positions
Dynamics L . : o :
of all dynamics in a particular dynamic group; this problem has now been fixed.
Engrave Engrave B Staff Spacing P Reset Selected Frames now correctly resets vertical
STEAM-9958 : . ;
mode spacing adjustments applied to tacet flows.
Engrave Using key commands to change between the tools in the Engrave mode toolbox now
STEAM-9960 s .
mode also visibly updates the selected tool in the toolbox.
STEAM-9982 Engrave Dorico could crash when attempting to drag a selection containing a playing technique
mode and an articulation in Engrave mode. This problem has now been fixed.
STEAM-9917 Fingering Specifying the other han(_j for fl_ngerl_ng on a keybpard |_nstrument in the Shift+F
popover no longer results in the fingerings being assigned in reverse order.
STEAM-10040 Flows Using erte » Split Flow in a flow thf_it contal_ns automqtlon data in Play mode no
longer incorrectly deletes all of the music following the split.
STEAM-6969 Flows Doing Write » _Sp_llt Flow from a Ia_lyout tha’F does not contain all players no longer
causes the music in the players not included in the layout to be deleted.
Glissando Glissando lines on grace notes no longer trigger a legato playback playing technique
STEAM-9904 : .
lines that causes all subsequent notes to be played legato even if not marked.
STEAM-9880 Grace notes Grace notes in tablature following a break where the global space size has been

changed are now scaled correctly.
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ID # Component Issue
STEAM-9853 Graphic files Imported graphics with fllen_ames containing accented or other extended characters
now appear correctly when imported (Windows only).
STEAM-9860 Guitar bends Moving a note at either end of a bend and then undoing that movement now correctly
restores the bend.
STEAM-9898 Guitar bends The horizontal position of guitar pre-bends in the presence of an accidental has been
improved.
STEAM-9899 Guitar bends When'draggllng a pre-bend |n.Eng.rave. mode, the shape of the pre-bend no longer
sometimes flips into the opposite direction.
STEAM-9757 Harmonics The fret number shqwn for Single notehead (sounding) harmonics can now correctly
be moved to the string above or below in tablature.
Instruments The standard and advanced ranges for alto and tenor saxophone have been revised.
Key When a key signature wraps around for a transposing instrument, Dorico no longer
STEAM-9918 . : . . . e
signatures incorrectly shows a tied note crossing a change of key changing staff position.
. - On some language versions of Windows, Dorico could not open or save projects if the
STEAM-9896 Localisation user account name contained accented or extended characters; this is now fixed.
STEAM-10119 Lyrics Adjusting a _hyphen before a Iy_rlc at t_he start of the system now always shows the
correct position for the hyphen immediately.
STEAM-9938 Mixer It is now possible to adjust the pan control across the entirety of its range with the
mouse wheel.
STEAM-7337 Multi-bar Tempo marks no longer incorrectly cause multi-rests at the start of the system to be
rests widened to the width of the tempo mark.
MusicXML Dorico could crash when importing invalid MusicXML files containing invalid time
import signatures with multiple <beats> elements; this problem has now been resolved.
STEAM-3134 _l\/IuszML Grand staff instruments with a different key signature on each staff are now imported
import correctly.
MusicXML Sometimes, grace notes created by importing MusicXML could end up with incorrect
STEAM-9420 imoort durations, which could in rarer still circumstances result in a crash; this has now been
P fixed.
. It is now possible to exit note input (i.e. hide the caret) by pressing Return when there
Note input . ;
is no selection.

i . When inputting onto a percussion kit, a single note on the MIDI keyboard could result
STEAM-10093 Note input in two notes being created in the target kit; this problem has been fixed.
STEAM-6627 Note input Duplicated unisons are now always correctly handled by Add Notes Above or Below.
STEAM-7112 Note input Inputting a noteina bar foIIowmg a tied note with an acc!dental starting in the previous

bar no longer incorrectly results in the new note being given the prevailing accidental.

i . Moving the caret left at the end of the flow no longer skips over all rests at the end of
STEAM-9895 Note input the flow and jumps the caret immediately to the last note in the flow.

STEAM-9905 Note input Using the Use percussion map option for MIDI input onto a percussion kit that has

been imported into the project now works correctly.

Dorico 3 /\—L a3V ERE

35 R—T Steinberg Media Technologies GmbH



@ steinberg

ID # Component Issue
Under some circumstances, Dorico could ignore existing grace notes when
STEAM-9931 Note input determining the octave to be used for the next note to be input. This problem has now
been fixed.
STEAM-9945 Note input An_ additional notehead is no longer sometimes added when inputting tied chords
using a MIDI keyboard.
STEAM-9946 Note input MIDI rgcordlng into a S|ngle-§taff .|nstrur.nent with an extra staff above or below no
longer incorrectly uses the split point for input onto grand staff instruments.
STEAM-9950 Note input Itis now possmlg to |nput.rests using Y in tablature even if you have not yet input any
notes since starting note input.
STEAM-9957 Note input Write B Edit Duration B Extend to End of Selection now extends all notes in the
selected chord, not only one of the notes.
STEAM-9963 Note input _Dorlco no _anger sometimes loses its connection to the MI_DI keyboard during note
input, requiring Dorico to be restarted to restore the connection.
. Under some circumstances, Dorico could crash when inputting onto both staves of a
STEAM-9972 Note input grand staff instrument. This problem is now fixed.
When music is inserted or deleted (for example, using the Shift+B popover), note
STEAM-9847 Note spacing  spacing adjustments are now automatically moved so they remain associated with the
right music.
Under some circumstances, the left-pointing stem on a split-stem chord could be
STEAM-8346 Notes forced unnecessarily far away from the main stem by a back note. This problem is
now fixed.
The notation option Notes starting in the middle of the beat ending at a beat
ST ies boundary without crossing the half-bar has been removed.
STEAM-9771 Notes The placement of rhythm dots on fret numbers in tablature has been improved.
STEAM-10074 Page layout Making a_djustm_ents to the height of_mu5|c _fr_ames in Engrayg mode now always
correctly immediately updates the vertical position of system dividers.
STEAM-2215 Page layout Edltlr_lg master pages in large projects with condensing enabled is no longer
considerably slower than expected.
STEAM-5536 Page layout Whe_n_ editing text in frar_nes in the master page editor, any properties that were
modified — such as text alignment, or border — will now be correctly preserved.
STEAM-10080 PDF export L_Jnder some circumstances, exporting a_Iandscape page as a PDF_ or other graphic
file could result in a page size twice as wide as wanted; this is now fixed.
STEAM-9838 Percussion The fallback behaviour for flndlng appropriate sounds for percussion instruments that
do not have any exact matches in the chosen percussion map has been improved.
STEAM-9974 Percussion Slmply selecting a different percussion map in Play » Percussion Maps no longer
incorrectly shows the percussion map as modified.
Attempting to delete the initial value in the Time lane in Play mode when there is no
STEAM-10031 Play mode explicit change of tempo at the start of the flow no longer incorrectly shows an error
message.
STEAM-10036 Play mode _nght-c_llcklng in an expandgq lane in Play mode now shows its context menu
immediately, rather than requiring you to leave and then return to Play mode.
STEAM-10049 Play mode Dorico could sometimes write out duplicate Mixer channel entries when saving projects,

which causes reopening them to be very slow; this has now been fixed.
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ID # Component Issue
STEAM-10096 Play mode If_you deactivate a VST instrument in the panel in _Play mode, the state of the plug-in
will be correctly restored when you reopen the project.
STEAM-10153 Play mode Clicking tq ex_pand one track in Play mode would unexpectedly cause all tracks to be
expanded; this has now been fixed.
STEAM-8526 Play mode |t.IS now po§5|ble to move the start and end position of a gradual tempo change in the
Time track in Play mode.
STEAM-9870 Play mode Automathn lanes now more reliably show the correct data when independent voice
playback is enabled.
] After using the Eraser tool to delete notes in the event display in Play mode, undo and
STl Play mode redo are no longer incorrectly shown as disabled in the Edit menu.
STEAM-10097 Players Delet_lng a_player no longer fails to delete the layout if the layout has manual staff
spacing adjustments.
Playing Adding a new playback playing technique in the Edit Playback Playing Techniques
techniques dialog no longer sometimes causes Dorico to hang.
Playing Creating and then deleting a playing technique within the same session in Engrave »
techniques Playing Techniques now works correctly.
STEAM-10113 Playing Changing the size of the Playing technique font font style to Absolute rather than
techniques Staff- relative no longer causes text-based playing techniques to disappear.

Project files

Under some circumstances, Dorico would unexpectedly create empty temporary folders
alongside a Dorico project when opening it; this has now been fixed (Windows only).

Project files

Under rare circumstances, instruments could be unexpectedly renumbered when
reopening a saved project file; this problem has been fixed.

STEAM-10104

Project files

Dorico no longer fails to open a project that was last saved with a null-terminated string
as e.g. alyric.

STEAM-10156

Project files

Switching to an open project that has no playback data no longer causes a crash.

Under some circumstances, repeat ending lines would not draw correctly if split over

STEAM-9668 Sr?é)iiats a system break where the staves shown change; this is now (very nearly completely)
9 fixed.
You can no longer move an instrument to a section player already holding an
Setup mode instrument using the Move Instrument to Player submenu in the instrument context
menu.
Temoo Itis no longer possible to set the final tempo percentage for a gradual or relative tempo
P to 0%, which could cause problems with calculating the playback duration of a flow.
Setting the Suppress playback property on a gradual tempo event is now correctly
Tempo A
preserved when the project is saved and reopened.
STEAM-9806 . Lo . . . .
STEAM-9819 Ties The placement of ties in opposing voices in tablature has been improved.
STEAM-9955 Ties The engraving option determining the appearance of ties notes in tablature is now
correctly applied for ties between notes in different voices.
STEAM-10150 Tlme Changlng the (jenomlnator style of a time signature now always causes it to be
signatures redrawn immediately.
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ID #

Component

Issue

STEAM-10115

Transposing

Selected key signatures are once again transposed correctly.

User
interface

The beat unit buttons in the Find Tempo dialog no longer overlap incorrectly.

User interface

Under some circumstances, Dorico could crash when dismissing a popover; this problem
has now been fixed.

User interface

The Description field is now correctly enabled or disabled depending on the state of
the lock icon in the Play P Expression Maps dialog.

User interface

Itis no longer possible to choose another layout from the layout selector on the toolbar
while editing a master page pair.

User interface

After confirming the Edit Percussion Playing Techniques dialog, the Edit
Percussion Kit dialog is correctly brought to the front rather than hidden behind the
project window.

User interface

The Playback playing technique menu in Engrave P Playing Techniques no longer
occupies the entire window (Windows only).

User interface

After changing a field in Project Info with the Project selected and clicking Apply,
further changes are registered and thus correctly re-enable the Apply button as
expected.

STEAM-10014 User The click areas for checkboxes in tables (for example, the Markers section of the
interface Video panel, and the Recover Auto-saves dialog) have been improved.
User Using Edit » Go to Next/Previous Flow now considers which flows are attached to
STEAM-10032 interface the current layout, so they do not stop navigating if there are any “gaps” in the
assigned flows.
User Enabling or disabling fixed tempo mode by clicking the tempo beat unit in the toolbar
STEAM-9912 interface no longer incorrectly causes the score view to jump unexpectedly to a different
position.
STEAM-9920 User Under some circumstances, the release portion of a mouse click was not recognised.
STEAM-9930 interface This problem has now been fixed (Mac only).
User Drop-down menus in the track headers and VST Instruments panel in Play mode no
STEAM-9933 interface longer unexpectedly change the selected value when scrolling the mouse wheel over
them.
STEAM-9995 ilrJE(Srrface Help » Check For Updates now correctly redirects to a page for Dorico 3 downloads.
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Issues resolved

ID # Component Issue
. . EastWest Play, UVIWorkstation and other VST 3 plug-ins that use PACE Anti-Piracy
Audio engine - . h
copy protection are no longer blacklisted by Dorico (Mac only).
. Under rare circumstances, Dorico could crash when starting audio export. This
Audio export -
problem has now been fixed.
Nudging bar numbers in Engrave mode with Alt+arrow keys now updates the score
Bar numbers . : .
display immediately.
The line thickness for O and X symbols for open and unplayed strings at the top of a
Chord . :
diagrams c_hord diagram now scales correctly when chord diagrams are drawn at very small
sizes.
Chord Chord diagrams no longer appear larger than expected when enabling them in projects
STEAM-9777 ! : . ) .
diagrams created in earlier versions of Dorico.
STEAM-9784 Comments Comments no longer cause multi-bar rests to split.
STEAM-9671 Condensing Tied notes and gllssar.ldo_s were often spaced more narrowly on condensed staves
than on regular staves; this problem has now been fixed.
Under rare circumstances, the presence of an octave line with an (impossible)
STEAM-9704 Condensing negative duration could cause slurs not to appear in condensed staves; this problem
has been fixed.
) . It is now possible to edit or hide player labels that appear both above and below the
STEAM-9749 Condensing staff at the same position without affecting the label on the opposite side of the staff.
When player numbers are stacked vertically in staff labels for condensed staves, they
STEAM-9786 Condensing are now stacked in ascending order rather than in the order they are assigned to
voices.
STEAM-9861 Condensing Music fqllowmg an instrument change on a system where condensed staves are
present is no longer incorrectly narrowly-spaced.
When switching off Export layouts as separate files in the Export Flows dialog,
STEAM-9815 Flows Dorico resets the selection of layouts to be exported, ensuring that the full score will
be exported.
Font styles Changing the font, size or style in Engrave p Font Styles now always saves correctly,

even if an item using that font style does not yet exist in the project.
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ID # Component Issue
STEAM-9603 Guitar bends The position of the control points for guitar bend_s no longer jumps unexpectedly when
releasing the mouse at the end of a drag operation in Engrave mode.
. If tied notes are set to be hidden in tablature, the target note for a release will still
STEAM-9603 Guitar bends appear if Fret number appearance for release is set for it to show.
STEAM-9758 Guitar bends The position of .the endpoints for guitar bends relative to the stem side of beamed
notes has been improved.
STEAM-9760 Guitar bends  The appearance of multiple simultaneous pre-bends in tablature has been improved.
STEAM-9807 Guitar bends  Guitar bends that cross a system break now draw correctly on both sides of the break.
STEAM-9700 SliET Notes with pre-bends are now assigned to the correct string by default.
tablature
STEAM-9759 Harmonics Natura[ harmonics on grace notes no longer incorrectly extend to the following
rhythmic note.
STEAM-9764 Harmonics Changing the harmqnlc. type from art|f|C|aj to natural no longer sometimes results in
two fret numbers being incorrectly shown in tablature.
Harp pedalin When a harp pedal change is hidden in the current layout, the pedals are now listed
PP 9 inthe signpost in the correct order, i.e. D, C, B, E, F, G, A.
STEAM-9891 Harp pedaling iA partlal pedal change consisting only of pedals on t_he left-hand side of the harp no
onger incorrectly contains a line break between the first and subsequent pedals.
Li . A problem with the Soft-eLicenser that causes some File » Export options to be
icensing s
missing on some Macs has been resolved (Mac only).
Localization Tunings for fretted instruments are now translated in non-English versions of Dorico.
Lyrics Various fixes to the Edit Line of Lyrics dialog to improve handling for individual lyrics
y including spaces, and accented characters.
STEAM-9778 Lyrics Nudglng lyrics vertically in Engrave mode no longer moves by a different amount
depending on how many lyrics of which kind are selected.
Navigati Navigating between system-attached items, such as rehearsal marks, in systems with
avigation . f . ; :
multiple staves using the arrow keys in Write mode now works more reliably.
Note i Under rare circumstances, Dorico could crash when using undo during step-time input.
ote input . '
This problem has now been fixed.
. Explicit rests are now always created when Force Duration is enabled during note
Note input . . . . ) - PR
input; otherwise, Dorico simply selects the appropriate existing implicit rest.
. Double-clicking on a string in tablature to start note input now always shows the caret
Note input ! >
on the appropriate string.
Note i When confirming a popover, the focus is now explicitly returned to the score view, so
ote input o ;
that navigating around the music works as expected.
STEAM-9639 Note input Advancing the caret with Space now correctly advances by the same amount when it

spans multiple staves.
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ID # Component Issue
STEAM-9799 Note input If the caret is already expanded across all staves, typing the up or down arrow key
now resets the caret to span just one staff and navigates it between staves as normal.
The feature to retrospectively improve the enharmonic spelling of notes input via a
STEAM-9812 Note input MIDI keyboard was inadvertently disabled in Dorico 3; it now works correctly once
more.
STEAM-9843 Note input When inputting notes with multiple v'wr!dow.s on t.he same project open, the score view
will no longer try to follow the caret in inactive windows.
STEAM-9846 Note input Starting note mpqt from a §e|ected bgrllne or other §ystem-attached item now shows
the correct caret if the top instrument in the system is shown as tablature.
STEAM-9781 Percussion When_ inputting multiple notes onto a percussion klt_ using a MIDI keyboard, playing
techniques are now correctly created for the appropriate instrument.
When moving through different instruments in the kit with the up and down arrow keys,
STEAM-9798 Percussion the last chosen playing technique is remembered for each instrument during the input
session.
STEAM-9803 Percussion It is now pqssmle to input rests onto a percussion kit using a MIDI keyboard if rest
mode is active.
Having the system track visible could result in occasional delays while moving the
Performance s
mouse around the score; this problem has now been resolved.
STEAM-9882 Playback Clicking Reset to Default in Play P Expression Maps and Play P Percussion Maps
templates now resets back to the state defined in the current playback template.
Long names for VST instruments that cause them to appear elided in the VST
STEAM-9793 Play mode Instruments panel no longer cause Dorico to use excessive CPU or, in rare
circumstances, freeze.
STEAM-9810 Plav mode It is now possible to change the port and channel correctly in the Chords track in Play
STEAM-9814 y mode.
STEAM-9813 Play mode Edits made to the velocity of grace notes are now correctly respected in playback.
If a project had been saved with a VST plug-in window open, and that plug-in is no
STEAM-9822 Play mode longer available when the project is reopened, Dorico could hang. This has now been
resolved.
STEAM-9830 Play mode When enabling independent voice routing in Play mode, Dorico now always ensures
that additional sounds are loaded for extra voices.
STEAM-9831 Play mode The Duplicate button in the action bar at the bottom of the VST Instruments panel in
Play mode now works as expected.
STEAM-9833 Play mode Under rare circumstances, Dorico could hang when starting playback. This problem
has now been fixed.
STEAM-9870 Play mode When independent v0|ce.r01_Jt|ng is enabled, the dlspla_y of automation lanes for each
voice could get confused; this problem has now been fixed.
STEAM-9885 Play mode When the Sends section is ylSlbIe in the Mixer, it was not possible to start playback;
this problem has now been fixed.
STEAM-7799 Playing The Horizontal offset for text playing techniques option on the Playing
techniques Techniques page of Engraving Options works correctly once more.
Plavin Grouping a playing technique that shows a sim. continuation with a later playing
STEAM-9341 tecgnigues technique no longer results in the sim. marking remaining in addition to the correct

transition line.
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ID # Component Issue
STEAM-9654 Playing If a playing technique continuing over a system break would be sufficiently wide that it
techniques would result in the line being unable to draw, the playing technique will not appear.
STEAM-9709 Playing Under some circumstances, playing techniques drawn as repeated glyphs would not
techniques update correctly when editing or undoing edits to their notes. This has now been fixed.
Playing Edits to factory playing techniques made in previous versions of Dorico are no longer
STEAM-9776 . : o ' s
techniques unexpectedly lost when opening that project in Dorico 3 for the first time.
Playing Deleting a bar or otherwise removing time from the middle of an ongoing playing
STEAM-9804 . . . . -
techniques technique now always correctly updates the duration of the playing technique.
Playing When ungrouping one or more selected playing techniques, Dorico no longer crashes
STEAM-9884 . . X - A
techniques if the selection also includes an implicit rest.
. ' Under rare circumstances, Dorico could crash when opening a project created in an
Project files . . ) >
earlier version. This problem has now been fixed.
. ' Dorico no longer crashes when opening projects created in an earlier version in which
Project files .
instruments that have no set standard or advanced playable ranges are used.
Repeat A repeat marker, such as a segno, positioned at the start of the flow now appears as
STEAM-9869 ; .
markers expected in galley view.
It is now possible to drag an instrument from another player and drop it onto a section
Setup mode . . - )
player in the Players panel, provided that section player is currently empty-handed.
Staff labels Clicking Reset to Default in the Edit Names dialog now also resets the state of the
Show transposition option to its default value.
STEAM-9789 Tablature If bot_h staff notation and tablature are shown, lyrics now appear only on the regular
notation staff.
Text Dorico no longer incorrectly reports that certain fonts are missing when opening
projects created in earlier versions of the application.
T When creating a new paragraph style, the font chosen by default will now reflect the
ext ; Lo
choice for Default text font family in Preferences.
STEAM-5536 Text _Ent(_a_rlng_ text into a frame from a master page with n_on-default properties (e.g. vertical
justification, border) no longer causes those properties to be lost.
When overriding the default choice of font for an existing font, paragraph or character
STEAM-9829 Text style, if the weight requested by the original choice is not available, choose the Regular
weight.
STEAM-9792 Tokens The_ resolved values for d_ate an(_i time tokens now follow the operating system’s
regional and language settings (Windows only).
STEAM-9799 Tokens All SMuFL codepoints are now correctly resolved from tokens.
STEAM-9387 Tuplets It is once again possible to flip a tuplet number/bracket using Edit » Flip.

User interface

When migrating user settings from a previous installed version of Dorico, the migrated
preferences are now used on the first run of the application, instead of needing a
restart.

User interface

When a modal child dialog opened via the Preferences dialog is open, it is no longer
possible to close the Preferences dialog until the child dialog has been closed.
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Component

Issue

User interface

The padding of the buttons in the Accidentals section of the Key Signatures panel
in Write mode has been adjusted so that up to five columns of accidentals can appear.

User interface

The Length field in the Expression Maps dialog now correctly saves and restores the
value entered there, but it still currently has no effect on playback.

User interface

The font menu in the Paragraph Styles and Character Styles dialogs once again
appears as as a single scrollable list rather than as a cascading menu that fills the
whole screen.

User interface

When macOS Dark appearance is active, the background of the editor for accidentals,
chord symbols, music symbols etc. is now white rather than black.

User interface

When choosing a graphic to use as a music symbol or playing technique, the preview
of the graphic is now constrained to the size of the panel.

User interface

If you have changed project info values in Project Info but not yet applied them,
copying info from the project to a flow will correctly use the updated values, not the old
saved ones.

User interface

It is now possible to set custom key commands for the pencil, line, erase, and
percussion tools in Play mode on the Key Commands page of Preferences.

User interface

When clicking e.g. Save as Default, the Close button in the options dialog will be
disabled until the operation completes, to avoid a crash when closing while it is
ongoing.

User interface

The selection in the list of flows in the Project Info dialog is no longer unexpectedly
changed when clicking Apply.

STEAM-9722

User interface

Attachment lines now always correctly appear for selected items; previously they could
disappear if they were exactly axis-aligned.

STEAM-9775

User interface

The Pages and Master Pages panels in Engrave mode have been reworked so that
scrolling them with a trackpad or mouse wheel is now much smoother.

STEAM-9780

User interface

Hitting Return in the Project Info dialog no longer causes a new flow to be added to
the list of flows; instead, Return (like Tab) now advances through the text fields on the
right.

STEAM-9827

User interface

Under some circumstances, Dorico could crash when showing a menu over a button
in the Mixer or in the track headers in Play mode; these buttons have been reworked
to solve this.

STEAM-9863

User interface

Changing the page margins for multiple selected layouts in Layout Options from Same
to Different no longer results in a crash.

STEAM-9867

User interface

Opening a project from Dorico Pro last saved in Engrave mode in Dorico Elements no
longer shows incorrect properties in the Properties panel.

STEAM-9048

Video

Closing the Video window by clicking its close button no longer causes the video to
fail to display when the window is subsequently re-shown.
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o4 Enable condensing

Groups to exclude from condensing: Custom condensing groups:

@ Piccolo 1, Piccolo 2 Soprano, Alto
@ Flute 1, Flute 2, Flute 3 Tenor, Bass
@ Oboe1,0boe 2, Oboe 3, Oboe 4

@ CorAnglais 1, Cor Anglais 2

@ Clarinet (BFlat) 1, Clarinet (B Flat) 2, Clarinet {B Flat) 3

@ Clarinet {A) 1, Clarinet (A) 2, Clarinet (A) 3

@ Bassoon 1, Bassoon 2, Bassoon 3, Bassoon 4

@ Contrabassoon 1, Contrabassoon 2

@ French Horn (F) 1, French Horn {F) 2, French Horn (F) 3, French Horn (F) 4
@ Trumpet (BFlat) 1, Trumpet (B Flat) 2, Trumpet (B Flat) 3

@ Trombone 1, Trombone 2, Trombone 3

@ Timpani 1, Timpani 2

@ Soprano, Alto

@ Tenor, Bass
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= A=YV IL—ARTETRTDIL—VY—DEVFEV XL —HBLET . ThE
NOBHICIEFELHEN 1 DT ORRINFET,

s BREHRHA: IL—AATIRTOTIL—V—DUXLHA—HBLETH, EvFMN
BLYFT . HFOKRENVTL—Y— (TIL—b 2 [TTIL—F 1 KUKEW) [ZET
ZEHFN. BFEOPESNIL—N—IZBTEEHLYLEN O, ThETNOEH
SIXE—DFRE. TL—YV—IC BT 2HDOFENRTINET,

s EREHE ITRTOTL—V—DUXLLEYFLERYZETH, HFENTEED
ERICET ALV —OEFN. HENLAZOERICET2E5HEELLT
FITRDHIENZ LGN EREIFRA LKLY FEE A,

= OVTULUTRL URLA—BLEWEIZ, FIL—TIZBTH5TL—Y—RETD
EHOEYFIMAELRET B0, BALERICESADILELTEE A, D5
BAVTUDUTERAREERY | BEEER OERICEEINET,

AZVUFRRFREEZRETORRERICK. FREXATHIL—X DA
ENRILTHALENHYET . ERMNRILERD 2 DOERMIHANTNDIES
THL.ENENDFHDOIL—ADRBMAENHIL, FEHBRSZELSE SO
ERESHNENGERIX. FENTRAEDFHOERDILHEN LAESOFEHOE
FETAL—2avARILTEYFRENEIVENEDE, FEN LEEOFEERC A
BENFET, CNITKY YA LN —HTEHIL—ADEFIEIFREZE 1 DITFEDH T,
HENTRZOFHEZERTIDIXIXLNBEVNESITROARETEET . &
HEEIEFOHEENDI R TOEFERATELVGETIX. TOHEEROEH
IREESNFEE A
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RBHEIAVTUV VT DREROHIRICEETHDEE. ERETDILODEYFHIYX

LEHTEBYFERA. T—Ta4Fal—ar BBES. A5— BRI, &

BLRETOMDHOWHILEETLHELET LR E 2 ADTLAV—IZET S

BERALIZVULTIL—XDMEIHI>TLSIEETH RT—PRBIESHEL

B, FRIELRETHHERTSTONRTADRS—NEENDGEE. TD/\vt—

CDTRARAIREEGDAVTUIVTIE. 2 ADTL—VY—FEREXBFTEEI .
INETNDOEFEIENOERTILESN, BHORS—F-(LRBLESFERD

TNERORIIRRTEINET,

NIZRT D 1 DOFINELT, BERRB LA V2—THRLBHYET . Dorico TIERE
CON—TTLELDBEHESEH DIV AMIILAVIE L., FlE—ADTL—F
—(ZHA I BA—=TENMTNT SR ADTL—Y—IZ (I HENEEEICDVTIE, T
VTV ERATEE T AVT UV VT SNERRICIIFEN LAEDOELD
—BLOTL—V—ICBTBBEHREE LA VI—TELRTIN, T IL—T DD
TL—N—DBWESEAVI—TRIETERICERIAET . COBRMDTL—F
—DERFE. —BLEOTL—V—ICBTHEHRLE LA VTR > Tk
nFE9,

REDAVREYILAVNTEH, BADAFESTFLERABTEH OLOEFIVTUIY
TJEInFE€ A,

EEOIAVTUOVUTIFHMBRI LI ENSEICANOTEITINET  AVTUY

DT ENEEEE, AT ULV ENTWVENLEDEELERLLZKTEABADR

RV EBTHGEEINDBYET . =EZIE BRDEXRTIEIEBTTHLIEHN 2

EOBRIZHIIGEE. AVTU VI SN ERTEIFERMEDETFNRLET 5120,
RAICAR—=RERSOTLEVET . COKSCAVTUIUTEFMTHE LA

TORDEEBEREICERENELDIENIKHYET  MEBEDEFTALTUIUITD

NBENERTHIEIFHEN O OB E THIERICRRLIZTL—V—

A DOERBPTRHOERICBHTHLEHYVEE A,

L. IL—XBMHGEL TOTHEBR S ETaAV T UV VI N ERSNDIEEBL
KBYFERBA, 2EX X HAMBRTHRENLAZOFIICIS RN 1L E2. FEMN
TRIZDEEICASRyE 3 MRICERIZFEE SN TLNTH, ROMETRSURY
F3ARSURYR 1 E2 DEFEEWTLIZEDIEE. FSURYE 3 (ZERI D
RICEEINDSLIITRYET,

LDDDA T ay (FERESHR) LN TE. BEATIRaVTUOV VI DRRICE
BFEMASELETEFEAD., INIFIFEMICEEEINSIFETT . BEDE
CAIE HBERYYEEAT AL CTHRRICEEEZEZHIENTEET . HEHES
Dorico TIL&FIMGHEL AT I EESh, BESN-EEREDHKNA TR
BIRAVT UV DREREERT H5=HTT,
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AT av: BREA T avIicHLGEmENTZIa> T304 (Condensing) 1D
R=DI2IE, avTFooUJ1ZB8T 5 Dorico DEUSEIROEELAEEEET 5.

UTDESEATLavhHyYET,

» TEYFELFDAE (Pitch crossing approach)lif, FEN TFTREDFEDE

YFNFEN LRAZOFBOEYFEECIEE, TL—V—HEREHEFTES
DEIIDHIERLET 2N EINEIRELET . AR ETIEIEYFEI-FLH
BB (Limit pitch crossing)IAGEIRSNTWVET M., CHIEBIILF-TIL—XDER
ERNTIEBRTOEYFEEFDHRARE (Maximum number of pitch crosses
in region) JNIEEEXIYBVEYFELEFEHAALENEEZEKRL, MIHERTED
BRAME 1 ICRESATOET, EvFHNFELZWTEEICTL—VY—IELCERE
HETEDLLSITTBHE(E. TEvFERLEFD AL (Pitch crossing approach)]
M HoBEYFE-FXEFA (Allow unlimited pitch crossing)JIZFRELET .

PRIV A—2ar ik (Amalgamation approach)lidE. FEMN TREDES
DEREREN LRAZOFEEICHEES T HILEHATINEINEIEELET . 7
BN ELAZEOFMEFAENTRAZOEFHOIL—IXBHi>TWWTH, TL—v—
ARILFHEEZHE TELEVRED X LN EXSHHE . Dorico DHEAERE TIX. &
ENLAEDFEBOBTRERALTAL—LavEHE OBENATREZDFHOETRH
FRENLAZOFEMMIHEEL. 2 DOFEHEERTIDILXLHIERLGSUE
EFIZEBEIILET ., COKIGEKRTEIZ 2 DOEHINERINDELSIZTS
[ZIE. TPRIVA A= a2 % Ik (Prevent amalgamation) 1% #RLET,

[YALobDTL—Y—Dar T’ (Condensing for inactive players)l
F. AT T DT I —THTKRATNSTL—NV—% ESH/RSIMNRELET,
NIZIE 3 DDERENHYFET

o 79747 DTL—Vv—LE&hHHES (Pair with active player)]Z®E &, OV
TV INERROFEN LAZSELETREVTNAADOEERICH ALY
FDTL—N—HDEIYLBTOENET . TITATDTL—Y—FE5—FDFEED
[CEYHETON, HALUrDTL—N—ZIEARFABEYIRTEINET,

o MNERINIVIZED (Include in staff label) JFRRE, HALUrDTL——
FAVTFUooU T INERICERRTEVETON. 7TIT4TDTL—V—
FREN LAEETRAESOFEMEAZHERATEES . YLD TL—V—(&
ERADERINILIZOARTINET,

o M T U4 L (Do not condense) |Z5&5E. 3Z& T AEIEIZDNT
HALURDTL—Y—[FarToivihoiaish, avsFoiviasnizn
BERADERIZKRRINET . COA T avid,. EHDEREFERRICTHH
EEBRLTWSGEEICERTY,
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HEATIE. EHOHALUMDTL—Y—% 1 DOFEICITFTFEDEL A D=
OHIPITF4TDTL—Y—EE&HHE B (Pair with active player) A& RSN 1=K EE
TAVTFoIVT DT IL—TRIZKATWNSETL—FY—NEH BB E. ALk
DIL—V—ETNENFREERT D0 ERICEVETEIENTES Y AL
URDTL—F—FHmK 2 NIGYFET, CNICBETHEMDA T av EFkmIC
EEINDSFETY,
NBEDFTLavFIRT. 7A—2RKDITRTOIAVTUIVT DT IL—TIH#E
AEnET, SHOV)—RTIE. ShoDF T aviFEEOHER Y DHE T,
ATV DT IN—TZEIERICERTESLIILDFETT,
AVTUDUTLIZEEDINIL EOBRTEDTL—V—HDEELTLENET
ELLET MNP TLT 2HIT. ERADERINILHSHEEBILICEHFINDEL
HITVHEDIZETL—V—SRHEMEN, EOTL—V—HFERIZEFENTL
SO EAREIZRRSNET,
FLOWIL—XORMBMBREIV T VIR ELRTHMEBEI LIS, ERD LI,
FREBEITIECTTICEINLABMEINET 1 ADTL—V—HEELTLVD
BE.ZDTL—V—DFSF 1 DARRINFET, ERICEIYHTON-TRTD
TL—Y—NEELTWSEE. n ADTL—Y—IZEY L TIZEHERT EINILAH,
fz&AETa 3JELVSBATRREINET . BEHOTL—V—AREZHBLTLS
KET 1 AULEDTL—VY—HAMADFEIZEY B TONTLSAERL TV
H5E. INILIETERIEN1.2 a 2] ELSB T RELEDTL—V—HFEICEYHT
LN TSN ERFEIZLET,
TL—Y—IRIVICET BFTavid #EF T avIicHLGEBmEN IOV Ty
<% (Condensing) IDR—U TR TEET . chbDA T ar T, ERICHT
BT IAINCDKFEMECEEMBELZEELY, TL—V—IIHIETEHFERY]
BEHNEIMR EVAREBMLIZY T ENEINEIRETEET,
HEEFTRH. TL—YV—IRNILOMBEEHRARE LRSI THRELEY., 7O
INTANRIVIZFLGEMEN=TaY TP F5R)L (Condensation Labels) 10
FIN—T2HBHRELTF XL (Custom text) IO TONTF4EAVIZLTTFF R
ERELIYTEET . ALY IIL—TDIERT (Hide) IOTANT1EFUITT BT
ETARDSIRNIVEFFERTRICHLTEET, REDTO/AT4THIT (Line break)] T
(X, TL—N—SR)VIZRITERATEIETKEAMEININITEET , &
ZIEM1.2 a 21D K535 N)LTIEEHTANa 2 1 DRTIIEASNE T [1.210 K575
NILTIE. 2 DOHFORICHITHEASINET,

TL—NY—SRLDIT+V b REANFELF YA XEERET BT . THE
(Engrave)] » [/185557RX 44 )L (Paragraph Styles)1TlavFoovds5~RL
(Condensation Labels)1D /855 57X 4/ JLERELET,
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ERINIL TL—YV—SNLOMIZH. 2 DOFHLWAToawNigELF T3>0
MFE&RSJL (Staff Labels)IOR—I(2EMENELT-, Thik Dorico NI T
DU ENTERICTINIVEMFEFEERETHLOTY . ATV TENT-
TL—r—DTL—r—&FE (Player numbers for condensed players)ITl&. 1
DAY AVREDERICTL—YV—FEEH TR ((EBEICRAYY (Stack
vertically)l) 50, AV ARYIIL AV EDERIZITTERT (TKEIZRAYH(Stack
horizontally)]) 5MERTEET,

[E|EICRAYY (Stack vertically)1ZEiRT 5L TL—YV—FBESDEROERE L.
1 DTFOATalavTFoivdesnt-IL—v—0IL—Vv—BELEEICRAE
w93 BB A (When stacking player numbers for condensed players
vertically) IICk > TRESNE T, RO LT EN TN OEICKIE T HKS124T
FRIZTIL—YV—BEEEME (LA 1 £ 2 ZHECTERZDTIEAL1.2) R TR)
I5155(F. FRDEIYETZE KB (Consider stem allocation) 1Z2RLET . #
BICB 5L TORBOENY B TIZEFRGL TL—V—FSEEICH—FITEREET
55E1%. TRHEDEY Y TEME (Ignore stem allocation) JZ:&IRLET .
RIEDAVRARGILAVMI&DAVT UV T INT RV ERHL5HE . TRED
YOEBHABEET B A DHESRIL: (Staff labels for identical adjacent solo
instruments) IO A T avirRMEInEzdT  [HERETIL—FILT S (Group
between staves)|#EIRT (&, av T EN=ERBIZIEIFlutes 172 EM
PRFIZ TREIN. TNETNOERICIEL2) 03 GEDBEENHEET,

SESFLHTATLOWLIE: FFLUSIH, Dorico [FEEEIV T T TBHRRIC

DT EEDLIITNE T EINRET DBLENHYFET , —MEHIIC, 2=V

FLEFRERETIa0TUOL VI DERIZEWTIE. FIL—TROTRTOT

L—V—DEEEFTDOME. Tab—av, BLUNBN—BLTWIDBELHY

T, —HBLLGWMEETH, TL—V—FEREEBTEEIN, BlADFETRE

SNFET ELBER SIS TL. AT U VI ARRICEHESNET . UT

[CZEDEBZZEITTVET,

= FIRCFEE: 3EOTL—NV—F RTHAMEDI=J VITHE-TLDIGFEIZD
HREEHRATEEY,

» 7—T4FalL—2av: 1EQTL—NV—FRTOT7—TasFaL—av B —HL
BN, A=V UFERERFRERE T T UV VT EERTEINFERA 7T—
TAF L —2avARLRIC—HLAEWMES (. 3V TUo VT TELDIEERD
FFETTY,

» IMAYE—RRES AV T ULV ETESICIE HEDTL—Y—F RTO/MVE
—FMEEOME. TaL—2avBLWNEHIE—FEEDAI VLD RATH—
LTWBREAHYFET —BLAEWNMEE. TL—V—([FERERFTEE LA,
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B 1=V Y EEBRORANTELNESMDOVTIL, EHLHELET .
YR LA —THEH T L —THEVESBE . AV TL LT TEHDIFHERD
#EFTTT,

A—RESHEE: U TUUU Y SNEBRICE. HRA LREOERO—F LD
TL— X —OI—FRSBENRTINET OTL— Y —ISBT SREIET
RTHBENES, I-FRSHBE, RISV TULV I RREOEELE
HIRLEE A

B E: AT o v SnERERICK. FEALAZSOESO—FBLOTL—
V—DEREENRRINET MDD TL—V—ICBTEHEREEILTTRTHEE
INFET, FEHERE L. BTSNV TUV VRO ESWVEHIELEE AL
Fao— Fa—(Far T EINEERRICEIRFTEINT BfTSshdarTod
VORRODESVWEFIELEE A,

MBS A=V UERIEIFROEENTELINEINIZDLTIL, BBFEELE
EBLET  BRBEENBLESIIES. AV TUI VT TEADIFEROEFETT
T RBIEBDMEIX, AT oIV T EN-HERTEIBFHICLS L THAELESH
T, ChICKYRTBERESLFEHEDBEENKYRAREICLEYET, BBEESITT L
—JTETEESINS=H. 1 DOEBBIEELUNEIFES=KEL 2 DDTIL—TMN
Ho=BEE. FNEFNDTIL—TDRBIEENEROBAIIZRTEINET,
G)yHY IR A UFERIIFRERET STV TN TELIMESIMNIZD
WTIK. TV U REEELE T, JUVHURABLESES. OV Ty T
EHDIFEROEFETTT,

BN EMEFIIEEDETFERCIL—ILIZHNET,, T-EEL-B2ED
BEFIZBWT, A=Y U FRERFREHERET 20TV VINTEENESIHD
FIEFCRELET . EMHTRLABNESIGS. AV TUI VI TELDILERD
BETTY,

FR—AUR: AV VFLIFEERETLa0T UV TN TEEMESHMIZD
WTIE, FEA—ARURBEELFET, FEI—AURAEBLESFE. aVTUIVI T
EHDIFEROEFETTT,

EREEEARIERES: 7 v—2EbRRILEESFEERICETATATLTHY.
RITEINBAVTUVVTRBRODEASVEFHIRLEREA. ILREEDHEFLE
DERITRTIZEVWT—HIIBENDBYFET, BLVESHAE. JL—Vv—nay
TG IXRITTEEE A,

X RAT7—T4Falb—2ay: A=Y UFHIIFEEZRET R T ULV MNTE
BEMEIMZDODNTIEK, O X7 —T4FaLb—a b EELET, O AXT7—T 41
Falb—avhBLESGE. AVTUVU T TELDITEROXFETTT,
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AS: LEOTL—V—RLTOASHBLGESISE. AVTUVUTEETTEE
‘A,
WA A=V UFEFRERET 0TI MTESINESMIZIDNTIL,
TEALEELTFT . BLESHA. OV TUV VI TELDIEEROKEEETTT .
BEATORATLET AR EMIESNTEY . RENLET1L—aVIEFE
CTHLEBRDT 2L —2av (FEGHHER (FEAIFRABET 1L 1 DOEF) I
WTIFBELLEV O, WAL L TIZHINTRRSNDI LD BEMGEE &
YEZLBYET,

FHB8—T8: AVTUVU TSN RRICE. FEN LAZOEHO—F LD
L—Y—DHERICET D73 —THRBIRRINET DT —V—IZET DA
DE—TRIET R TERSINET, —AT. FEREFDOAVE2—TR(Ea>To
VU ERLICAELET .
EMTEMNIL AV UFRAFEERE T LTI TNTELMNEINIC
DNTIE EMBFEMNLEEELET NILDIGE, TaL—av ERENLE
BOBmANZELET EMHETLNBIESIGEE. AVTUIUI TELDEHERD
HEETTY,
Ayl atElE: WERATIE. Ao a @ Far 7o 0 TET  RAIviaf
HBEHEOTL—YV—IEZDTaL—avhFarToi o dIcEFEnEz A
ARS5—: AV VFEEREHREZEAITZAVTUVUIMTEEAESIAIZDOLTIEL,
ATS—HEELFT . AT—DHE. TaL—a FEIIBEDRIMILHAELES
5E. ATV TEBDIEERDEFETTT . —A. TRTOIL—V—
[CB T BRS—HARE—THDHA. Dorico [FRS—E#HEL. AVTUoIvTEh
FRERODHFAIZ 1 HOHADRST—ERTLET

THXAN A=V UFERERERERET a0 TOO VT MTEIMNEIMNZDINT
(F. THFRAMBEELET MEBEFIETFRNTATLORBNEBLESEE. O
VTV TELDILERDEFETTY,

A4 EHEOAA L, EHBEFHISZEDEFADIIEEH T BHATEIY
TV TEFERA, INFaVTUOO VT EREFFLERAMN. OVTIIUT
SNFERICKRRINGAGYET , LY—BMICIE, BE—OFBOZTRED 24
. A=V UFREFRERE TV TV I NTEINESHDFIETIZHE
LET . HEIBEHDTL—avhTal—av bl i>TEEESA T
558, FEEZEEATELDE. TRTOBEHAMNRAKICTL—avF LEES
NTWBBEDHTY  ZAFEFVALLEDA TV ELESES. aVTY
VU TEBDIEROEEFETTY . LEI(TLEASIFaAr T snt=5E
RICRTEINFT . LEDTL—V—RHTRIGESBE. VT VT TEDDIE
EROKBETTY,
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» AFREE: HEDTL—VY—RTORFIEENEBLESIGE. AVTUIUTIEE
TTEEEA,

s ER AV UFEREREEFREAETHAVT UV TN TELINESIHNIZDLNTIEL,
EHLEELFET, EEMATAL—2av T TG B R —HT 5
HERHYET, EFABLLESEE. AVTUIU I TEADIEEROLEEFET
T,

HERIZB T AT7ATLIZIK. TUR Un—HIILv—4 . v—h—. 3—FiE8. ZL T

JE—MEMABYEI N, IhSFIRTLAT7IOMToarnlEREMER

(Staves and Systems)|DR—U TERLIzA T avIzi BEICHLTIVT

DU ENRRICERRINET,

BHOEREEDAVARIILAVMNEAV T OO TENGE N =8O RELEEE/N—

TREIOERIERIZAVT OOV SNFERIZIIRRESNEFB A AHFIZ 1>

ARYILAVMMEMDERE -V THEHAEE. TNoD/\yvE—2(FarT

DOV TEFERA,
RTINS a—T425: ATV THEREYDEENBLOALGNES ., LD
MDEREELAHYET,

» LEDERTTEICERDOEFBNMERSA TGN EEHERELET . T TORN
BLRCEIIZBLTLSIERT HICIE, TEa— (View)] » TEFLARFDOHS
— (Note and Rest Colors)] » I'E&Hh5— (Voice Colors)|ZEALE T, FEp
N—HBLLGWNGE . ARZ TR TEIRLT, T{RE (Edit)] » TEE (Voice)] » IFHE
EB#Z®E (Change Voice)] » TFFEMR LMZDFESER 1 (Up-stem Voice 1) 1% %
RLT. IR TOEELZE—DFEICHELET,

» ATV DORREEDTAT LB THRTH5TONTAHENHNERLET,
FEDAR., Tab—ray, BHRESLENBRIISNZEFILENL. EfTSh
ATV IIRHRDESVWERIRLET . #ESNIBREERLT, TRE
(Edit)] » T4+ 8% vk (Reset Appearance) 1z LET,

FREHALTEMRSLBWGEE L. 7+—FLIZT VAL T, BEL-MEICET

SREROFIZRRLTOETNIE AEF—LABIDEEBLET FR—FFET,

FEDHE: FEDV)—ATIH, AT T HEEED S HE LR EM

SNFET BROAVTUOO VT HEEICET S — RNy IZBUBLET,

www.dorico.com/forum DIA—FLIZFIEALT, AREF—LPI—F—HEL

BEEEIZDWWTEELEIDFLAMTLEI D,

Fa—nA I
Dorico [Z[&. FA—PZDMDTLYMEZRD O DI T EIERBERENRESINFEL
fzo CNIZEZHOF4—ERDERMWLGRELS . AIRZLDEDF1—=27
RTELET)ALERDT IESFHRALGEDYR—IDNEENET, thDRFEE
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Y7 7(2x LT Dorico AZDREHTHEDIA=Z—ILFAD 1 DX BED
BERDEREATHEAFRIFICEECRTTE, —ADORENMEAICEHBIMICRIRS
h3ZETY,

Fa—=2J%FER: Dorico BNRFTFEERTT H1=HITIE. AV ARYILAV DD

. BEROFABMZOEYF. ZLybDE. BB TIL Yk (NP3 —D%E 5 ZD K,
BREDZMN T YK LHSIEFEDER). BLUVILYLDOEE (FRAIOTFVo

DEAT =y IDEE) DEBRPIBELELRYET,

Dorico THL—N—IZTL Y RBEEY LB TH=EE, TDAURARY LAV T—HEH)
[CERASNEF1—=U D ERHDIEE . IV ARYILAVRERKRY T —1—D
BRIDF|Far——UFN—ERRTIN, FRTEIF1—=- I RO 5ERTE
EX I

[B/N\—23> M Dorico TEREN =700 I DTy 1d. Dorico 3 T7OY
THOLEMHTRCESE BEFLIERL—MRWEKREF2—=0 T DEIVA BEM
[CEAEf FoNET,

BEFA—— U EERTHL—BEBELAEIL. TDAVRMIILAVLE, BRIDF
A= EBE DDAV ARY I AVNIERTTBEIETT  AVARYILAVRESE
B3 BI2IE. 22 Dorico ARL— 30 =aFILICERESINDFIRIZHE->TLE
= AW

BEFaA—=UTERE: —RMICERINDIFI—0ZDMDOTILYNERIZIEY)
S ENCEBEREF1— VI ARAESNTOWET BN AV FILDFa—=
TOEBRP. BEOF1—=V T DEENDBELLEE. ZOHICERAOTAT
A NAESNTLET,

HEE—RDTL—V—/{RUVT Fa—=VJEERETHILYREBRHEYRTS
NE=TL—N—DH—FEERLET . ILYFEBIZHIETEIRNILICII AR
A—HEDHED L. AVTXIRMIA—DBEETHIEETTEME O LIFIRN> A
RTREINDDT, ThESYILTAZ1—%FRL, [KEFa—=V 5 EHE (Edit
Strings and Tuning)1##IRLET . RO LSHEFA A7 ET BRRINET,

=dit Strings and Turing

Irszularée s20ang

nnnnnnnnnnn

AVRARGILAVRDEEN, ST IVET ST TREBSIN, FARGEOE Y FIZH L
TILYLDENRREINET  FEDEEVIVIL T DO FICRTINSHRER
akA—=ILDRETIT4TIZLET,
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» TBRBBEOEYF (Open pitch)lX, HEZ TWVEWLKDOEYFEIRELET . T
[ZIZTEREAVHE—T (ZRIL C=C4) & BEITHRLTOY—TIE#1, 75V
[ETb1Z#FERALTAALET,

= [JLybE (No. of frets)JIEEIRFDZDILYMNIEEELET . HEIZELT
BRI EICEANDEERETEET

 TBASRDL b (Starting fret)J(&. BIRFDED 1 FHDILVREHEELET . £
DETIE, /AP 3—DFE 5 ZAEIRINTULETH, ZD3IE 5 FEHDIL YL
MBIRLTLET,

» [$ERFYFFa—=2% EIF (Tune Up Half-Step) 1 EMERTFYFTFa—=UFF
[+ (Tune Down Half-Step) IO & HRAV L, EIRFDEOF1—=2F ZHHEICE
TTEEY,

- BREOOBEOILYMREEIOTFUILUSNIT A [RRAEIL YO/
W8 (Irregular fret spacing) &4 IZLET, # LS T —HEDRBIE, R
EDRT— LIRS 21=8. TLyrORRALZENLDELEDLOAHYE
T, ILyrORREL ST B A%, 2 BT HEAEM21%, 2VYK
YOI TAALTIEELET,

[T RTEIR (Select Al)IRFVZEFEATIHE. TRTODZET (EOGERTESLT-
O FEAFTRTOERDILYNEE—EITERELZY . I RTOREFET OL
TICBHFELEYTEET,
FATAT TEDT I3/ N—TIE EDEM, RZEZ | FFBIBRNATEET,
T#IHAERE(Z) vk (Reset to Default) 129w 93 5E EIRFD AU RS ILAY
FDZEF 21—V T RENERRFOREICRYET,
RRITFoa—=2F%2BEHL (Export Tuning)1&9JvHILT. &EFa—=0
NEBERDHRTEZIEF doricotuning DI7AILIZEESHEET, TNLURIE
[Fa—=2F%FEHARAH (Import Tuning)1E9)vI$BHZET MDA XYL
AVh(RCTRDzHMTHMTADINTE) ITBESHL-RTEEZHGAADET,
GI@FERs JUIVNEBRRADITHERTI DI LATINFToavnlFL
— X — (Players) IO R—C IZHLGEMSNTILYFESEF (Fretted
Instruments) DI aVICBELET, TLYREREN 1 DULERYETONE
TL—N—FTRTITIZRTEIN. 4 DDA TLavn oIy EBDOEEDR
RAERETEETEET,
» IEH (Notation)]IEWHARE CTHRIRSI . EEZEEDEFROERICOART
LET,

= (575 (Tab)l[FHTEICOAEREERTLET T EICITIAFIES. FE.
. BHRELEEN . EEOYXLNRTINET,
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- [ERESTHM (Notation and Tab)[FEBEEENEHDERL. THOTDFT
RISRRLET, SHOBRNH D0, FTHIZFY X LHEESNE L A,

» T4T75% (VX LHL) (Tab (no rhythms)) 13 EEEFTHDATRRLET A,
FiL5. FE. B FHLLFRTINFEL A SRR LABH T U T
BEMDIZEDHTERAMTY .

ROBEEY LT REEFTEICRTTIOICIE. EFEERTHRICERT
DRMNMEESNTVIRENHYFET . BEEFTEICETAENLEEFTBERES
DEREEATOETH. B TANSINFEEE. TIHILITIEZOEIYET
[ZDOWTCEHHERBREFBE R A TNDT=8 Dorico X, ZMNBAREICIEEIN TLY
BOERFIZTOWTIE, BRSO BEEIY B TEETLET, Dorico (&, ¥iL9 %
EEDI=V VT HEMTHEVRYIE. ZIC 2 DOEFZIVETLHEVLIIIRE
=RLET,

BLHZIZ 2 DOEFHNENV LB TONESTE AT LOBRLICHRE TRERSN
FT. NoOWVWI IO ELEEADERERIRLT. FEITHOEY LB TEEET
EFET,2 DULEDERIZTONT,. ZCTLMRETERWEIEN IR R ILAV L
DRILEZEICHEIZLTEENTAGELLGIMAEDLE L EBTRRINET &
EZOKRTIE. WFhDOOERZHIBRT 0. BEEZEETLHILNERRKIEHY
Ft A

BROZEERT S EFELFLETORICHBHTH5E. EFEERLTINIZ
ANTBLELEDKIZ IMIZAANTHETORICBETEES , BRERETELL
RICIEEFEBBSINERT A, TAONTA/IRILOTERF LKA (Notes and Rests) ]
DT IN—TDIEE (String) IDTANT4ZFAUIZTBHIETH, BERDZRERETS
CENTEFET, CCTORIEHRBEELEARAEYFOMATRIRINET (FEXF1E
EF1——2TDXFEI—D—BTDXIII6 (E2)). — B LDFKIEIN (E4)1EFR RS
nEzY),

FENDER FHNFTEICTETLICIXETES (—BTOEDFIYREYIELY),
FEEETED (—BLOZOREDILILKYB) HE. FTEOTEIZ LD
SEICOZRFIVI—PTRRSINET , COLIGEERICDOVTIE, EEFILHI
BRI B FIFA VRN AR DFAa—= VT ERTHILESTTHLET,

BTDEFAN: AT ICEEBEREANTIICIE. A TEOBERFEZDOMOT A
T LEZINLT [Shift]+[N] 7=l [Return] ZAALTH¥LyrERTRL,. SHD
ANZERBLET ., EFTOXRMEF— (11 !]) 2ERALT. BHOERMOATEEIC
FrLyhEBETHILELETEET,

BRILILIYNBEZEETILEMDPANINET . BEROERTHNIEX. T2
L—2av DIEEICERTHHFF—ZFEALET . £ 10 ILybEYBLEREZA
HTBI5EIE. BIZ 2 HiTOHFEFEHRLTRECANLET EXIEE 1 ILyk
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[CAALEBEHESE 2 ILYNMIEERETHHEEE. DLF>THLI2IZANT HE.
ERNEEHBAONET,

Ff= MIDI F— R—FTEHFEEELIZY.A~GC OXEFETELEAALIEYLTES
TEICANTEET, COE. EFIETBRDPDOZKICAAINET, TILT7RNULE
FRALTAATIEAX. FYMI—FBEWAII—TABIRENET,

EFDTAL—avDEEE. BEDTL—a 2 EROFH/ARILTYYYY
TEMN F—R—FLa—rhAvkD [F] T1DRWTalb—Yay [ T1 28T
L—avEBIRTEET . BRDERICBTAIAANTIE. ThoDXF—FZEhEh
RS DI Y —TETTVNEIEE T A-DIERASNET,
RTHETEEEMICTO—RADNDREICHENILS>TLSH. FrLyMIBEEIMIC
FRELEEA YL Y ETORIZBET AICIEETOXRENEF— (T[] %.
FrLybERTEREROT)YRIEICEE T SHIZIFTERF— (<)[~]) ZEAL
FY9,

RTHEDYX L BRDERGLTITEDOAERTLTVDIES . BE(E2TEIZ)
ALERETHOMNMERTY , XY, HFESLEREFTEISBRNENDS
TATLNRTESN, EHVCNTICHE. FOSIVEMNTESNET .2 7 E
FOLFRE 4 DEFHLREANTE-HDEMEET LA T avEEALTEMT
EFET.REBTEHA T avF BEA T avIcHLGEMSAITZ2TH
(Tablature) JIOR—JIZHYET,

COR—=DDEIaVFIBEICRY LEIFTVEET,

» FFRE (Stems): YUXLZEFRRET HBRORERANT. HhROHRYTEICELGYE
9, fz&Z 1L Hal Leonard OHIRMI T X LERRT HLDIE. ERXMICHEL
ERETEH, AR Guitar World TlE, EAMIZHEE TRETY FEHHS
2 DHEETHEEIF. FEDAMEFEIZHRLET), £/-. Hal Leonard D H iRk
MOFET. BE—FLOZRETLMEVAW O, EERTED LFIETIC
LHRFRSNFEE A, LHL. Guitar World DHFRITERORBETHY, —BTF
DZEDEFOERMCTLFEYET  CNoDORERAIZIZOA T3V EFE-T
EHEICHERTEEY,

» & (Rhythm Dots): BEFIZZ(T5 L. Hal Leonard DRI TIEATEEIZ) X
LERTTHEE MRAITEEZRONMI. FEORAIDIKICEESNETH
(TRERDHMAI (Outside staff)1%:EIR). Guitar World TILEH . ERFDHERER
FRIZH RIFEERONAIICEEESNET (TR (Next to notes)1Z:ER),

= FHAHR (Enclosures): Guitar World (. 2 A ERFULORESOEFELUVNED
RYICHEAROBEABREERTHELEERSEELE ThiZLY 4 R EFE 2
NEFLRBTEDLSITHEYELTz, Guitar World TIZIEMR DBEAREHIMERS
nEIH (M (Ellipse)1%:EIR). Dorico TIFRAR—ZAMEALYLINELDE
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ARtERTEET (AADEAH (Rounded rectangle) 1Z:&1R), thd H iRk
TIRIDISHETEMERBILEWNZENZ V=0, TIAHILNTIIBE AR IE
RAEhZEEA (7L (None)1ZE4R),

» B4 (Ties): Guitar World TO2A [XBEEHREDHIEEL TRRSNFET A, Hal
Leonard DHRMTOR2A (T BEEROBPMELTRIFIINET, 21D
(Tie appearance)IDA T3V EH/ETDHLT. ELLDNBREFEATEET,
T BTREIZAAFDEDERTTEINEID . RIDT 2 LUERA TOEMN
NEBREFITRIZESIRTIIMIDVTIISEIEFLREHAHYET A,
(84 TOEANI-2THDOEFSRF (Tied notes in tablature) IOF T aviZlx, Z
NIZBEMICHET 5y RBEINTOET,

BTEDEMTEITKETERIHYE R AL, EMEFEHFINELYET, —F
NEIDZENSFEDHAIDIRETD T I4ILEDIRRERICINFEY EHHUH T 5HE
HOFEORIF. ERDOFROREDA T av (TR WNET, F-FZL. ChiT—F&
NEADEEMN S —BERBIDEHRETDEBENFAR—AKEITESLENGEIZR
VET EHIROBNNEBEADE. FETEHBROASERRDFDZEIZHE
WERSNFET, CHICKYEBNDERIE, TNLYTL—2av ORVERIZES
EIVBWMIEICRTEINSEEDIT, DN SEMIT T RTKEICERESNE
ER

TYR/—b: KCED2B . Sa—FESNEBOHEOONI-F L, F2)AMI&H>TEFE
SELFVAMNHYET A, Dorico TIXZDBEEFEIEFEDO TT YR/ —FEFEE
NEF, TYR/—ME. BRDERTIE X BHEEEFEAL, #TETIEIXIZEAL
TRIRSNET, TANTAIARILDOTEFERF (Notes and Rests) DT IL—T
[ZHLGEBMEN I TYR/—k (Dead note) IDTO/IRTAZAUIZT L. BEHET
Yk /—hELTHRIRTEET,

N—EZYR: Dorico Tl FLYFEROENLUNDERICDONTH, FEDECEE
PEFERIZHR—FEINDESITHYELT, ML 46 R—PDIN—FE=IUX 125
BBLTIZELY,

RITEDTONT 1. BLOTATLIE BEDOEROERICKRRTHEESLEFTIEIC
RNTDEELET. TANTAZERIRETEE T MELPEREDTA/NTAIELIRIX
ITARTEHELEY,

ATHOBFONE: 3TEOBRFO I RIS OV A XEERTBHICIL,
%% (Engrave)] » x> FRBA )L (Font Styles)IZHh AT RO BFRIAY
b (Tablature Numbers Font)I1Z#m&ELET . MHAKTE TIL. BFI 8pt D Lato
Regular 74> h&ERALET, Lato 74+ kT 731)— (SIL Open Font License
(OFL) M5t RERFTLVET) [F. —=AS Dorico LRI/ Rb—ILEND
FIITIYFELT =,
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—EDEIRIMIEFTEDILYNBEEDEREBYDSNT IELEFAFETH. 5ZDK
ERAZTDFEFESTRIBIHILLTFOCHBRAEHYET  HARETIE. TLYE
BSEEBERNBYDARINFET . CNEEETDICIE. BEA T avnl4T8
(Tablature) IO R—CDIIJLYFEBERADOEREZEYDSRT (Erase
background around fret numbers)1&42I1ZLE 3,

THEDOEE: MERETIE. FRITHETHRE 1 1/2 AR—XOHRECERES
hi?’b\ BDAR—D VT EEBTHERIL. FEF T a0 Dl#ER (Staves)l
DR—UTIRTEOERBEDOHERDFEE (Scale factor between staff lines in
tablature) 1Z&fHELEY,

RTEDEBEEARDAR—T: LAT I TV DIEEARADAR—S T
(Vertical Spacing)IOR—DIFHDHERNSHTHET (Notation staff to
tablature) I TIE,. BEFDEREZDTICHMET H2THED T IAILDIEEREIE
ETEET,

ATHDOBHELS: —BOHEMILTIE, FTREEF2TEORIDIEER OB AIE
[COHRRTDEDNFENET . CNEBRTHICIE, BEF T a0 DI FEHBE
B (Clefs)IOR—IIZH LGEBMESN-I4TEREERTT BB (Show tab clef
onN) DA T a EIBREDMERDH (First System Only) JIZERELE T,

FHA—RURETYRUF

ILFFI—DEETRLFHWEERREELLTIE RUREENICEEST 5T
RURGENHYFET , FAVRME ZEBEDOREMNSIFLLIT. EDERYEZH
TEYFELEIFAIETRURETHEVET . AVRDLEHOLMNI LR T D4
DU, BEREEOTIROLI-FFRETMITFLILTHEONES , —ADTIRUFK
(T, BREHENIZEHFTHEEDTY  RURICHIG T HEE TIE))—RET
BOWET, CNIFZERKDLAEICRRICETINTT,

n )
Fes———— ~
57— |' = - g
) =
full full Y
oo !
T 7 7 ~
Jiy 2 2 2—0—2—0
B
J

RNUR TIRUEBE LV —R(E, EHROERTRIINTRCBKATRESNET,
AT—ERBRDEETHRIBMNELKR THEDFEZRZELET A, LMY DEKET
[T IR ERSNES, :ELATETE. ChoORERFELGY . RDEE
ELYERNGYT 57490 TRELET . LAEOHBOKRENIEANUFERDL. T
AZEDQBDORENEVI—RERDLET . TIRVREHMEICE>ITCOEREDE
ENzEALTRRSNET,
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RNURERLIEU)—REER: RUREV)—RIEREIZ2 DDBEREREELET . AU
BLU)—R(E RODCHBELRTEORMAZEIRT 0. HIBRBEDAHEE
RLTERTEES . B BEDAEERLIZGZE. TOERICELESBOMET S
BERNHLIEEDH. Dorico NEEIMICKRTEZRELET , RURIL, EBEE—F
DEMBF/NARILDIT)YyH UK (Glissandi) D EIavICH I ITNEDREIV %
)99 T BHEERTEET , £=(X. [Shift]+[0] DRy TAH—/\—IZTbendjEA S
LTHEBRLEZBFENOARURFERIE))—REERTEE T, Dorico [LFHIAE &#&
TEDBEECEDZTERTHILDEEEMICRET 50, V) —RZEEKT S
F=OIZELGLHBREIDEHYFEE A,

BROERTIE. FRELR T EORICINBEIMERSNET , FTETIE. RUKF
DETHIXERTRIEY, LAEOHMBORENDOLIZ, FEEZRTHAHFLET 1R
Tv7 (&F) 2RI TulllARREINET, V) —R T TRAZOBIRDO KN TREN,
BTEDILYRESICANMNNET,

J—70—NTERDORUFEERT H5HE . REXED+—HR—Fa—thy
k (Key Commands)IDR—CDIFEFD AN (Note Input)JDATI—IZFHLL
EBMEh=-IFE2—RURZEM (Create Guitar Bend) J®aYURIZF—R—Ki 3
—rHYREEIY B TEOLSEMTT,

R—ILRFBRUR: A TOHEIN-BEROTAL—aV DERNVREREFT D0
ENHIEE. REFEHMLTIIELRNIEFEZ S0, AT HITR—ILEDK
FRERTTDHEENHYET, CRERTIT BT TANRTAIARIILDOIFEI—A
>R (Guitar Bends) 1045 JL—7 TlIR—ILR %R (Show hold) 1D TR/ 8T4%7F
VNIZLET . FEA T30 DIFA—ARUR (Guitar Bends)|DR—U TlE, /h—IL
FEEBRFELITBROLEELTHET HMNBIRTEET,

RURDAE: BEFDERTIH. FEMN 1 DETDHEE . AVR V)—=RELVT)
RURTEHNICFEAICRESNET A FERIEROBEIEBEMICFER
[CREESINFET AVEPYY—RIFVTNEBRLT [F] ZA DT 50, THRE%E
(Edit)) » TZYvT (Flip) ZBIRTHETRETEET , TUAUKRIX [F] TRERIE
TEFEAD. [RUT 12T DAM (Guitar pre-bend direction) IO T O/ T1%F
UISTBHE BBIRESN-ARAZ LEESTEET,

TYRUEDER: TUNURIE, TANTANRRIVIZHFLGEMESNIZIRO T4
(Guitar Pre-bends) IO Y IL—TTIRYF42 45 O E. (Guitar pre-bend
interval) I TA/NTA4ZFVICLT, ZETURURTHERREIRET HETER
TEFET, TIRVFDOEREZRETHL. BROERICITFIMTZOMBIBERFIIA
RV DODRRTRINET  FTEICIETUAURD EHFTHHAXDILY
FEBICEEOXRHAFLV TR RSN, ZTOLICIETIRUEOFREETRT H
}FEIE 1 RTYT (28) 2RI TUIIDNRTEINET, AISHDEHTIYRUR
[CRRSNDEHRESZFERTICTILENHDIEHEEIE. [RUT12Y (Guitar
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Pre-bends)1D% IL—F DIEEREEER (Accidental) DT O/ F4Z74 (2L, TFER
X (Hide)JIZERELET

HETF BFEEFCEBEFOERLITEDOTAT. TRTORUL, Y=
BLUTIRUROBRERETEET . EROERTE. AVRFOTFLED 3 2D
NURLDENDLED)YILTRESYT § 50\ [Alt] ZHLENSRENF—FFEAL
TEEDRAVIDUBELMAR TEE T, £ [Tab] ZHLT. 3 DD/N\URILEIE
[COYBZONET,

RTHEETEH RUFRIZIE 3 DONURILDARIRISINET  KEIDOMIKIC 1 DF D&,
BEORRERET S 3 DHOAVMO—ILRAVITYT . BHDERERHE, <
RAEIE [AlY] #RLEASRNF—ZFERALTEEDORSAUIERHETE, [Tab] ¥
—HHLTRAUNEIEBICYIVEBZONET,

RATEDARUEDETE: 1 AT7v7 (88) NURTMHUllOMDHYIZTL 2R TS 55
B FEFEFERTYT (FHE) RURIZMLTIEALKI121ERTTDEE (X, FELT
2AvITHLGEMEN I FE—RUR (Guitar Bends)IDR—S DBET 34T
IVEEBELEY,

) —ZDHNER: FTEIC))—RABTHREDEREEDKIICRERTHMNIIDNT
(X, TL—V—HDERICEFEZEDTTEBRNIEN S, SEIFHEHARERAH
HYFET, —EHOERMTIIILIYINESZBEEBYRTL. —BIETILYNESZEEE
M ETRRL MICIETILIMNESZEDLDEERTRICTIEEILHYET . BE
AT arDIFE—AUE (Guitar Bends) |IDR—IZH BT TH A (Design) 1D
O3 T W=D I7LYLBEE DS (Fret number appearance for
release) IZEFEDNERIZRELET

RUREYXLIZEDAR—L Y Dorico 1§, BRDEREFTHEDOMAICE LT,
BEMICRUFDIODAR—REERLET FREFTTao DI FE4—AUF
(Guitar Bends) IDR—ZIZE. ENENDRTAEICEFTEIRUVFDORPMREIC
I HEMNDA T avhHYES, FTEDHDLAT IR TIE, AKIRIT > TIHEh
BOKENFLELYOORNIEAHBYET, COFZEE, FEET—FTHBREDOXMN
DIRERAETEIN BEHROAR—IUTY—LEFERALT. FHTEFOAR—Y
JERELTEET,

RATHETRURE) X LEHAEHES: ATHEICYRXLERTLENOAU R R
THES. BEATIDIETHE (Tablature) IDR—CTIHEBDTI74/LEDA
& (Default stem direction)1ZIF (Down)JIZEEFTEHEEETIHLET . 25
FTHILETHEOEHERV RN BARLEMAAIIZRTINET,

ANURDOEA: Dorico DI/NA—DavITFRUR Y)—RAEBELUVTIRUFDEEE
EEEIEHYFEBAN. JFEDNA—2a0 TOREERATTY,
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XA—a—KFAT7TS5L

A—RFAT TS LIF  BEDI—FDORAL T EAV NN THERMGEHETES
JAMIABEZBNET, Dorico Tlk, Aa—FEAF7H S LIEI—FEED—EHTHY.
EQTL—V—I2BVWTHO—FREEDTICKRRTE,. TRTDILYLERDF 2
—ZUJEDEET R TEET,

Am Dm G C F Bb Eb Ab
frreee . 5 ft e 5 fratir. 3 . 3 fyir. 6 g ire 4
, BT @ ®e R W e @
| 1 1 1

oJ

6 %X A— (IB#.FOyT D.A—T> G. #—7F> D.DADGAD Fa—=2%).
JLL. IR BLUNYDa—RAIZHBICE LS O—FBIRDOZ4T3)—HH
EINTHY., SESEHRA—RICHTEINSITF 2 ERAI VT EERLET,
Dorico [&. 1V ARYILAV DRI EDFEDME THEAZILYLDHEAED
HERIGSEIIETHEDEYFEBIEVSBANSTIEIEL EETIAMOF
DOFIZEBL. BBV ThE/ L —TREIZBIESZTENIE, RvVITiH-T
ETFTEREVNSBANSI—FERERTHEVIFFHLETIO—FERALTVET,
NIZEKY., ALERESESEFLI—FICBRATEES, FLZEOBRANEET S
AVRMYIIAVRDEIEDF 21— J 2BV TESALBAATEEY,

A—RFAT7 IS LEHREFIIEERT HL. Dorico [FENEHEDI—RIHRDIT
KOEEFET . I FBROADRESNE T, DFY ., TOBRN RV IITHB-TE
TICHBHTESGE. RV LOBRLGIMEBICZOMREEHAT H2LTHLNDE
vF% Dorico BNEHL. thDI—FIZHLZDORKMNFIAINELSITHYVETS,
A—RFAT7 T I LDRR: A—FFAT IS LERRT BT BREE—FICUYE
AT TL—N—/I RV TaA—FFAT IS LERTTHDIL—V—IIH BT 5h—F
69y ILET, [a—FF L4745, (Chord Diagrams)IDH T A=a—I[Z(&, 7
LybEBRTHRATEDIREDF1—=V T DYAMIKRREINET , [RAVF—R¥
#—Fa1—=>% (Standard guitar tuning) 1% & FRTEIF1—= o ERRLE
ED
COTL—Y—CHHEDI—RESEIRTCI—FESDOTICTI—RFA(TI I L%
RTTDESICEHFIN, UBERT 20— FREICa— 4475 SLMNEMSh
F9 ., #HARE TIL. Dorico [FEEDIA—RIZHLTHRLEMAI—RFT (TS L
FZERLFET, CNIFRHABEZESAREZL T4 AT DEENFYMIRBIALD
—FRESEEKRLET .
BRBEIA—RFTATISLNSATS)—IZROMSHEMERIXZEDI—REATHS
LARREND-O. BULGHREIEE ST ILENHYET . FEE—FTI—KF
AT TS LETTIVI)IILTCITA3—2MEET , TT43—(CDLTITLAE TR
BLET,
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REOWIK: SATSV—IZIE, FEAEDI—REEITH L TEERREA IR, E
BELELET . O—FF AT IS LEEIRLT [Shift]+[AIt]+[Q] T &, RAEDD
—FRES THEATEABREIARTRERIT DI VTINGHTATOATBEEES . K
F—FEIVRTHEATEIRBOMKEEIRL. [Return] F—%# 9 H . TOKIZE
D)o ERTEIRKETTILIIVILTEAATRITEHELET , O—FF
AT TS LEZRUIKEET [AI]+HQ] ZAANTHILTH, FHARELTRTOR
BORKERITHNTEEVVEZONET,
BIRUEBERKE EEOTLUYMEBRAF1—=—U 7 EERLTWSTRTOTL—
Y—IZEWT, BALHEBIZHDITRTHDIA—REETDA U RAV R ITERINET,
A—REAT7 TS LDHRE: FLETIMRENSAITS)—ICHESATUOERMES (.
FET—RICYYBA T, O—RESDI—FFAT7ISLDEREZERL. FTILY
oD &ET=IE [Return] ¥—%# 4L THREDOBIREERTEE T, U TOI T4
— M EEET,

+r. —fr.

Import Diagram... Export Diagram...

FRIERZE 1 DRTY DM, FREE (FAT7T 5L LA O ZRR) FEFES (¥
AT TS LDLEERIZ X &RR) TRESNET, ZDiHELY EE2VVYILTERE LR
BEREDYBZ DD FAT IS LLDTLYNED )Y )L TEIICRERELET,

BHOZERILILYMIBE THEIZSEE. TOILYMIEIZHINWT O DRE
DT BHE FNLDEDBIC/NL—FRIRTEET . /\L—FHTICITHFEYY
wILET,

HEZ B LUVBEBBROEYFIIZTATISLD LIZRTENFET  FA4TT 54
[CRAE o -a0—REEICHEALEVLEYFIE, BELLTHRERTINET,
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BAT TS LDORBILIYNEERSTHHEIE. TTAF—TE8DT Y230 /N—T
[BARTLwh (Starting fret) IOEEZEELET . F4T7I S LIZTLYLE 1 DB
TBICIE. 7ooavnN—DT+Hr &0 )y ILET, REkIZTTILYEE 1 DiEinTIZI,
T avnN—nlfr1&9)voLET,

[A—FARRYIICB>THEETHLEHA (Chord may be moved along the
neck)IDFTvIRYIRIE, COA—FRBBEHTESD ., RV LDIBEINLE
TLAERTELGLNZE Dorico [THRLET . a—FZERV V(SR> TLAICEHS
B LEHMERE /L —TEETELDOTHNIE, a—REVThILBENAEETT,
LAL Dorico CnZEBEIMICHIE TS LEHYFER A REMERAKICEY L
BAHEIINT. COF VIRV IREAI—HF—BENEET ILENHYET,

[MRTF (Save)lzV)vy§ 5L A—FBRKNRIATIZRESA. COI—RFA4TY
SLIZERASNDLSIZHYES, Dorico [FA—RE (75 SLEHFENDI—REEEIC
B EHICBEEM T DD TIEGKTRET 570 EREOHAHMDI—FIZH,
CORRPIRBOZEIRRELTRIREINDIIITHYFET,

JL—LE: Dorico [2IEa—FHRIKRDIL—FFICBEATRRERTEDA T arh KD
MAESNTVWET 2EX X R—RTL—N—,F7oH T ILTHX2)XAAD
HEEERLTVDGEE . A—RTL—Y—EET I — RN LRI
JHEERLEZWEENHYET . COHDFTavid, ERAAFT T avIicHL
GEmMEnf=-Ta—K& 4745 5., (Chord Diagrams) | DR—J(ZHYFET, IL—+%F
T2ITRNTEINEID . BRALLGVGEEZI—FOREEICTTEINEINEIEBET
EFET,

BVWEEDOFILEL—1arDHDHa—K: 9 ELUEDAIILAL— 3 EFERT S0

—FERETHIEE. I FOBRBDSLENEERT INBIRTIVLELAHYFE

T /—bATA T avIz#FHLGEBMEN=Ia—FFA 14745 5L (Chord Diagrams)]

DR—IZ[E Dorico MRFEIZEEESZ DA T avhHYET,

» FEF2k 7th LEDA ILEL—2 3> (Dominant sevenths or higher
alterations): 5 EZHIKT HAMNEINEERLET,

= 11th &Y 13th M3I—F (11 and 13 chords): 9 EZ &I T ENESIHNEERL
E3 8
A—REAT IS L5473 —: HFILLO—FBRESHRERTIHEE. &AL
Dotico DT IHILEZA TS —IZEENTWNEWA D AR LAV IOF2—Z2 5
AOMREEETHLIGEEIL. IHE (Engrave)] » Ta—F&A4T75 5L
(Chord Diagrams)1Z:&RLET . F47AT D—FLDOERLI=Fa—=5
(Chosen tuning) IDRAYTH OV A1 =MW RELDIFa1—U T %8RG B,
ZOF1—=UF AICERSINEBROVRMEFHIN, [Fa—=2TI2ERTS
3—F (Chords for tuning) IORAYTH VIR RINET , EELIzO—FRIK
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IZT&RT (Name)JImERIVPO— L TREZAPTVRFIZF (T THL, LD AE

THRERELET . TTLELIRE (Save) &9y ILET . TnhoFHLLVA

BZAALTCELITHRDI— T AT IS LEEERTHH. LS (Close)l1z4')

YILTIA—RERDIATI)—DmELEHERTLET,

FEATVay: BEATVavICHLGEMSNIZT2—FX (7 5L (Chord

Diagrams)IDR—U TlE ROARS O RDEENLEKPTILIYMDAR—V VT ET,
A—FEAT7 IS LDHEICEAT 52H0WLEREZHETEET . BTKRIEEL

AT avEMra—RRRSIcx9 5% (Scale factor relative to chord symbol)JT

Yo CNICKYTRTOA—FRFTAT IS LD YA REEHRICEETEEY,

A—RFAT TS LDBERIZRRTEINEILIYNEBTD T+ b RFZMILELUVHAX
=ZEESBHIZIE. [FF (Engrave)] » I+ FRA2A L (Font Styles)lIZ&HdHIa—
RELT TS LDILYRES DIk (Chord Diagram Fret Number Font) 1%
£LFET,

XE—DI214H) T

D59 XFI—DEEL. EELORMNERTHL-H. AFEEFHAD I«
DHIDT DFERDNEUVZLLEBEIN TSI ERKLHYET , Dorico 3 [ZMF D
T4A) T EAENICYR— . SELGEHREMKEIZLY. SREDHIRY
LRIFEDFERNBONET,

TV HIT DRYTFH—18N— FE—D T4 H )2 1% [Shift]+[F] DRy TA—
N—ZFRALTEMLEY . RyTA—N—IZ@FTLIFEEFIRINR TSN, EFF
RIEBEFOTHVTEAARTHIIEMNTREINET, [LINSIRICTIYEZ
BITF ] 2. TRINSTLIZHIYEZAICIE [ T] Z3LET,
BE.ABFOITVAIVTITIEARAVEDIEDLRNICHIS T AXFAERAINE
9, MpllE pulgar (#i18). li1lE indicio (AZLE). Im1IE medio (F15). Nallx
anular (E$8) #ERLET, /MBS ST HXFIZTDONTIXIXSDEA 2L, Dorico
TlElel Tel. Ixl. TolOWFhHERATEET,

— A EFOERIFEMICHFEERL. AZLIBICIEIL /MEICIET41Z2ERAL
FI BEEFORBEIERALELEA), S0 ABRKEELDEETILI7AVE
DIOITIRHLELLEFDI0] (£0) ZEALT. EFDOEIRLRILE TRRINET,

BHOERERIRLTVSEE . VI TRUNIEERD I AH) VT ERYTH
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—/N\—IZANTEFET, F2EAIL 3 BOMBEERLT, [Shift]+[F] ZABL=HE
IZ[1] ZADLTEFOERICUYEZ, RIMp,imIZANLET . CNTRES
([ZTpl. pEICTi) ZREEIIMIBEESNET,

TAVHIT DR TAH—IN—DFENHDEMIZDOVNTIE, DA RL—2307
ZaT7IIVESRLTIZEL,

BEFOIT«HITONE: BIELAEFORBICEDOXFEFERTIHDA T3
VL. HEEFT D740 H)2T (Fingering) IOR—TZH BT THSLY
(Design) 1D 923> DIBEFTOFEBLT«42H YUY (Right-hand Plucked
Fingering) QY I AyF—IZHYET , HIEETplEIEMtl. /MEDIFEE T DAL
& 6 DOERMK (Ted. gl Tel Ts1Tol, Tx]) MoRIRTEFT

PR ETIE. TRTOEFDI«2H) T DHNERIZIXGHRILERF RHALE F
SNFETH. 2428V DN (Fingering appearance) &l FL—224 2k
(Plain font)JIZERET BE. FI—DEFDI(AHIVTEELTRTDI(2HY
DT 1ZI%, T8 (Engrave)] » [T+ FRAAJL (Font Style)IDT 242 H )2 A
TXARIA2k (Fingering Text Font) JIZSRESN =T+ bMEREINFET,

BFDOI40H)T DEE: MERETIE. BFDOT4A) T IELERDONEID
FEAICRESNFETH. —BOMTE. EFOREOT(OA)V T FEROT
[CRESNDENHYFET . ChoDWHAREEEET DHICE, FEA T avm
[24274)2%5 (Fingering) IOR—U DIBLE (Position) D93> T . IAFT
DEELITLVHI T DT IHIIVMILE (Default position of right-hand plucked
fingerings)IB L WTEFOBRIBETOF/T42H T DT I4IVMMIE (Default
position of right-hand thumb plucked fingerings) 1Z&8&EL%E Y,
TFIWROFARBEDI«VAI T TILROFARBEEFERAL T FEETRT 515
B.ITRTCOFKIHLEFOLEDIEEFERALTER T AMNMERTEES . CDIHFET
AVAII T TIWARCAREDTEICRTREINET  TILRDARED T4
DTEBMYBICIE. TILRCAREEZRLT, TANRT/ARILOTMTIELEL
(Plucked Fingering)10D4 JL—7 Tl g (Fingen) 1O 7 ANT1%F A UICLET,

BEA T arDII40HY24 (Fingering) IOR—C DIBIE (Position) I D+%
2avITUE, T4V AT ERERRORAICERET S0 RH RO IMAIICERET
BEMERETEBITIRCARBED I« HI) VT DEBRELIE (Vertical position
for arpeggio sign fingering)1E . ZPILRSFRED T4 AT OEBREICEAT
B4 Tar Lo BYET,

FLIETHERDEZZIILS I—FRADEBDEZRILE (2LDBHEIFHE) TE
ETHDE. BLLWIETEBYFERA, CNIEEBINEIBTHIELLNIEENDT
FTIMIK>TREN, T VD TFTEEIFBIZIE T T T HRREINET,
COREEETITBHICE. - FRNORLIETERTIENETITATERL.
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[Shift]+[F] ORYTFH—/I—%FRAWNT [|] TEFOERICUYEZ. LA
(p.pplEAALET . MR ETIE T4 AU FA—FO LEFEFITRRS
NETH, TORTARILDOTMTIEEL (Plucked Fingering) 105 L—7 Tl &
BEAIE (Vertical position)1DTO/T1Z=AUIZL. TERF O (Next to note)]
%8R9 5L, Dorico (TS vhEBIMLT, SNIZTA2H YT % 1 DIEITRTR
LET,

EFDI40HIUY BE.EFDI«HITIEERORAIT, BETHIEFHD
ERICRESNE T, T4V AIV VT SBRRRE O REEMDT AT LEDER®
FisZELTIEELREN =, CNIFEBITERGLEIZRYES . HopdHY T
FDHT Dorico FEFDIT4VHI T ERET S-HDHRLERSNI=TILTY
ALEFLET . RED-ODBREMLEA TV EETHLOD 3EAAMBEICG
LT . EEE—FTRLDI(VHIVT DIUEBEWRABRTEET,

EFDI742A) T DN DIEIERETIE. EFDIT4 AT IEF—KR—FD T
AVH) T ERICIEHNEBARTEFRALET N, FEA T a0 240H) T
(Fingering) IO R—J(ZH BT TH ALY (Design) 1D toar T4 HIVT D
5188 (Fingering appearance)1Z&l FL—224 >k (Plain font)JICERET HET,
FEEDOIAIEFERATEET . EFDTVAYLTIE ERORBAITEROMHEIC
KRNI DEE. EROLFLETICRRT DIV /NEKGYET  FIHAREDEEL
85% ICERESNTHY. DA TLavEEFEEF T aoDla40HIVT
(Fingering) IO R—SI2H BT TH ALY (Design) 1D a3 DIEMEE
(Advanced Option) JDH T2 avIZHYET,

HRENTLBIFELEAEDFEI—EFEICKL T, Dorico TIXEROABITERDE
[CRRINDEFOI«AIVT OEBIDERBEHELTRZ OIS EHEMH
BELLTVET RGN ENITFELL ChEEMICLIZWMES, BEA T3
2DII40H)Y (Fingering) IO R—TIZH BT TH ALY (Design)lDto 3>
DI E#ERE (Advanced Options)IDH T I avIZEFNLIEERORBD T«
DHILT DEREEY DAY (Erase background behind fingerings inside
the staff)1Z4 7129 5ZEMNTEFET,

EFOI40HV T DERE: FEA T arDI240H)0% (Fingering) | R—
COIBIE (Position) DI avIZiE, ERORBAIZRREINDIEFDIT42H)
DU DKESLVEEMBEZEHHICHIEHTEST T ar O HYET,

BEDEFOI«AIVTDTIHIMIBEERTBICIE, TANTA/ARILD
242524 (Fingering) 1M IL—F Tl IEHIBDARS L3> (Stopping finger
position) INTA/NTAETIT47(2L, LT D 3 DDA T av DL hhEER
LET . WHRTETIIIEFDOEMA (Left of note) INBIRENFT . [BHOEA
(Right of note)1[&74> ANV = HBEOARIZHEESEET, [HERDOH A

(Outside staff)1[ZT71o )T #HERONBIOFERIZ. FFEFRNTIT
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1T IGEIFEOA RIS T HEIBESEET,

T4HIVTRZAR: AV ARSIV AVED R Y IIZR>THE L TFICRSAREESHT
ET.RILEDRICIE TERLE-BEHRERERITDLETT . 2 ADEHEEZDLECH
BOBINNET, ZHDEFFLIMTRN TSGR ASIFEDERDOEARIC
BOEMNEIANET,

BRI, TANRTANRILDTFEF LKA (Notes and Rests) DT IIL—T12H 5%
(String) INTANRTAMFUIZH-OTWSIEE ASARTTERSAIR DT ADF
FICEICBEAFRESNTNDILEMRLET , RIS, AIRICTO/NRTA/IRILDIT
A2HY2Y (Fingering) 1D T IW—T DI 242 H) o F= &R 3> (Finger or
positions(s))INTA/NTAH ASARTLERSAR DT ADEFTRILCIZHES
NTNBIEEHRLET,

NLDRMREHEBLTONIE RZAFEDEFZERL. TO/NRTANARILD
(242824 (Fingering) IDY IL—TF TIRSALKAY (Slide in) IO TA/T4%H4
VIZLFET 2 DOERNTRITSEWNGES . Z140A) 0T ORICRHRNEIANET
T4VHITBREBEET . T AV T RZAED T4 AT OB FMER
DHEFET, COLEFHE, BRRES. thO I HI VI HEDEEMIESLEIC
HHHEEE. ChoZzBEELET,

G4VANVTASAROEBEREHRRICHER TELVGE X FEE—FTRSAF
DB BEFEIIRTRBED I HIVTEFT YD LTH TSN, f#RIZBE
I T4 AH) T EBRLET . BEICRL T, RSIRORBREAEROVT A D
ZEIRLT. Y OREFERATH0. [Alt] ZHRLEGASKENF—EFERAT 5N LTRER
ERETHLETEET . VAV T RSARDMBEZ ) EYbT BICIE. BFEE
—RTTO/8TFAIRILDT 42524 (Fingering) IDT IL—FZH BT RS5/4KBH
IREIE (Slide start) 1B FUVTRSAFRTHLE (Slide end) 1D TO/T1EFTIZL
79,

2 DDEHRDIEEMN, BEATLav D744 4 (Fingering) IDR—2 D
24258 XS5AF (Fingering Slides)1Dt9av(tH B T4 HIT RS
AR THREITHEFBORKIER (Maximum distance between notes to join
with afingering slide)JIZEELIZEKYRELGE . T42H) T RS/ RIEEE
DREOMREELTRIAFEDTAVAIV T DI CEICKRTEINET . BEE—F
DTANTAINFILDII420H) 25 (Fingering) IDT IL—TIZRTRENDBI RS54
Fa47 (Slide type)IDTO/NRTAZERTHE BELDI«VHIITRS54(K%E L
EETEFET S Qoin)IISERETHE RTARTERTAREDE FFHE D EER
[ZRARE<. MERMICRHEL S IDNET . [RSAF5EDH (Destination only) 11Z5%
ETHEARTIREDEFOEAICEAEDRIORBENRTRINET,

BAN—2ar TSN TR ok BN—230 THERLEETRS 2 OD 407
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Do DNBEEBLGWOIC, FI—EFFETAIVTEECHEEDT
A I HrTIK ERORBIZEFOI«HITERRLTHEICEFOI4H
)T RIS DIEEEIIMEARETEAVIHBYERA EFDIT«HITH
EROMIILARTEINT . BEFDT10A) T EF1KERTELWEE (T,
BEA TSI DII740HYDY (Fingering) IOR—J 2L, [THAY
(Design) 1D L av OIFHMBREIN Y T Iav TTEFOIT1HILTEIL
yhEBOEROWEITEA (Allow left-hand fingerings inside the staff for
fretted instruments)1Z4ICLET, ChIZkY., TADIHIMIEEFNEZFI—
ZTOMDILYNEBOBREFDIT(H) T DEENEFINDIEITEEL TS
AW

FA—DEDIERES

EFDIT10HI T EERDODRBIDAR—XTHET HDIFEDIERILETY .
NFEEAEAHTEETLIERDELLNDAIZRTRSINET A, FICFERD
NMUICHLRRSN . BILRTERIHAEMNERTI DO DWIRICIIERKEH
SHEFLHYEYS,

RO LT OROIETRES L. [Shift]+[P] ORYTFH—/—IZ, f=&Z (L stringl]
Prlstring31REEANLTHERTEE T,

BEROEAIERIZRREINDUDIEREE L. TONRTANRILOSFIZTE
FY . RDERIEFTERTI DEFZTERLKET, HILGEMESN-TEEDIETR
#085 (String Indicators) 1D T IL—F(2H BT RER (Show) D TO/NTA4EA (T
BE HDIEBTRREENRTINET, [BEHEAKFF (Notes and Rests)IDT )L—7T
[ZH B8 (String) IO T A/NTA4TI TICBHBELRENRESNTLDIGEIX. ZD
ENZBESLELTRRINET . RESNTULEWNGE X EHEN KBS N K
RENFET, RGLRBEEZRRIEDHGEEIL. [TK (String) IOTA/NTAZEA VI
LTERATSIRESEHRELET,

FKE%: FIEIERE T, F’a-ﬁﬁﬂil‘Ii%lﬁ@%ﬁ%%@b‘b‘)l‘K?O)t“Diﬁi'T‘é
NET, CNEEBETDHICIE. FEF T avICHLGEMSN KD IERE
(String Indicators) IO R— TIRAMEE D 54 8] (Open string appearance)Jé‘—FEK
D ¥gREES (String indicator) JIERELET .

KEME: MHARECE. EFOT40AIV T HFELGVNEESHDIERESEE
FOERICRESNETA. T4VAVVITBESHEETIEEIL. KOERLS
DRREIEFOERICYNEDYET . CONEEHES 4 Tav EEEF T
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3> DIZDFEREES (String Indicators) IO R—C DIGIE (Position) 1Dt 3
NZHYET . RIALTEIERTEYFALZY T EHDIEREEDMEIZET 54
ToavmESICAEINTLET,

N—=TORFYYH

WROAVHY—bN—TLEE 6 FV4—TFDOBFEEHL. \—TETENEED

F—TEEZBERTELLIIC ROEVFEFRTYT (8) TLEIFFIFTELH

W7 I2avxBLTVWET BT 723V ERTIILTERESh . ZhThoR

FIVEEBZDEFVI—TICh->THEDEYFITRICET 5T RTDKITH

BE52FF . —TOERIZIX 3 DOREIL (D.C.B) B’dHY. HEIZIE 4 2D

REIJL (E.F.G.A) BHYET, ERFILIZIE 3 DR avhpyUET ., FRD

RO aVTIFRIEFTFaTIL. DFEYERLLOEYFIZHRYET, EORDLaVT

F735vbk (FIF) DEYFIZHY, TORD LAV TIEDY—T (LIF) DEYFIZRY

EZ 8

REVWIFIN—TEEZ LT THMERRICE S TEREL R ATMEEERYET, /N —

TTRERFIWDOROLAVEEBLGVRYBFEDENERTELNILLERT D

DHFARTHIEEDIZ. N—TEEHICEITRARELGRTIINEFEZERLEGKS

FETIBLENHYET , Dorico [TIF. N—TDEEEIZILD—EDHEEL MED S

TWET, FERIFN—TRINWBEEOYR—, ZBHD\vtE—CFERTD

EOITBBELGRE KRS AVEHET Y=L BRUVBREDRA LRI L3V T

BETELRVEREFR TR T ARELELHYET . N—TDREDRERAZ L

ERRTHO>TH. COELVWVEBDOEBOEERECERZTESINDMHERIZEL

T.INLDY—)LEZRITONDTLLS,

IN—TRENWEAT IS LEER: N—TRENFATTSLIE. FETRA KD

AVERERF RS IV BT B/ — B ERELTH Y—ILEFERLTE

REICEDERFIARD L IVEHETHIETHERTEET,

N—TRENEAT T Z LEFETERT BHIZIE, [Shift]+[P] L TR RTINS

BRBUEORY T —N—ZHRALET . RF RIS IVIELUTO 2 205600 F

NHODHETEETEET,

» REWRDLAVERA: LORF LIRS LAY (IF9h) [2ETME FRORT )L
ROay (FFa3N) ISET- &, TORF LRI Ay (Or—T) ITIETvIZEE
ALET  N—TOEREERIDRTIILDOREICIENATXEN1ZEATEIELT
EFFET ROV 7 DORF VT RTCITHEET IDLENHYET , & 1HT--
AN-AJEANTBE B E.A MNISUMIEST= Eb ASYy—DIN—TREILEAT
T LMERSNET

» EVFEEBREE /—MEINTNKRXFOTLI7RINAINGIGITEEAL.
UMbl Sy —TIZEMH#IZERLET . TRTOEVTFERET 5. ¥
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v—TFERETIVMDEYFDAEIRET NG ERTEET, ABRLIEYFIC
LTI EEON—TREILBRENHIIGEZTINOERBINLZLD TIEAEL,
BIZTFFaTILEBREINDIEITTELTZEL, > T, [CDEbFGAbBb1&
ABLTH, BIZTEDADBDIEAALTH, LERDBIERMEN—TRENFAT TS
LOMERENET,

BEIRICN—TRENFAT IS LEERTEEEE. N—TOVWThHADIERT
N=TRENEFAT TS LEERTAUBICHLIEREETOMDT AT LERE
RU. TEREE (Write)] » T/\—TF RS JLEMRHT (Calculate Harp Pedals) 1% #IRLE
T TDWUEBELUBDRENBNOMELINDIN—TREILEELFEH N, B
FIL 1 EOADEYETTTELEFTZLDOERFICHIGLESELFET . TEa—
(View) ] » TEFFEKREFDHS— (Note and Rest Colors) | » IEFES D EFEF (Notes
Out Of Range)1Zx T AUICLET , TNITKY | RISNHN—TRIILEEEEET D
DENHLMEBEE. FTCRRSNEEFCHATEES . COBATTIE. FILOF
BLHRORREGYET,

N=TRENEFATOYT DHER: MPRETIE N—TRELREDERIFTILA
A7 FRFARZLARIATLATIRTCIEHRIENE R A (DDOYIZZDREEIZACR
DRIREINFET) N—FL AT IRTIERENA AT IS LDRTEINET , DK
EEFERTBICIEX. LAT7 I T3>l Fo—v—(Players) IO R—S DI /v—
TOREYLY (Harp Pedaling)]DtEHLav(ZBEIL, [IN—TDRE) 745K
& (Show harp pedaling) &4 LT, BRLIEZLA T ONMIN—TRE)LDOEE
fERERTLET,

N—TRFIOEBERIE. ARFTILHDLEIZ, ERF LN TERICEMFETER
M(FRE) &#=3FF 47734 (TRRA)ELTRREINET,

Eb Ft Gy Ab 11 |
Dy Ch Bb

BEF T avIZHLGEMENIN—=FORA) S (Harp Pedaling) IO R—
[CIE. THRRNS AT IS LOTMA DN EEET 5O DFMEA T avhH
VET, ERMIZIE. N—TRINFATISLDEREZRDOHAX, XS KSH
FURR=L VT DAL, BEMBEKFMABED T IHINEREETHRAET,

THFAMELTRBINIZN—TREILOERERICTOVTIE, ERFTILDIEF (—
END/N—TEHIEI D CB TIEH B CD DIEFEIFAET) OTF A ERIE TH
CMEINGEEERETEFT . TFRMD TN O A RXEZEET BHICIE, [HE
(Engrave)] » TINS5 S5TRAA)L (Paragraph Styles) I TI/N\N—TFRFILEE
(Harp Pedal Settings)ID/\ST S 7R3(IVEwmELET,

DGR TIERIER N—TREILDERERICTTEFRM DN EEER
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558 BEORENCERTINEATILOAZRTTHIERALBRTEET,
N—TRFIOEEIEREFHTHEELZEE. ERZIERLGVLRS LT, BT
DRFEINVEBIRRICEDIROLaVESIEFRCOTIEGL, AR (FFaTL) DRY
AV THIEREREINET, fz12L Dorico [Z[X. EEIETRE DR T T HHEHE
DHY. MBEZETIE. 7 DORFILDSIHLEREMN 3 DUTOARFILEEIERIL,
ARG ERERERELTRITINET,

COMNPBREZLEESTRICK. BEAFTLIvDIN=TORFY2Y (Harp
Pedaling) IOR—C TR ML ELIBRERTTEIRFILOKRKE (Show
partial pedal changes for changes up to n pedals)]&x 22 5M ., [EZZE R
LET. CNIEFEFRIBRILICLLEEZTEE T, BANERFTYY (Partial
pedaling) IR TO/NT4ZF T HE EELEAZILOFICEFRLEL FIRIOAR
FINEEERIOSERIN-ERADADNRTINET , BHRIC, TESHERFT) Y
7 (Partial pedaling) &Y H& BAHLERTILDEEETTE. $TD
REDRREINZKREDORELLGERIERELTRRTEES,

MEZRETIE. BREERTIMAMERTIILEERIERE 2 TICHEISh, AR
IWDNERT LD EIZRRENETN. IATE 1 TITRTI DGR BEFTY
v DIN—TFDORFY24 (Harp Pedaling) IDR—U(ZH BT E S HERTILER
$&% (Partial pedal changes) %1 7&K (Allow on a single line) JIZEREL
FT . NICKYSRBRTIIWERIETRIE. BET 54T ar B HNEEERR
% 2 I TRRITHARFILOBDOETR /MK (Show partial pedal changes in single
line if fewer than n pedals)JIZEELI=RAIIEMETIE 1 TTRREINBESIZH
YES,

MPREDORY )L JO—FRNE TR LR EERELLIMER. 7 DORFIL
[FITRTHRRD 3y (FFaIL) ITHEIEREINE T, DFY., Iv—TF(F
IV DB RFIEVTETEHEN IO FTRRSNDEITHEYET , TD1=6H.
JO—DRBME TN—TREIBEEEEET I EESTITOLETS . ChldlaE
i (Write)] » T/N—F R JLEHT (Calculate Harp Pedals) 13 AL EI(C
TRZET,

Ty ROBEE: Dorico T, JUVH VR TEETIBEREMTTHMEICIEN
—TDREDRTIEENRBEINET . N—T DTy R THHFRY DR —
ILDSERINSKSIC, BUHBN—TRIIWOEFRRERTELTHCLERTT
HLES,

N=TRENWNDHARERTR: MHARETIE. N—TRFIILOEFRRITENRIESH
BOLATIMIEHARTRREINET . N—TREILDEEIETERTLELE
Blx.TEa— (View)] » THAF (Signposts)] » THAFZIERRIZTS (Hide
Signposts)IZERLTI R TOHAREIERTRIZT H0, ALY TAZa—RHDIN

—FRH)L (Harp Pedals) IO HDBIRFTYEZFT .
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[BANA—ParTHEREN=7a ok IB/N\—23>® Dorico TSN -7V
IRT BRIZAV ARSI AV RELTN=T N AASNTNDEDEH TRV -EE
F. 207 O REEFACCEBERCETE. \N—TRFTIILOERIRREHE
B TEEH A, Chid. Dorico 3 A TOC I HREBENTEHTAEEIZ, BED/\—
TDAVRRYILAVMIEBIMERERET 5=HTT . ChoDFERIE. TPV
FHRERETEEAINT . FRLTEEE A

BETVIL—F

BAETUTL—MIN—F VLAV R AV NEREZ DD BE T /NARITE
YP03N BEB/YIUR T—T4F¥2L—avBLUERBE. ThoDY ™
VROEBAE (VST THVRTLYavIvTICER). BEUENLDHY VRO H
MEENEZIRTENIZDOVT, TADIIMAD B AV AR LAV RDEREVLEF
EDHITL=HD T, Dorico MIB/N\—2a>Tld. 48D HALion Sonic SE &V
HALion Symphonic Orchestra MY REERT 51=8. F1=I& NotePerformer
ZERATAOOTATSLFEOBETTL— 1 DFEIE 2 DICHEAH IR
EN MDY IURSATI—ON—F XA DRIV AN EERT BITIE, FE
BEETODI UM EITRYRLITESDENHYFELT,

Dorico 3 Tl&. BLR2BET NAANSDHRILDEAEHEERRELIZAUDF
WOBETUTL—FEBRETESLIIHRYELZ, TRTOTUIL—EBFHIA
TEDH. REERY BRI BEMNGLGEY, 1D Dorico A—H—MERT L8
DIHYRAR—bBITHRAFET,

[H/8—23> M Dorico [ZHELT=B4%T> 7L —k &, Dorico A¥ HALion Sonic SE
H LUV NotePerformer D/ N—F v LAV ARG LAV MBSO UREBEMIC
HARADDBENSHAT, BEBETUIL— EZDHTEMNTEET, Dorico 3 Tl
FEHETUTL—FEERTESLSITHYEL Iz, NIEN—F VLAV Ry LA
UhEBAHRAH FERTEIYVURERARAA TTURRSAULDOEEE (Endpoint
Setup)INFA7RAY T VST THRTLyIarIvT#EYLTHIEIZLH>T, 70
CIVMADAV ARG ILAVREENSED Y ORI VEL T ERETHED T,
BHD VST AVRMYILAVADEEEFHBELETUIL—F 1 DITREFTEET,
NEZENETNDIVRRAVIEE. TRTOSHE VST THVRTLyiarvIvT,
HBEU VST THRTLyiavIvTICErTSRBINITRTOBERDESR X
LEERBEDEEZ. VEFLEDHIZTTEHELEDTY,

FE}EETUIL—FOER: FRIBETUTL—FOERFIBIXLLTFICRYET,

" FTREENRTHRELGDIAVARIILAVIDEY B TON=TL—Y—2T 0
:)Ibl\':iﬂﬂu L/gsj—o
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» BAE—FICYIYBZT.BET B VSTAUVARYILAVRE VST AV AR IL AR

INRIVICERARAF AV ARG LA N ERRS (Edit Instrument) J7R2Y (WX F
DlelDT7AaY) 59 ILTAUE—T1—RERRL,. TASIIMD AV R by
IWAUKNZERT B Y IR ERAHIAHFET .

BEE—FOARVITARTULAERIZH BSOS —DavbO—)LEE R
LT.&AVARYILAVRE VST AVARYILAV DB LG F oo 2ILIZE|Y KT
E I

VST AV RRSIL AU R RILTRIET BT TURKRA VDT (Endpoint Setup)
Ry (BEDOTA2Y) #9)vIL T [TURRLUFDERTE (Endpoint Setup)]
DFATATERHEET . [TVFRAUFDERTE (Endpoint Setup)1DF 47045
DEMZDOVTIX, SCOARL—2307 a7 IILESBELTLESD, ROBIE
BIZ2WLWT, IAR—bk (Port)l. IFv>RJL (Channe) 1B LKUTEIYYETOEA=A1Y
AkHILAVE (Assigned Instruments) | DFIAT R TIELWN EZRESEL. TS
ATLwiary7 (Expression Map) | DF|DA—1—%FERALTEYE VST T
YRTLwLaveyTZEY S TET, @Y VST TH/RTLyiar Iy I GFE
LEWMEEIE. TEE (Play)l » TZ9RTLyiar<yF (Expression Maps)1%
FRALTERLET GEMICOWLTIE, SCOARL— 30w a7IILESRLTK
EEWN) o AVARILAVEITER YLD AL, TNR—hyarveyd
(Percussion Map)lDFIDA=a1—#FEALT, B/ A—hyar<yTHENY
LTET,

NEDFIEMNTET LIE. [TURFRLULDEERE (Endpoint Setup)lDF 47045
DI FBFE T TU—MERTE (Save Manual Playback Template) J/RZ>%41)
YILT. ZD VST AVRRYIAVCDFEHBELETUIL—F 1 DEZRETIMN. F
X ERRFIEEHEDEM VST AR bYJLAVMIEYIRLTHS, VST 12 Xk
WADRNRRIVTEDT I a0 N—12H 5T FEBBEETVITL—FERE (Save
Manual Playback Template)I/R2> %0y IL T HWESVIIZHETSATDAY
ARYIAVND T 2RO -FEBETUTL—MERELET .

BETUIL—MOER: FHBETUIL—ME 1 DU EERLTWSIEE. Thb
% Dorico DWEAREDEFBAE T IL—rAEHLETHICFTILOBETY
TL—bEERTEET, CNICIXTHEE (Play)) » TEB&ETUFL—b (Playback
Template) JZ:E#RLET, COFAT7OTFUTDESIZERTSNTLET,

79 R—T Steinberg Media Technologies GmbH


https://steinberg.help/dorico/v2/en/dorico/topics/play_mode/play_mode_endpoint_setup_dialog_r.html
https://steinberg.help/dorico/v2/en/dorico/topics/play_mode/play_mode_expression_maps_dialog_r.html

(») steinberg

Apply Playback Template

HSSE (Elements)

NotePerformer

=1
|

Apply and Close Close

FAT7OY LEICIX. BETUTL—FD—EEZTAIWA) T TEBRET(—ILR
NHYET ., —EBRIIBETUIL—FOER. FEFANTHBHERRET
HEIMESIMCE>TY—FTEET  BRFHE THAHHFEIE. 2 FIHIZTHDT7A
AVHRFRENET, —BEOTDOT7IavN—IZF. ENSEADIEIZUTOATY
IUHIBDENTNET,

BN (Add): ZEHDBAETUIL—MEHRERLET,

#E (Duplicate): BIRFDBETUIL—rEHLEICBETYTL—MEHRER
LET,

HRE (Edit) BIRPOBETUTL—ERELTET,

H B EZE R R (Show Factory): HERREDHBETYIL—tE—EIZKR R
TEMEIMRELES , IR ETIIALTY,

EBEHL (Export): BRRPOBETVIL—rEMDIVE 1 —2—IZ/ R =)L
TEDI7AILELTEESHLET,

BARAH (Import): EEOBETUIL—MERRLTHRARAAH, COIAVE1—4
—THEATESLIICLET,

HIFX (Delete): BIRPD1—HF—ERZDBETVIL—IERIRLET.

BETUTIL—MEERTRICIE. FAT7AT TERDOT Va0 N—0M+ 1RV %Y
JyoLET . [BETUTU—ME#RE (Edit Playback Template) IO& 47045 A
REET,

Dorico 3 /N\—2aV ERE
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@ steinberg

FAT7AYT L THRBETTL—FDOTART (Name)1Z3EELET, ID F1—IL
FIZBBIERSNET M. OvI71a0E0) o3 5L, THERE (Creator)]. /X
—2ay (Version)1H &UTERBA (Description)1 74— LR DwRENE ML DHEE
LHIT. INEFETHRETEDLIITHYET . ShoDTo—ILRIE Dorico [2&>T
BEEFERAINIDOITTEBYVELAN., EAE WO —LBETTL—
FHRETLHOLYNH LB EE. CIICHMBEETAALY  BFEOBETVTIL—
EFIEIET BHEIET/—Pay (Version) 1B ES& LIF YL TEET,

TToh)— (Entries)]I—EIZIX. BETVIL—r 2K THEASNBDIFHELUVE
BOBETUIL—MD BEIBELOBIETR RSNET, 2FY . BETVTIL—k
ZERAT DMRIZ, Dorico [EFBA VR ILAVRADARD IV ) —DEY HTE.,
JRALD 1 ED. 2 BHESNIBEBETHAFET . BRUICAVD Y IURERITHEDA
DARYILAVEDEEDRIREZRERTIBETUIL—EURLND—FLIZEREL.
RBLLT, z&Z 1L, Dorico MR EDBEBETTIL—FD 1 DFYRLD
REICEELT. 7OCIIMIBMT 54 ARYIILAVMIENTHLEEMIZY S
URICEIY B TENDELSICLET,

[ToR)— (Entries)I—BEDT7 72 avN—DRIAVIIUTDESYTY,

» [FEIFEM (Add Manual)1Z20')v o9 5E, AVELA—F—IZHET R TOFH
BETUIL—rERTTIAZA—DNRYT7YIL Ama—bmoToTL— %
BIRTBHEMTUM)— (Entries) I —E(TBMESNET,
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= [EHRIC. TEEZEM (Add Auto)IRZ2 %) w99 &, Dorico DHEAZRED B
BHEETUOIL— T RTRRSINAZA—DRYT 7T, ZTHh5 1 D
BT HEMTUM)— (Entries)]I—EIBMESNET,

» [EAFE (Move up)IEEUTTAEE (Move down) I DHREUIE, TTUR)—
(Entries) I—ETRIRPOBETUIL— 2 ETFICBEL. ThODELIERME
EELFET,

= THIBR (Delete)llE. FHFE-IIBHDEBETVIL—rEZOBETYTL—M
HHIBRLET A, BELICHIBRINDZEEHYEE A,

[273)—0 LEE (Family Override) JETA VAR ILAVRD EEZE (Instrument
Override) ID—ETIE. FEFLIEBEOBETUOIL— LI BEDA AR
ILAURDI7I) —FFE R DAV ARSI AAD LEEEFERTEET . 12
EZIE Vienna Symphonic Library OFBBETUITL—MIFYRET HUTIL
DZEZMBUNOH N TNET A, VANAF)(E EastWest Hollywood Strings 5
HERTALIIIEETEET, CNDIGE. TTVM)— (Entries)]—E T Hollywood
Strings DFFBETUTIL—FEZRLTHL. [AVRARYIILAVFD LEE
(Instrument Override) |—&D 793V /N\—Tl+]&5)voL. RIRSNBAIUR
Ry JLAVMEIRRY TAH—N—m T4 A Y (Violin) I1ZEIRLET,

— RIS RACBETVIL— M BROFHBET U IL—HBY . ENENAME
CAVRRYILAVNMIH IR ERBT DG S ERITIE BEFIT7IV—F=[E1>
ARYIAD LEEZFZRETIVLEIHYFEEA BE(X. TTUM)— (Entries) ]
—BICBETVIL— M EEIBICHA TSI LEHRT 52T THA T,

LI R TOBETYIL—NE, ZFZOaVE2—43—THhERFLIZRAWN =X
THOTACIITCERTEET,

BETUIL—FOER: AVCFILOBETUTL—rOWVWT O EFERTHERIE.
B4 (Play)] » TEB4ETFL—b (Playback Template)1Z#iRL, —EMSEB4A
TUTL—bEERLTIHERALTEALS (Apply and Close)1&9'vo9 5h. HIC
BETUIL—MESTILDIVITHE FATATNBEMICEALET .
BETUTL—MEGHAH: T7AIIRRFD dorico_pt TEEH SNz Dorico
DBETUIL—rEZTEo1=15E . Dorico DTAY IR ILURIIZINERSY
TT7URRAYT I BT TIVARM—ILTEFY . AV AL RIFT. BESLUVSE
DIFRTOTADCIMIBEVWTIEE (Play)l » TEETYFTL—bF (Playback
Template)IMoFATESLIICTHYET,

FEEBOD{E A B E

BEE—FTIH,. BAIVARIIAVNMIBTHAEREZINZENERNDIURRA R
[CIL—TFAV T T BIEEBETELLSIHRYEL, ChIZEY ., &2 E N—F
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@ steinberg

YILA LA DEHHURIZEARD MIDI FryoRILBABERIBEXD. T49420
Nyt—CFKYIMNRBELGE I aVICBY GO URTEATHIEALE . BT
BHIHIETEET,

EHOENBEEEDICTBICIE. BEE—FRDAURARIIILAVRD IS IANYE
—EBICHEIRTAF RV FEERLET . BT EHLE. BEIRITEMDOFEEHA
AMRDFroRIVIZEIYBTONET , CNIEBEUEN—F v LA XY LA
BOTWBAVRIVADEDF Yo FIVEFERATEM BEISIELTHLLA VRS
VREBMLET,

EHOENBEZENCTIE ASARRMYFOITCHIZHAINAVTTIUNRE
MY FOAVRA—LICEDE D ERER RS INBIRTEET, MHEE
TIHMFRTOEE (All voices)IhERSN, COEEHNTNAR R—F. B&
UFroRILDAVRA—)LIET R TEMLGYEST, [TRTHOEE (All voices)]
EBINTBE ET7/O—ILTFARTLAIZIFTRTOEED /— bR FTESNETS,
INITRL/—IROS T —DREFTEZAFETH A—bA—2aV EEEREZED
L—UIEEICGYET
BRADRAZDSEWNVTNAEROYTEHUMDERTHE OV bO—ILAFTART
BAMGY ERDORARDIV—T 12T H EEETELLIITHYETS,

MEARETIE, EAETHRNTRZDEE 1 (Down-stem voice 1) IR EYFE
DEHDHREIL. 7O HFDITRTOI7O—DBEPLEHIZIVE T ST
H. I RTOIA—ITHEECHBZITEOLERHYFRE A, -ELKRIZE>TIE.
JO—fECELEEOEMNIN—T1V T DR EICELHGZELHYVET . COHE. TCD
70—IZE5E (Set for This Flow) (B) &7Vvo95&. 7B8—&I2I—T42T
ZEACEETEET . cNIE. EROEENSLY BMOT4J4o0VAD/ Y
T—UFEROSOLEMTIERTRILFET . LA RE 1 EETHIFEN ELAZ
DFEER 1 (Up-stem Voice 1)IMTA4T42 D/ \tE—2DYBNAF) UITRIGLE
TH. INDE 2 BETRENAAI 0230 DT IHIVEDERICESLIGIEE
TY, tDT7O—[CRILEHAGNEHT. 1 20708—0 1 2D/ vtE—IITxL
TOHERBEEMTHIELTEFET . TDIL—TAV T (FIBICERETEEITH.
DI RTHOESIZIEFRTHOTAO—IZERE (Set for All Flows)] (Bl ) %%
L Ib—TA4 T —BSEDIRENHYET,

BERITESRTYNMIEFEHOENBLEEIRETEFTEA,
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@ steinberg

ROV TA—EEYFRUN DTS

BAE—RIZIE.MIDI OBEREIZERTESY—IVEILERT S 2 DDIT43—HH
LGEmMEShFELZ, RO T —IT442—& BEFED MIDI OV bE—5—I 7443 —
ANDEYFARURITA4E—DEMTY,

RNOVTA—ITA3— bV INIE—DFHLWREILED) 9T HE AV ARYIL

AADARALTA—ITAE—DRREFRRDYPYBEDLYEST . E7/O—ILDT

[CROVTA—ITAE—HFAE. TRTO/—FBEDN—DARFRSINET, 1T

DIFE. BEN—IL 1 AFICELRYE TRRSNFIT A E7/O0—-ILIT(5—

TN—ZERTHILETREDN—ZRIAEICKRRTEET . ERLIZ 1 DO/—+D

EHEGROLTA—EE. RO TA—IT43—DrIVIANYE—DRAEY IO

—ILIZRRENET , ChIZEHFEAALT [Return] ¥—%H{3 L. A0S T4—1E

EHIETHEETEET,

ROV TA—IT43—TlH . BEE—FDOY—ILRYIRANDUTOY—ILHBEEL

7,

» FITDIHRDFIR (REN): COY—ILDFEREEE, /—bDAROLTa—N—%))
YILENLR IV T LTARAL TA—EZ BRI E S5 A0S TA—/N\—DBREFED
ESUTOECTEY VI LTEERLST CEMNTEET,

= AEE: COV—IILOERBIE AR TA—N\—DEHERNTY) v ILENRSRTYY
T BHET)—N\URTHRGE DK AN, TVRRAU2—E T L. DN
FERRITRIBTRAL T —N—DRESIET,

» AV ZOYV—ILOERRIEL. VU ILENLRSYT T 5E 2 SEIDERIHEL
NET YVRARAU—FERT EEMINBOABEIIELT 2 REORAS T4
—N—IEEINFET,

/—hROL T —DREFHIBRT BICIE. AAS T —F Vb T B/ —FEERL

TIMH4E (Play)l » TBE£0O LEEEHZE) YL (Reset Playback Overrides) 1%

BRLET, iKY, SO/—MIMAONzZDMOBEF T EYRET AT+

yhENFET,

EvFAURIT(4—: THIZEFD MIDI IV bA—5—I 78— ESh TL

F9.MDI aUbO—5—IF(8—F E7/O—LIT(4—DTFITRRTENFET

(NEYTA—ITAE—DRRENTVDIGEEF. TOTIZRRESNET), MIDI TV

FE—S5—DAZ1—MTEYFARUK (Pitch Bend)1%#&IRT 5. HRIDI T4

—TARTUADEFHEIN  EVFNEBRINTIVEWNIEZR DT HRLEDKF

BOARTEINET, PRIBEY LDRAUMIEVFE LT, BEY TORAUMEE

YFETIFET,
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ATz ILDFER (Object Selection)1V—ILERBIIBEFEDEYFAURDT—
ARAVNEBIRLTR ST TEET, [ (Draw)|V—ILERKFIEFROKRA>
FED)—NURTHETEEY [SMY (Line)lV—ILERKIE 2 AROEHRER
BETEET . T—IRAUEAABFICERAT LY ) vFORRICEREL LEROTRSE
[CKBDEYFARURIL 4 RERD U322 DRERICHITOEN, GOHONIBEINET,
EvFAURIE -100 5 +100 DETERESN, BESNE/HLTOThH
ITRK 1 ATy (& 2 2) &#xbHLFET,

Soundiron Olympus Choir Micro
Dorico Pro 3 & U Dorico Elements 3 [ZI&. Soundiron @ Olympus Choir Micro
OA—ZRADYIURZATI)——AMNEENTLVET, Olympus Choir Micro &L
(F5<DfE Kontakt THIFATETLVELTAY, Soundiron MF—LAY HALion Sonic
SE AZ473)—&BEFLI-CEICKY ., 2HEEATIATES LIV ELT,
4 751)—IZ2LVT: Olympus Choir Micro [&. Soundiron A% Olympus Symphonic
Choir 5475 ——HK D=8 IZ. Robert Geary KD 1EE D T San Francisco
Choral Society. Volti, San Francisco Symphony Chorus M5 63 AOFEED
THFYTFr—LEREEFERALTVEY . I—SROFFF. YU IV RIEE
WEESILT DRVHICH D, BENICRER A TL—LBE D KRRGF )L
Tl FELTZ, 90 BEZBZ B I ThON RO T—THTYLTAY
vk & Soundiron B DHFE N EEAGHLE T EmETERENGEL VIXZYY
TI—SRADFATZ)—MERBEEINFELT=, Olympus Choir Micro (&, A 1> DEEY
AIMEBICEREEDLELZAMBAYVTINSA4TS)—TT, RSB/ FIZIE,
4 MEBDVIZ/ T THF—  NRADEEEHTDIILT oYU TILTHDOM,
E7/ETHNTAVEMADTATIVANEENS  BEOBEOHHKEE 2 D
(Tahl&lool) AMURERSNTLVET .
Olympus Choir Micro @K%, Dorico Pro 3 $ & U Dorico Elements 3 TE
BEN=FHLWTOD O DOR—DILERICIE AR ETCHEAINE T, MIHARTE
DEETUIL—rEERTAHILET, [B/A—3> D Dorico THERBIN-TOS Y
MItBEATEEY .
a¥kA—JL: HALion Sonic SE /> 4—7x—X%BLT, ZZTHRESE (Edit) 1D
—J%BIT H &, Olympus Choir Micro /SyF DAV FO—)LINRTENET,

Dorico 3 /\—2avV ERE 85 R—o Steinberg Media Technologies GmbH



Dorico 3 /N\—2aV ERE

SOUNDIRON
MNLayer 1][ZBHEDEWFEIZHIEGL, TLayer 2] [FXEDBEWEIZHELET ., Th
FholLayer I3/ FILOERIZHDIAFDREIVIE. TDLAN—DA 4 T%
PVBRET . RIVEFTIZTHE. ZOLAVY—IEBEFHLEE A,

MLayer IOAAMILD TS TIZHAROYTEHUTlE TahlEloo DB EE, X T
A2 RIVHA—b, REYD—bFDT—T4F2L—2aVEBIRTEET KAV TS
YOTIZIEUTD 6 2D/THHYET .

= TSwellJl&, LAY —D5EFEDR) 21— LEFHELET,

» TPanJlk,. LANY—DRTLAN/SIEFEBLET,

» TAttacklE,. LAY —®D 1 /—bODTZY IR LEFIEHLET , EA/NSLVERL
BY (EERECTEHERVEBZNFT TR LR 2a— LR ENRBESIZHYET,

= TOffsetl(&. LAY —DH VT LEOBIAA 7LV MERBILET . /T LT L.
YT OBENEYY VT ILIZBURA THIESNETS,

» [Releaselld. LAVY—ND))—REDBEREMEZFELET ., hlX, /—FH)
J—REN:=HEESITETIETORBORIEZHEHLET,

= TRel. Vol.JI&. V)—RDHY T ILDHDR) 21— LERAELET,

FTnZEndlLayer I/ ARILTEIZIE. E7 /DS THILTETDIRBIEEN/—FA
AL T1—& MIDI CC DELLIZLH>THIHIEN SN EERET HMDynamics IRTA
B—HYET RFMT—D—BEIZHSEE . REOEILIENOAST4—DHAIC
LoTHIEHESNh, —BRIZHS5E. @FBEMSwell 1/ T (WHAFRE TIEX. MIDI ok
A—5— 72 H&U 73 ITIVELTINTUVET) IZ& > TERICHIESINET,

2 DOLAN—/ISRILIEIDOFRFZIEBlend IO ILREURHYET , AT12F
BE MADLANY—DREIRFICELRYE>TRYET . AvICFTHE, IBlend ] RS54
H—ZEHALT2 DOLAN—2F—T40 T TEFET,
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[Blend JRSAF—DTDHRDF|IZIE, lLegato]. lVibrato ], Ff=[EKeys J7R
BUDISEENNEBIRENTLWANICEH>TELRIVMO—ILARTEINET,
lNLegatolIZ[FUUTOarvrO—ILABYET,

» lLegato 1IDORTILRAVIE, BEDFEDOLANY—ToIalb—bSnfzLH— %
AoFERIEATIZLET,

» lLegato 21D LRIV IE. KEDEDLANVY—TIalb—bSnzLA— %
Tpif:[ijjl:bij_o

= [Timel/7 &, ELANY—DLA—FDBITOERSEFIELET,

» BEERECTHEFE. BITHOYVARTz—FNELGYFET,

» [Bendl/JI&. HELANV—DLA—FDBITIZVIaL—bESNFEVFAUREFE
MUTERAELEY,

VibratoJIZIZU TRV FA—ILABHYET,

= TVibrato LIOMILREVIE. BHEOEOLAVY—Co2alb—tshizETS—F
EAUFERIFEATIZLET,

= TVibrato 21O LKAV IE. KEDEDOLAVY—To2alb—bshizETS5—F
EAUFEIFEATIZLET,

= lLevel]/TIE. ETS—FDRIERSE, DFEYEYFER)2—LDED2L—I 3
DEHIELET  INSIETIEMAN G 2KYELIEETS—MIBRYFET M, [EEZK
ETBIEE, [FoFYVELIZENETS—IAERESNET,

[KeyslDavbO—)LiE, BHEAEDEOLAVY—DF—DOTRELEZIEET

E L INICKYNFOBETREREBEE L TICOLT DIEIFAIENTEET,

#H#l: Olympus Symphonic Choir DSE£RDFFEMIZ DLV TIE. Soundiron DAk

(www.soundiron.com/olympus) ZZ BB L TLE&ELY,

AR

JAVNEFERATAE B EDRERDBFEDME (F-(FEHE) (COAVFOWEHL
it FHIET, RAT7ICHZEAF ITONET  AAVMITFANTERSN TEY, 24
UROREHLEZTILY) 90T HH ., BIRL T [Return] F—Z 9 L THRETSE
FI o AAVMEIEREE—FITHLGEMEN =AU MR IVICRTRENET , BEIFD
AAVKIRIET HTELTE, ChITKYAAUMEFERALTTOO VD EEIZ DL
TELESTENTEET , CNIIBHBD AU N—I2KDT—H70—THRIBET,

YEREDHEA: FMEARETIEX. IAVMERBOHIFICEBREDI—HF—ThIUb
DT HhoVRBHERINET , Mac TIXIGHolstID KSIZRWLWT AV R AMER
. Windows Tl&ElGustav HolstiD &3IZ7 AV MIBEER TN TSI IL
F—LMSBINET  AAVMRILOZAAVMIE EREBE D7 IL R —LHEE
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EFHFONTRRENFTT , — AR TAAVFOREHLNRTINZGAE. £
DRITA=vIL 2 XF (A—F—RITKXFHIERINTVIIEEIEHETRIBIZK
XF0 2 XF. Z5THNEE 1 —RDRID 2 XF) BRRSNET,

AL E CTEU LT HOURED B TERMEES . IO TOIAVMERBIZEER
DINR—LEAZOXILVAADARNZRDONFET , ChoDFRIT, IRIFHRED
2% (Genera) IOR—UTWDTHEERTEEFITH., EFEDOIAVMIRESNE
EREDAFITEEBMNICEHRINEE A,

OAVRDEM: aAVREEBNT BIZIE, AAVERTTAME TERERNDT7AT L
ZEIRLIZIREET (ERO/NHIZE D> TTATLERIRT B, AU MMIESUD
EDEHEZSRLET  HEERAI7BRICREMICERRSNET AL, T4
ISRILIZIFRESNF D), T525E (Write) ] » Ta*>bE4ERL (Create Comment) %%
Yo dBh ., MEARTEDF—HR—Fa—rhvk [At)+[C] ZEHT 5. SBEE—
RFTCarAURARIILTEDT a0 nN—DT+ | REVED )9 ILET , FrLybdR
RENTVSHZE . AAVMIBREDORREBEBFL T rLYMIBITEBMENET,

DUTNBFATATHEE, AAUMEANTEELT, [Return] £fzI& [Enter] 17
FEAAVIAHEEL ., RATITBIMENFT , AV MEME TESE T FEOLATH
Z5&3IZ, [Return] 4> [Enter] (XEICFATRJTEEESETET , IAVMIRITE
EBINY BIZ(F [Shift]+[Return] ZAALET,

A7 DFRRLE-EROLICOAOWEHLARTEIN, TOFIZEREDM=
OXILBARTRENET  AAVMEIAAV M ARIVIZERTENET,

AAVEOHRE: BEDIAVIERETSHICE. RAT7ADIAVIERRLT
[Return] E7zI& [Enter] ZILET , £, BBEE—FTAAVMARILDIATE
EETIVIYHT B, AAMRRILDAAREEIRL T, SRV TEDT I3
UN—IZHEIRETAAVED)VILET,
JAVPDERRBFERILA AT R BNRREN, AV MDBREDTFAMERIREN
*9, HMELHEEEMA T, [Return] E1=(X [Enter] 2L TEA7O5E2HELE
T o AANDAA LRIV TIEEHFINET B AT ILOERE IFRFSNET,

AAVRADRIE: BEFEDAAVMIRIET BHI2E, A7 TIAAVMERIRLTH IR
5 (Write)] » TAAVKIRIE (Reply to Comment) 1ZEIRT 5H . PR EDF
—iR—Ra—kAvhk [AIt]+[R] ZEALE T, Ff=lE, SLEEE—FTAAVMIRILT
DT O avN—IZHEHRIERIVEIIIILET,

FAT7OTHERE RIEEANTEET [Return] E/zI& [Enter] T LAV
FEEL, RAO7ITBMESNET,

REIE. RA7RADBRETIAVEDTCTIC, B DAV POREHLELTERT
ENFT LB E—FDIAVMAIRILTIE, BEFRETOIA DI CTIZAY

TUMNTRRINET  AVTUMEIL 1 FBELANGEW O LBEOREIERICAY
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TUMBIZEBEYETS,
AAVRDHEIRR: aAVMEEIBRT BIZIE, A7 TIAAVMEEIRLT [Delete] 2189
M OAAVR AR TIAAVEBIRL T ARV TEDOT O avnN—IZHBEIBT A
avEI)YILET,
OAVMDEEHL: 7Oz LaAANERERATEESHEE T, AV IRIL
DTFEIZHBT I AVN—DEEHLREIVED )vITHE. TAD IR IT7AILE
—RBICRTFSNHTML 77V EEHINDERBFICT I4HILED Web TS5+
—THHMNICHAINET, 7O IMDTRTOI7O0—NIAAVIEHEINET,

OAVRNRIL: BREEE—FRDAAVMRILIZIEZ. BEDQ7O—ADTRTOIAUE
MRREINFET, FAAVME 70— DRI SR T ETORRIIEICKRRSNE
T AAVRADREX, RETDIAAVIDTCTFICHATR RSN, DLETFAY
TURShETS,

FEAAVMIFEREBOIILA—L BB (FEEREHB). ELVAAVN
B BDAVRARGILAU NG LN (FIFF-DNHEHD/NE) NRIRENFET, a4
hDTERRARBTATRRSINFET,

AAVRNARIDRRENTNDEE AAT7ADIAAVOREHLEREIRT HE, /N
FILVADIAAVPLBIRENFET . FELFAIRE T NRIILADIAAVEERT BHE
AA7ADAAVRLBIREN . AAVMRASMEETRIATEA—HIBEHLET,

ISRILTERD T V230 N\—TIE, FHEAACDEM (RATRHRTTATLEERT
HERFUNEHIL), EFEIAVIDIRE (VAN TIAAVIEERT /ML),
BEFIAVRADRIE (VRAMATIAAVIEERTHEEMEL). REATOIAAVLD
ETHL CREDZO—IZ 1 DULEQAAU DY HDEERE). BEIUVEGFEIA LD
HIBR (VAR TIAAVMERIRYT HEAMIE) BMTHRRFET,

JAVRERT: TEa— (View)] » TaAk (Comments) 1% #IRTHEX7HNOT
AVEDRREFRTEVNYBEZONET T, PIARETIL, AAVMIRTRENFET,

JAVMIWHRETIXEANRENERAD., RIE—RTHAIA T av R RIILDIE
I (Annotations) 1o avIcH B AT avER R (View options) 14 I2F
HEEHRIICHATEET,

N—FE=HR
BEBBLIVILYMEBDN—FEZIADREICEATASEIELRTERAZ YR
—hLFET, CNIZIFERAAIN—FEZJROWANEEN.E 2 HhidE 6 TTD
N—FEZHJRADELVWEYFHLEBTEHINET . N—FZVRIZIK. D /—F
(F=FHELHE) (- TEELFFONFET . F 2 N—EZIVR(EIEEF 2 5E|
THME.FE3IX3NE.F 44X 4 9B ELN--EETT,

BRAN—EZJRIE ABRED/—FD55 1 DIZAYFLTHS, KoM T F=I&
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DEBEFTEHILICEOTHRELET . E 2 N—FEHVRIEKEOEYFD 1 45
A—TJ L E3ETDRLEL. FA4FZTNTLEA4EL ES5FTORIEL,
%6 [FFNDE 3 ELTT, —ADAIN—FEZH/RIE BEZ-ZEORSIZNTS
/—RD55 1 DNHAYFFTEHIETHRELET ., cnlEk. TL—V—HKEZL(CH
SABDEERRE/—FTHYFTHIENRFICKRDOND-. BRAN—FZIRE
YL ZELNSVEMNTT,

N—FZHJRDEM: N—F=YREEMTHICIE. AREELEBSZZOEY
FERELTHS, TONTA/IRIVIZHLGEMSNFIN—FEZH X (Harmonics)]
DIIN—TI2HBTB84T (Type) IO TANRT4EAUIZLT BREIZHLTIAL
(Artificial) JE=IZT B (Natural) JZERLET , MEAKETIE. B 2 N—F=H
R (DFY. BERAFENEYFD 1 #95—T L) MEESN, ADN—FE=VZAD
HEIE. A LEDEYFOLEICAVWERFENZEINET . BRN—EZVRAD
BE. XA —LNTIEEE LOEYFD LIZN—FEZHVRERTRNESHRTRS
NETH, FE—TEADYIZEBE LOEYFNENER FETRESNAET,
/—FDOEE: E3IMNLE 6 N—FEZHVRITERT BT, [EF (Partial) 10T A/
TAEAVICL T BRITAVFTAMED/—FBEEEIRLET . 1211F5FE 2 /N—F
ZHR T6]IFE 6 N—FZHURTT, N\—EZHRICEMOBAVEBFENR TS
Nn3G5E. BWERFBEOEYFNEHRINET,

BRN—EZHOADONBDZEE: BRN—EZHVXIZIE 3 D2ONEIAAEZESN. TR
LIV (Style) IDTA/INT4%A 2T BHETHRATEET,

= _F[ZH (Circle above): CHIEN—FEZHIREEKTIAVIEENLBELOEH
DFEEBIZRRLET (f=FL. THIE (Placement) I TONTAZEF 2T BHE
RAEID G EIZE5EH TEET).

= FMFFEE (Diamond notehead): N IZE B LD EFOFFELZEHMEICEERL
FI. BN 4 DERUTOEEFEVERIC. 2 PEFULOGEEIFANE
MIZEYEY,

= ZERMFFEE (8) (White diamond notehead): Ch (& B EOEHOHIEE, B
DERSIZEFRGE BOERFBICEELET .

AIN—FZHRDBATDER: AT/N—F=ZHIRATIE 4 DDEATDIN—F=H

AN R—FEN, [RBSIL (Style) IDTO/IRT4%EA VT B ETRRATEET,

= {Z# (Normal): {EZ EVFEAVFLIZEYFD 2 DOFEMNRTINET (/)
—EZHJRADTANTAIZEDEHESINT T REEDIHEEIEE 2 N—FEZHX
ERGENFET) #T TSR - ILYMARTEIN, TCHEICIKFEIMICEHAT
AyFLIz7Lyb (FLETLybDFRAME) NARRESNET,
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@ steinberg
» EVF (Pinch): FA—8BEDTIVITHAIELFN—FEZIRX (FAILARN—F
ZHRERIFRID4—ILELFIENFT) (K. EVITHENV-RICEYITYT ik
D/—FTREAVFLTHEOEETEFX v EILTEHILET. BRN—FEZVRADSH
1 DN XEMIZESZEICKYBRENWY DR RELES . EROERTIE. EY
FN—FEZJRTWEIZDMBEREINDIEVFD 2 DOFEMNRTINETH.
RATEICITWEIZADMBEDHDRIINET,

= 1 DOFE (BELEDEYF) (Single notehead (sounding)): EFDERIZIXE
EFOEYF. . DFYVRBRELTELBN—FEHIRDAHDFRRENET, AT L[
[FREZBTLYEHRTEIN, FOICHIZEIMTETEZTINIEYFNRTRS
hij—o

= 1 DDFE BSZBHLBOEYF) (Single notehead (stopped)): ERFDEERIC
FHESADMEBEDEYFDHDRIRIINET , FTHEICIEIHSZEHTLYMIRRS
. FDOTCHEIHEIIMITETAYFTEILY (FEILYEOHREME) HART
SINFEY,

N—EZHADEERES: BREICKHLT, I/v—FZ=HX (Harmonics) DT IL—7

2 DTEREESE (Accidenta) IDTONTF4EAVIZTHIET, AVERMFEEIC

FREFELBERRT DM, ERRITTHM . FEEIMAETRRITIMERLTLE

E2xTEFT (FHEKF (Notes and Rests) DT IL—T2HDHRLDTA/ T4

. N—FEZVRDOFETIHLGEEDFEBICEAINS-H. CNEFELGYED),
BEOBROBRIRESDIGES LAk, RS ERTT 55 IXTERFES S

(Accidental column) IO TANTAEHETHLTLEEZTEET (0 DIEFAL

DINEERL EDEMEEBRDOFICHELET ), £-TERHES X 77€vF

(Accidental X offset) IO TEA/NTAZERET D&, FIxt I HERRFEHE DFEHEK

FhEx LEETEFES,

N—FZHDADBAXE: SEION—RATIH. N—FEZHVRADOBEICEEITHEFMLGY
R—rEIHYFEEA.

—TiLShi-RERE

BERBERFERBRTTAL—2aVERTTEDLIITAHY T IL—TLLTEDELS
[SHYELE ChITKY . HAHABRRENCMDERTBEE~NDBITERLE T DEL
BT L—TADT R TOEEREZBHNICERETEET.

sul tasto =0£<_i;______\ sul pont

T > .

. p - - = .
b . ? e T ehe £ 2E L T
e e —] —]
%)U 1 1 1 | 1

—_— T ——p cresc.

GI—TIUEN=EBEBGEOERITZ ATYT AN BRIAS ., FEIEEBEDE
EEEDTIL—TIED 3 DDHFEONT NN TITHRZET,
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@ steinberg
ATYTARN: RATVTARNTEEBEEDT IWL—TEERT BICE, FrLvrERR
L. [Shift]+[P] Z A AL TRYTA—N—Z2REFET, VI —TORBLEICERT
HEEHEDZMEANL BERICKRMNZEKRTSHI->1ZANLET . ChEA S
THIEICKY. TDERRZEZERLTUBONMEIZH LA DERBEFETRHRITS
Z&% Dorico ITHEETEEY . LRDFIZFANT BIHE. Tsul tasto->1&ERyTH
—/IN\—[ZABALTHL [Return] L. [Space] #H I MNBFHFEILICAALTH
YLUNEEDET . ROBEZREERT T HMEETEET HL. [Shift]+[P] &3
5—EAALTlord.JEA AL, [Return] ZLET . FIL—TE2HITI 5B AL
ford.->JEABL, SHITFYLYREEDHET,

EERZEOERBOHEICHOEERZEEANET (T T I BIZIE. [Shift]+[P]
DRy TA—IN—IZ[?2JEADLFET,

BIRMSER: EBIRAD 1 HOBERBEICKD T IN—TE2ERTEEFT . FT 1 D
ODEEREERTTAMBL. 2 DOODEEREFERTTHMBERIRLET .
NoDMEFFRILERLTERLET . EROERICE-NIMEZTERLI-EGS.
TIN—TEEh=EBEREITEROSE—BLOERICOAERSINET,

[Shift+P] Z A AL TRy T A —/\—%FKRL. 1z&Z [LTsul pont->sul tastol&A
ALT [Return] ZHLET

BEOEREEET IV—Tib: L —TIbT5EBERENBRICRa7 LIZERTS
BE. TALERIRLTIERE (Edit)] » EZLUE (Playing Techniques)) » &
EHE%E Y IL—F1E (Group Playing Techniques)1&Z#IRLET , BIRDS5b—F
BAEBRV-TRTOEREEE. HEOMREEDHSLSITTaL—av R
SNFT TN —ThTRTOBEEBENEBRRERTT IR ETHII5E. B
T HERREFTTNTNEBRICLYEREINET,

BEREEETIL—THLHIR: JIL—ThoEREZEE 1 DHEIRT3ICIE. The
BIRLTIRE (Edit)) » TEZH% (Playing Techniques)l » T L —ThoE%E
B %HIB& (Remove Playing Technique from Group)l&:&iRLET , ChILE
EREDTAL—2avICEHELFRA R TEEBRICZERBROR RISV E
1o =18 8 &, FNERIRLT [Shift]+[Alt] £HLEMNS [<] ZBLT. Tal—
avEEmELET,

TaL—2a  EEBR: TR D/ AR )LEIE [Shift]+[P] DRy TA—/3—hH
SIFUHE ST IHILEDEEREDFEALIZE. HIRETRTTD51UMNK
ESNTWET, Tab—2avIid@E. NAZETYIREORERR (TvrIFERAI0
AE) TRRINDG—AH. EBITEE. ERAZTOEYDALRHFEDEBRTRRS
NFET . TERM—ADBERBETE.ERAT T+ DIV IRNADEZD
BETTaALb—av EEBBRIBIBINET, JUIR—ROEREEATIE. FU7
DEEAROHREEMNSFIBSNET,
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@ steinberg

Tab—2a v EEBRBROBR. BLUVERREAICHTOIROBEEME L., [FE
(Engrave)] » IE&EH ik (Playing Techniques)JIZHLLEMESh-TEE
(Continuation) 127 TRETEEY,

General [N
Continuation type: = Line v
Durationline: ~ Solid line with inward-pointing hook v
Alignment above: ~ Halfx height v Below: = Half x height

Transition line:  Solid line with solid arrowhead v

Alignment above:  Half x height v Below: Halfx height

R TETAL—2a FEEBRICHT IS TILDOR AL IVIEEERTEEFEAD.
CNIFIFEMIZFEEEESNSFETT,

WREMIBT DT IAINCDKEMEE. BEF T avDIRESE (Playing

Techniques) |DR—DIEER (Continuation) IDEIavICHBA T avIzk
YRESNET,

NEDOLEEE RORFAM)L (ER. IR, ZFR. (SUBLE) PRIFDFvyT
(RENSkim, Tv9 ., RimfRas) OBEANFEHGE, TaL—2a v EEBBRONERIE.

FEE—FTOHRRTRINDZTOANRT4ARIILOIEERE (Playing Techniques)]
DI AVICHLGEMEN =T ONT 4 DS RERICHIETEET,

BRONBICMAON-ZRET . THE (Edit)] » THE8BZE) LY (Reset
Appearance) | CHIBR TEF I,

EEREDIES: 707432 IO EERE (Playing Techniques) 104 )L—
FIZFHLGEBMSINIIAYF T Lo TYH9R (Tucking index)IDTO/NT &1
[CF 5L, EROMUISEREENRIVISNBIBEERETEET . FvF oI 4
UTVIRNDERIET LT L2ERICERINET N 29X T AV TIIRIEY
=TSN THEVBEIROERHRICHLRETEET,

BETFFTORE FEE—FRTIIL—TD 1 D2ODEEREEEIRTEE.FD
FCEITINEBFROLNUFILBRRENET . CONVFILEFERTLHE TIL—T
ROE L2 DERHEDATwYMNIMFLLELS, VI —T2AREEEICBETEE
T, EwzlE BEEEEENTHLRRLTH YD FERLEIRSYI TEET BERED
BRINSBRAMBUTNDIGE L. BRECELE TROMBEELBELET,
FRRIZ. ERIDSHBUTELRICLOTRESNDEREEBRE T HL BERIE
[CELETROBTHELBELET £ EEREZORBICH A ROMinHH B
[CRETEET . COBDOFTyrE RADEZREZBEL TLHFINES,
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SFEE R THREINATEVME. TIL—TeEn = BE2 R EEBIRLTIERE
(Edit)] » T RT3 %tk (Reset Position) 1% RIRTHZETHIBRTEE T,
RETBH5)7I2&LBEERE: [B/A—23> 0 Dorico TRET 357D E%EE
AT 2EERE (EAIETAL—av a8 —0EEREELDIN—EZIR
DHNEE) ZERLTWIGE . thDBEERAISER T IEBRBELUTaL—3
VISERTIBLENHADT=0. Dorico 3 TIEIREIT BV IIZLDEEREILIE
N—=2308YE 1 DRIDBEFTRTLEY,
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@ steinberg

FARSH RS

RAT—RELIDT IILRIAERE: Gardner Read KM ZE{EIMusic Notation | 242
R=UTETIARDFEEDNDOYICHIEDERBEZERICINDH ST 90 EH
BRLI-RS—DERMNMBHINTVET, Read K, ChITFEHLWRITELZEEE
LEITH. —SOEHRIE. BEDRBOTILADAREELEIRLGLIRFLLTIO
RECZEZHEALET . COBERT—ITUEREEK REOTILROARFIFEKX
BRICNBOEREWLITFAIOTELGL, ALETMELELIFAERIZEYET,
Dorico TIHERZF—RBAILDTIAOARENFIATELLIITHYEL-, ThiZ
[Shift]+[0] DRy TH—/\—([ZTslurarplEANTEH . BEE—FDOIEHF
(Ornaments)J/ AR IILDITZILRIHA (Arpeggiation) | 293> T, &S T 5REV
)00 BETERTEET,

BEATavDI84307 (Timing) IOR—J(ZHLGBMEN AT a2 THhiR
FIURSFHDTI24IVEDESE (Default curved arpeggio length)JTl&, RS5—X
BAIDTINRSFREOBENREIEETEET,

JOTIROFERE: /T IROF DBFENORIGEDOEEMEICONTOF T3
UM, BEA T I DTFILROFES (Arpeggio Signs)IDR—T DI &IRD AL
i (Endpoint Positioning) 1Dt o avIcFHLGBIMENELT =,

BERE

BHERFDIHZAT: Dorico IZ&>THERFICHEASN LI BEIRTE (AutoSave)l”Z
AT —DIBMERET H-ODRBFRTE FHIRSN. TBERTE (AutoSave)l1”7
ANE—EA—F—LRIDOTT)r—2a0 T—2T7+ LT —RNICEESIND LS
[THEYELz, ShiZaA—H—HR>TAM TSI I+ VT — 5 BERFIZE
AT 5ELDERLTH LA —IZERELTLEL, Dorico ¥ THICRELZBBREES
=27y FT T B, TRV ERIZRLTHIBREIA TLESIDZEHLST2HT
ER

INGTEE

INIBBSDRE: LAT7 O Toa> ol &S (Bar Numbers) JOR—I D/
MBESOMEBEDOA T avhhiRESNFE Lz, IB/A—2aV TR /DHBESOMET
FRERICH LT 1 AP, DFEVHEBRDO—B LDERDO L, F-ITHBEO—BT O

DTFDELLMLMNEIRTEFEFEATLIZ, Dorico 3 Tl EBEDEBDAEIZ/N
HMBEBERTTEDIIICHYEL HED—FBLOERDO L. HEDO—FTD
EROT.ZLTHEDTL—V—ICBTH5— B LOERDO LLERTEET,

INABESERAKFF MBS ERAFOMREERAMNUTOLIICHESNELS,
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@ steinberg

= NEIRSEITARTO/MEHIZRTL, LAT7IMNIRARFLRTITHREDES T,
B—D/MEICEERAFDPDEHESFIERTISSNGAGYELE, ERTITE
BI2IF 2 DUEDNEEECRAFTHOILENHYFET . RKFD/INEHES
DHEZRRY ST TavElABOLETHERATHE RRFZLITNEES
AEBD/NEROBICR TSNS RIIBYET,

» MAESE/NEHREICEELTRTRITDELDITRRFDO/NEBRSDEHEBEZRT
X T AVARESNTVSES . RINFORRMED/NIES (L. R/
AEHELTRTEINDDZEHS=OITERTITEYETS,

INRBSDEAR: MHBSENFTEEARAVDOEARICANTRTI DEE.
BEAHREIEROTATLEHEETALITHYFEL, ShITKY MBS T /NE
WLICERES DRD/NEHESDHBENRESNTT,

5

Ay atBEOa—REES: IH/A—23>® Dorico TlE. beo&Lf=/\iyt—2IC
I—FREZRTTIDNREGERTL . TATDAURRY LAV NIO—REE
BERTRLTHDS RN TRELGERTRTEERRICTTILELRHS-=HTT,
AATA—EFTH. I—FESFVOERNFEINIGEDARTT DL —i
MITY, COGE. AV aBllEERALTRTT AL IBYFET,
ZOEBITHIET 51012, REE—FDTL—Y—/R)LDOTa—FEE (Chord
Symbols) IDHTAZa—(Z BEFEDA T ay (TRTDAUARYILAVMIRTR,
FTRTDAVARYILAVMMIIERR VR LEILAVDAV ARG LAV NMIERR) (2
MmAT, MA—FEBEEERS YL 1 4EBITFKFR (Show in Chord Symbol and
Slash Regions) |OZ# T arh#HLGEMESNELT =,

O—REEEfEEERT Y 25818 I2F R (Show in Chord Symbol and Slash
Regions)1Z:#RI H&. A—FREFBEBAVRAMIIIADV D AT YL A B ITURE
BINEHDEHICDARTINET,

A—FRSHEE: (VAR AV DB LEE D /M EEICa—FREEERTLDD
L AOHADEBATEDREICASY Y 1ZRRSELZWVGR(E, O—FRESHEEZE
HRICERLES .

SNIERIATAD 1 DULEDTATLERRLT, NC# (Write)] » TO—FEEEH
B #4ERk (Create Chord Symbol Region)1Z:&R3 5L TEET , O—FEE
PEIEIE. ERD—BLOREICR RSN SERATEELER T EIRT HEREE—
FCIENVRILNRRESNET (FEE—FTENVRILERFTEINERA) NUF
IWERDATR YT T AHLMBEOEHENERTINET, [Alt]+[<]/[—] (fElELA%E
8 KU [Shift]+[Alt] ZRLAENS [«]/[—] FEEDKR T LIEBEEZHEE) D a—
by LBEBY ITHEELET .
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@ steinberg

ERBRLI—FRESEERARTIN. ChIXTEa— (View)l » TO—FiE 5S4
%Mz R (Highlight Chord Symbol Regions) I TAH Y EFI7ETIVEZONE
ER

DDAV ALY AVMIO—REESHREENDO TR T HEE. TD AU Ry ILAY
MIa—KRESERTTDERETIEENSIGE. TDAVRMYIILAUMITa—FEE
SEBERS YL 5EEBIZRR (Show in Chord Symbol and Slash Regions)]
(BEE—FDTL—NV—IRIILDTL—N—DaAVTHFRAAZ2—NIO—FEE]
DY TA=a—) NEEIMICEEINE T, ChITKY, fEEIMERESNSETCIZHE
HROI—RESHAEEMICRREINET,

=

LATILDBRICEL-BHETORT: LATIMOBRAICELT. HEDES
REICERTIERREDIAT (fLAIE. BRAZT/N—MIEFEREERTL.
EFRIATVIZEANTREERRT HGE) ZBINTEFT . LD EIE. HIC
TT—YYIRADESINNBREEINEFREDEHZEZBRITHN—T DEIGEET
(. A DEEOBRIFR TSN GVEBERRSILELGEELHYET,
NIZHET B2, TRIRTANRIILDOTF RIS (Clefs) 1T IL—TI B
[ LTERA (Show for transposition) IO TA/NT4HBFLGEMENEL=, TR
INTADEESN TGN EEZE, EHREOEREETICHRESNFLATILE
BREICEESNLATINDEAICRRIINET  TONTAHEEINDE T
BT IEBRL-BAIMTEERATEILATIFTOARTINET , 1A DHBH
BRATHERTHLATIMMIE, BREFEHARELTRRENSET T, BEFRD
ERMEICTEZELLGARYET,

ZO0—FBHEDHTRMEEHES: BEDAUVARIIAVNTT IHILMNIERSE
NTWAEREEEEETTADICWLEL, JO—FIRNMEDH TN EIEESER
HLTH. EHDEREFIFERRICTESLOITHYEL,

E: EEEv S

&8 F poco/molto DATEVICHT HEE: FEATLavDIEBRES
(Dynamics) 1D R— DT REERISREEEE S (Gradual Dynamics)1D 93>I
[ANPEY EDEBEMHFTFAMDEIE (Position of modifier text on hairpin) 1074
TavhFHLGEBMENELz, ThiIZkY. poco % molto 7HE DIEHFFEANTE Y
DRBMED LT, FETRDKIIIIATELORAIZT 2B IRLCEBTE
BESITHYELT=,

el

——poco———
CONEIX. TORT1/3RIILDOIETFTEEE (Dynamics) DT IL—FIZ#FHLGEMSE
n-TEMHFDAE (Modifier position)]DTONT«EFEALTHLRIRTEET,
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BET—FTIXIEMHF DA Ty (Modifier offset) IO TO/STFaoE KRS,
NIZKUANTEUICH T HEHFOUEZRABTEFET . HALTEIOHIC [H
REZEYD AL (Erase background)IDTA/NTAHBAUIZHEHITWVELTH AT
ECORBICEESN TG EDEHFORBEDERIEEICEYDSENET,

SRS EE B DIRE DR RIEREDIF—HR—Fa—rAyk (Key Commands)]
DR—=CDOIFEFDOHRE (Note Editing) JIOHATI—IZ, 2 DDFHLLF—HR—K
a—hhyRBERE B NEEZE TIT5 (Decrease Dynamic Intensity) J&TRFSED
B DEEZH LT3 (Increase Dynamic Intensity) JAGBIMESNEL =, BEIDRT
BY INSDITURTIIBEMEBEEDEELTFS (AT mp s p
TIFBHE) FIFHICEFS (fzLxEmp HS mf (ZEIF5) SENTEFET . C
NEDATURF ATEVGEDEBHABESICEEELEFE A,

2oy UV

T4 AT DEIRR: Hra< U RT#ESE (Edit)] » 24248124 (Fingering)l » 12
17T %)k (Reset Fingering) I1ANBMENEL -, CHILBIRLE-E/HH
LbITRTDIAA) T HHIBFRTHEDTY,

EREFCHBEDT«VAHNT: BEF T3 DII40H2Y (Fingering) 10D
R=U(ZHBTLE (Position)IDEILav(, TFEREFCHEDOI«HIVT
DAIE (Position for fingerings on cross-staff chords) 1A 7S arhEH L E
MENFELz, SNIZKY T4V AN T DEEEZLTORERICHET SN, —FL
DERD L. —BTOEEROT. FEAFLEFEAOVLDTIANITRTERET
SMEETEET , CNITKY . EEREF-CHBIZT(VAVIEEET IEDER
MDY, LIRT&Y KIEICM ELET,

EREFCHMBOI«HIVT DOELE (Position for fingerings on cross-
staff chords) N FEREF-CHIEFZHES (Ignore cross-staff chords) L9 D
FT2avONFTNDIRESNTLEEE . BIRLE-BRDIET40A) 0T Hi T
<BDIZIE, FLGEMSh-MEE DR L (On home staff) IO TR/ TAHERT
SNFET . NIEBER DI AT DIMEZ LEETTHILET. BRANERETES:
CHIDLEDERLEICEFERTTEDLNDTY,

ERONBIDTTIVYT: BEBERGEDAVARIIAVNDI4VA) T %,
RO LT TIHGEAAICERE TESLIICRYEL- ERONAICEENT S04
UHIDI KRBT EEHMERIRL, TO/IRFARRILDTI42H Y4 (Fingering)l
DT L—TIZFHLGEMSN-IERDORA (Inside staff) 124 ICLEST. COTA
NTAEFERALTH, BRIBIXERANICRTTEEE A,
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TAHY T [ ELF T DI I42H YUY (Fingering) IO _R—S DT EE
(Position) 1D avIZH AT avIci>TERESN, FEE—FTHARE
T: (j: P%“Jﬁ‘—c‘%f?—o

G)ygR

Uy UROBE: JUvHURIXERND/—rEFERALTEBESNALSITHYEL
fzo BUINBLRSART BTV UROBEFFELYR—SNTOEREAD, F
KHMICIEEESNEFETT . N—TDI=HDEFEIZHNTIE,. JUv YU RFOBE
[CIFBREDN—TRFILETE (N—TRFIJLEENAREIIEESNTUOELGEE L.
FTARTORTIDFFaIIIDEYRRRISLIVICHLINPAREDIKELRGLE
) BRRENFTH. TNUNDA U ARYILAVRTIE, Uy ROBAEIZIFY
AYFVIRT—ILHMERSNET,

TVIBUEONTNADIHDEFNFZATOHENINTNSIES . ChiTRBRENE
T, VYU DRBMEEDE RN DLANTNDEZE ., TV IR EELD D%
AYDREDFEDMNENSFHIRSNET .V 'J“J*ﬂ‘/FOD.‘ﬁ%TﬁLEOD SRS YINSTAY
BNTWBIGEE ., Ty UREZLDDLENAYDRYDFEDMLE TR TLET,

TV URFOBE LORBMEEZ LEZTHICIE. FILGEMSNI-TBIREED
T4 A (Delayed start) IO TANTF4EAUIZLET . ChIZKY,. TV HURDE
ENBRBLR TEOPRMENSHIEINET,, SBICTToLA (Delay)ldFA
INTAEAVICT BE A DEFICHTHEIGEERL T )y U O ERHEGRIAGL
BZEETEET,

PETZAVDEEMEDRE: FZET—FTIE. FHERIZBVLWTHADSI 2D

BEEMBEEMNCAERTELLSICHRYELZ FEOHEATIRNOIMEFALEZRL.
[AII+[ T[] ZHLT. FDSA>DOFALKELTIZF YD LET, [Cirl]

(Windows) #F7=zI& [Command] (Mac) & [Alt] &—#&ICIHSZ5ZET,. —EIT1 R

R—RFOPRFAEBETEET,

PEADTAEFTIOTHE BIRFOBADTAU TN BELES  SHEROH

FASAV2ARDONBLXRFICARTIHEEIE. FTyPTHHNTRTOSAUHS 1

DL LDOHEAERIRLET,

EEDHANERICL >THERDBAKBRMEBENDEFOMBENEETIN-IGE. TD

R EOTEFADA Ty EEBMICHIBREINES,

HEOHBELOEEMEREZHIRTS(CE. TOMBELOBFHASIDODEED
IEAZEEIRLTI%E (Engrave)] » TEREADF Tt vh (Lyric Offsets)] » IERL
=%t vk (Reset Selected Systems)1ZR#IRLET  FFEDEMIL—LK
NDEBEMERABLZHEIRTZICE. IL—LNOTAZENTEHEIRLTIZE

(Engrave)] » TREADA7EYE (Lyric Offsets)] » NERLI=TL—LZEYEYE
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(Reset Selected Frames)Z&IRLET . LAT IV ERD TR TOEEMERE
ZHIBR9 BIZIX. [58F (Engrave)l » TRE DA 7tk (Lyric Offsets)1 » TLAT7
k%t Yk (Reset Layout)1&:&IRLET,

TR DOAE—LREYAT T TEFAEEES LI, FIEFH T EICEYFITHRIENTE
BESHYEL =, 12ERE HER—HILS—FDOTEFEEA AL, AaE—T D EHE
BN (TR (Edit)) » [D4JL5— (Filter)] » THREA (Lyrics)IZ AT HLEE(E
RTEFET) LTHBYYYTR—FIZIE—LT, BlOR—hIL/S—+DIREE DAL
PMEDEFEERL. [Shift]+[L] ZAALTHREARY T —/N—ZRALTHS.,
[CtrI]+[V] (Windows) F1=I& [Command]+[V] (Mac) ZERALTR—RMLFET, B
BELITEEHN 1 DT DYMFITENED T, HEITMHEIZIELT [Space] Fi=(&
-] UNATY) ZIRLTA)RAIEERT 12T TY . BYAHITEITES =IO v T
R—FOABNERESN., TR TOEECTEHINBYFTONEETHREET,

COHREFPEE. BAZFRIUVREZEORFATIAATEZE A

DEFAEHREDT (70T RADKREIFRHELLDGENHYET . RFIEERD
THFRALEYRRMNIEL, FWEHMIFFREMICKELEETHESNSIELBLL
@L\T:&)-G—a-o

PEFRDIATIRAGE DBV DFE R LB EZRITITHRST-OIZ. HaATUFTIRE
(Edit)] » TEREA (Lyrics)l » TREADS A %#mE (Edit Line of Lyrics)1h%EME
NELI, COATURIEAIMEIRSNTVSIBRIZOAENIEY ERICKRIE 1
DOPWANEENTUOVENEHEELEE A EROTFAINBIRSATVDEA. —
BLOBROZMCBNLIPHASMEER KLY FATOTICHANKTINE
Yo MRELGDMEFADNR DM o-15E . [MEFAERE (Edit Lyrics) IOFHRF 470
ThREES,

AT DTHFACITAE—ICIFBREDTIO—DZBTEI71DFALN. IS
[SECTNA T ERR—REHSTRRENET . FAT7OY FEIZE. THRIT
TA3—NORFADHKE. DFADKHEEK. DFYTIA—HNDZDTAVICERIZHFET
SPFADHDZEAHUENKRREINET , CCTIHIMFADEBMEILEIBRE . 3G
DTL—2a DEBLTEFRA (HELEEDTEMAE. A LHEDRIENE
WA L-BEICERETALREFTEED) . FATAT D7 I3V N—TRHBFADT
FRAMAXEEETES-0 ., BROBESLOITLBYET,
TOKIRAUDEHIZGY . TOKIZD ) yY T Hh [Return] WY E&THAT7RYT
FHETEADF. TTA3—HOBFABDRHERHE—HTHEEDHATY . eH
HUEXADICROVEFRENS-O ., HERIC—HTINEINEHERTEET,
SATOTEHETHE BRADTAVEENESBRZIONETS, [Shift]+[L] DRy
TH—N—%FEALTHRAETHETIEELRAKRIC. FAT7OJEHEELI-EERIA
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BREDTONTAAHIBRENET . Chld, EROLETIIHFATHIBRSNBEERS
NTWB=HTY,

FAFF

INTEIDAMER: A EYbN—F [ EE VR EMILDRERFIZESIERARFTO LFE LTI
RRSNDDEHOBFONREERETEEHLIITHRYELZ, FEAF T3 DMk
#F (Rests) IOR—T(ZNIMNRE D 4188 (Bar count appearance) IDA TS arhiEh
L<EMmEh, TEEI+2k (Music font)] TRAFFO/NHEBAIAM (Multi-bar
Rest Bar Count Font)ID 74 b RAAILEFER) £EMFL—2T42k (Plain
font)] TRKFONMHFHATL—>T+2k (Multi-bar Rest Bar Count Plain
Font) 1D T+ b RAA IV EER) 2B IRTEDLIITHYELT,

INTBDBIE: FEFTLavDMHRF (Rests)IDR—U(CTE—DERDARF
HILAVMZBITHIMEHOEE (Placement for bar count on single-staff
instruments) 1DA T av A FHLGEMEN., MO HFORRAUABEEZERD
ETFTOFIMDIIEETESLIICHEYFEL -,

RAFORE: BREMABESICHR<BMHNEBLEENIRATOMBMEIZHS
BE.EBESEIRATFOEINO/NHFORTHREIZCR TSN, ChIZKYEIZIRL
TERFIRDEISN DI EMNELAGEYFELTZ, BRIZ. ZRUSMAIBELNVDNETIZT 47
AODMERENT-IGE . TEDNEARKFAMESNSKIICHYEL-, COLEH
ZFRICKY. . BFEOTOCINDEBRERENEILT HATEEMEITEREL T,

FES—Lay

SEEE—FTODFES— 3> [B/A\—230 D Dorico Tl FES —SavILiEETE
—REBRETFRDELLICBVTL. BB ARICHETATLEDRREDIASIC
EOWTWEL COAKIEEFEE—RTIESEHELET . BEIIBELEET
DEERENEL BIRFAROENLZ NV OTT ERALFEE—FTIE. 1 DOFHF
DHRIZFE, FED L, BRERS . TREEEMNDERFRAVDOLEELE
IH. BREE—FTERALERNKYREZLGEHEELZRHFD 1 DFETOBEIRFRIZEY
FT.COAXDER. BHEE—FTIEEDTATLMNBIRSNSZHDDFRIHELL,
PUYEBELFEE RIEBRLETATLNERSN GV LB LLBYFE R ATL,
MEE—FTOXRNF—2FERATEIFES—2avaLYRERETFRALLTVEDIC
957182, Dorico 3 TIEZDAIEICEITHHBEMNEEINELT =,

EXRAX, CEE—FTIIEEZOMDTA T LTI, BFICKEZIFTES—
AVAEENDIETT  -T, EFERRLIKET,

=[] D[] EANTEE ALEBORMEITRODBEFIAERINET
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= [T1A[] ZANTEE RLERICEFRVONIE ERPOEFFII—FELNE
TOEFNBRSNFITH. GVGEEFELETOERICEBBLET . EOERICHE
I 555, TOMETHIBELFIREET NS —BEVEFFNERSN, TOE
RICHBIDHER. —BSVEAVBERSNTT . ERAVEVNEE IXKRFAER
ShET,

= [Ctrl]+[«] (Windows) A [Command]+[<] (Mac). E71=(& [Ctrl]+[—] (Windows)
M [Command]+[—] (Mac) ZANT5HE. MEDERDAIEILRD/NETD
IRMIEICEEILET .

= [Ctrl]+[ T] (Windows) A [Command]+[ T] (Mac). E7=I& [Ctrl]+[ | ] (Windows)
M [Command]+[ 1] (Mac) ZANT 5L BEDHEBEO—FBLOERT-IE—
BETDRRICHELET,

thDBEIED T AT LZEERT HICIE, [Tab] ZA KT SH [Shift]+[Tab] ZAALT.
REDQMEMNOHIRAMIZ, BRDDERDET 2EDMDT AT LISEREDY
BAET . E00AMICEYIYEBERZTHo>TEH, BREIVIThEZDERDLEDM
ENERELRFARFICR-TEFES . ERTURFTTILEVTATLEERLTLS
EEE [<] I [2] ZAATHERERDELEATDT AT LEEIRTEET . Ch
[FRYRWEEREEB BT HEESITERITT  [Tab] Ff=I& [Shift]+[Tab] ZERALT
HERICB T A7 AT L (TUR UN—TFILT—Y 2—REELRE) ITBEREUVE
ABEFTEFEAN BRICET DT ATLERIRLEGDDS [«] N[ ZEANT
BEICKY RLAMTDRIEDT AT LERIRTHZEETEET,

[B/8—23> M Dorico Tl&. [Tab] & [Shift]+[Tab] (XET#& D /MR~ DFEEZ{F
AEInFLE. COBEICRTDOR. REZEDIF—HR—FPa—kravk (Key
Commands)IDR—U M fTHRFET, EIREFES —a> (Selection and
Navigation) J®HTI)—T. TRO/NHHRIZFTE S —bF (Navigate to the Next
Barline)]IZ [Tab] #. TRID/NEHRIZFE S —bF (Navigate to the Previous
Barline)lIZ [Shift]+[Tab] ZE|YHTAHIENTEE T, ZOMDERIZETH7 A
TLIZERREZGYEZD 2 DOFRMATUREIRS IV DRDT AT LIZHEE
(Navigate to Next Item at Position) J&TRO IV DRID T AT LIZHEE)
(Navigate to Previous Item at Position)] T 56 . Ch(ZEh Y &4 5 F
DX —HR—Fa—rvrEEIVETEHIENTEFET,

BEHDODAN

BHOERADEFOAN: FYLyrEEHOERICHIIL T, EHDOERICE
BRICANTEDESIZHYELz, FYLybERERS, [Shift]+[ 1] ZANTDHEFY
LybD EDFERIZEHY, [Shift]+[ | | ZANTHEFVYL YD TORERIZHEUET,

CHIIHFIZ MIDI F—R—FTANT DB EIERNTY  EAL 4 KDHRILOD
ERICHEVYLYNELITTHR—R—FT 4 EO0LHMBTEREEIT HE. FrLvbn
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WU 4 DOWRIT 4 OEHHEHMIEY RSN ET

BELELBREIRTOERICEVIRSADTIE AL TNENDERICRAKRICT AR
THOEFEAANTEIEEIE. EFAAFTSI>OIMIDI AA (MIDI Input) IOR—
DTIF YLy BN EROERIZELASHEEERSA-a0—F (Chord played
when caret spans multiple staves)IZI ZENENDERICTRTOEFZEZAN
(Input all notes on each staff)JIZERELET

FLRAS— BRBESPLTOMDEETEL. TNETNDORYTA—/N\—%FEHT L8
HEOHET, FvLYMBEU-ITRTOERICANTEET,
FTOET7/DERIZF LY EBRIELIZGE. ERPEDLSIZEIYIRSEN DM
(X, BEREDIELE (Play)lDR—SDIRF)bE1THES MIDI /—RES (Split
at MIDI note number) IOEIZHELNET S

EMOER: N585 (Write)] » TTaL—3a %R (Edit Duration) JIDH T A=a
—IZ. TROBEHETEER (Extend to Next Note) |EMBIREFMOKRIGFETER
(Extend to End of Selection)® 2 DOFE AT BMESNFELT =,

» ROBHFETEER (Extend to Next Note) Il BIRPDYXLEER DS (&
HERLUN) TRTZNREZEZA . RLESBICROERLHIIGEIEZTOMEE
HELT. EFHOMREEHIHTEREZERLET,

» NBIRGEADOKIEETER (Extend to End of Selection) (. BRLE=-ZHDS
Lb—BEREIDMNEICHAIBFICOAMBESZAFET . CNITEHLYDEIRMEF
CTEREERISRICNEE—rZ2EATLHO. EREGEENORICERICET
BEFIE. ERINE-EFIZI—23NET,

Talb—a DOy Y EEMER. FYLYMEMBEROMEICHAEEITaL

—3av%Av?% (Lock Duration)] (MHAZREDF—HR—Fa—rhvbklLl) 24>

2L FYLIMDRDYRXLEFE ODOEFDOMEICED D TIEEL, BLLAEIZE

EFBLSIZHYELT =,

MIDI T/ R: BB D MIDI AAT/3A ADEGE(IUIRERETES LIS

HYELE=, ChIZE->T, AKX MIDI F—HR—KZ$#E#L1-#IZ Dorico =HEiE
BT ADELLELIGEYELT=,

MIDI =22 T: EROADLUNDIKRT MIDI F—R—FTERZEET 515
& REITHERTEAURARYILACDYIURD, FEITRIRLIZERIZEDNT
EBEINDLIIHBYEL - ABEICERT A YV REERTHICE. FEDOY OV
FEERTIER EDEHIEERLES,

MIDI RJL—: BEHTF—HR—FE#FERALTWAES. £-dF—HR—FZDEFR
[CEHELTWRIEE (FEAIFREAVR7O—2FE—F® Ivory DAV A4S X)), MIDI
F—R—RTERETHEEIO—/\VIINEI T IR TR ELRGEENHYVET IRIE
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BREDIEE (Play)JOR—(ZIMIDI thru Z8 =93 (Enable MIDI thru)J®
FTLarhFHLGEMEN  CNIFEARE THUITE>TWET  ChEd TITT
5&.MIDI F—HR—FTEZELEFEHE Dorico ETRTa—\voEshFEA,

MIDI 79T AETAAo P —8— Az o4 RO DETAIZ MIDI 7HT74E
TAA T —a—FHLGEMENELTZ, Dorico H' MIDI T—4%%2{59 5L, Ch
N—ERBICARBLET . 10O —4—DBGEMICRBICETTHI5E1F,. aVE
A—F—IZEHFEIN TS 1 DULEDN—F Iz 7EIEYTEILT7 MIDI T/A(R
A Dorico IZT—2%KEISEYVAATWNSIEEZEKRT S0, MBEDRRAELS
TINAREHELTORATLNCHRTZLENHYET,

*IoF

INETIRDEESR: BEF T3> OTINGR Barlines) IOR—S DAY T
(Ossias)IDEILavIT (YT EAD RS ILAV DS 1 DUNELEE D /N
B%&## 4 (Join ossia with systemic barline for systems with only one
instrument) IOF T avhBMENELz, IR ETIX,. ShITFHRITODH
FTIEA ZIZHE>TOET A, B3 TR SN 2T 0D Vb TIEA V12745 T
WEFT AVARYILAUE L DDASVEER 1 DTEBRSNAHEERTIE. RN
BQINEHRD AV TIHEEINGO AN B ERLGINEIEND, DA T3y
L ONEITDSMITEYELE,

R—=ULAT7 Ik
MiHRIZ (BEAM): EREMBREETEIL—LDBIICEHOELHIZEEAM
DEIHNIAZRITT AEDHEAENBEEINEL - HIT. TIL—LO HEEMN
EROADOMIGHIAZRITTHLENMEL, ERLMMBEOMADOEIRRAETETT
BHLEMELDREIZHAERHEN-BE . REDEHREIZENTIE. thDFEREDE
BEDBITBOITTRLEAR—ZADH AL DHLT | BROLTITREHL
=7 ATLDEDELEERRIITEIHEENHYELID . CONENLYEES
N TITHHhEKIITEYFEL,
NIZKY . BEIL—LICERDOEERAHHLAT LTI EELROEIHRIZ D
HERHIBN—230 D Dorico MoZEAL T HAIREMENHAHZEITEREL T ZEWL L
MLIEE (Engrave)] » TERDRAR—I DY (Staff Spacing)l » TLL4 7o+ %&1)
bk (Reset Layout)1Z{#EAL T, IB/A—Ca OMinRiZ EREMHS-HIZ1T4
S-FfRIAZZHIBRL TANIE, HLOMERERERDOADIEEINIIFELLED
THAHEITMIITEDTLED,
IL—LDEEEDAVOT—F—: FEE—FRTERODAR=S2GY—ILHTY
TATDEE, BBEREIL—LDOTEHIZ. IL—LDEEREN—EUIRTT D5
HABYELFLGEMESNhELT-,
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ERDNODBE: BERZTOMDTATLEZRLTHS [Pl ZANLTHELRMBT
556 EBIRHROMEICOVTOBREEINEFSN. L DDAURRYIILAVRT
R EICHIEBDT AT LIERINTNSIEETEH. TRTDIURRYILAY
EABESNDLIITAEYELIz, DFEY., LA FBB->T/—FERS—FRIBFITER
LT [P] ZAALEGETH, TORERETTIIELT oYU TILVEENBESINE
ER

AR/ =LG)9T: IZNSVRAR=DT7) YT (Click)IRE2Z0 )y 7T 50\ R
BHRFEDF—HR—Fa—rAvk (Key Commands)IDR—SDIFLE (Play) 1
ATII—IZFLGEMEN=TO)yOZEFERITT S (Enable Click) Ja< 2 FIZEY
LBToNFZARELDF—HR—Ra—rhybEANTEHILET. BERTEANA/—
LDV IDAVEIEATENYBZONDEIITRYFELT-,

16 A EF DAY Dorico TIEM16 R EHFDR 42T 1D X2y 74—)LA
YIR—hSNFEL =, ThiE 8 B EMTIHGEL 16 FEFNRVAVTFTHLEDTY

AEINhTz 16 RERDRI4VT D) XZVIT4—ILOVTAhETASTID

TIHNEDYRZIVIT4—)LELTEIRT BICE. BEA T avnl 34307

(Timing)IOR—C DI FI4ILEDY XIYYT4—)L (Default rhythmic feel) IDOF

AyTEa UM BN T —ILEEIRLET,

RED/\vE—TIC 16 DEFRDRA V4T DIXZIHNIT4—ILENT W ERER

FBIZIE, [Shift]+[T] DRYTAH—/\—%BEALT, fz&Z [ETMedium swing 16ths]
ERYTA—IN—ICANTBHE. 16 REFDITAT LRIV TNBIRENFET,

Fr.BEATLIvDIZ343045 (Timing) 1IOR—SDIYXIvyoI740—)L
(Rhythmic Feel) 1M+t 3> TIHRE (Edit) 129y oL TF7 oA TESLMN) XY
974—IVERE (Edit Rhythmic Feels) IO A 7R Tlk, BESh TS XS
VP T4—ILDIREOFIR I —ILDERIITHERAET

HADES: BEA T aVDIEHIES (Dynamics) I OR—J(HHTHADES
(Beat stress)IDA T avMNEEHRPCEHEFICETHADY IL—TILE LYE]
[CRMFTDESIZHESN, BIENT=2 DDA T avIcky ., MO TINEFE=IZZF
DDIEDT IL—TIIZETS 1 AHERBEDANR RSN D KSICHYELE=,

TRBIINDBE: 5 REFIETVIFDORTIATICANSh-BBESHIE
EICRMENDEIICHYEL, BRICRM T HEBREEEHEET HITHzoTIE.
FTXVNEEBAT HE L DITEIFICRESNI-ERBREZHAMY . RVT 5 R
EFERETIVIFDRRIMTICLORRINGVRBIESTEI—ILET ., ChiTE
Y. RS LEYROA—T RS DITERFYMNIERBREZEMTI2OMNEEICFEE
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[TRYELT=,
IVRRAUEDOFHEY LT BEBEETTL—b (Dorico AEEIMIZH I RE
FAHRADTUTL—, EEMIZIE HALion Sonic SE F7=[d NotePerformer Z{#
RAT5T70TL—b) 2ERATH5E8. BEE—FTAIVRMIILAVRDIVRKRAUE
DEY B TEFETHAES HL, Dorico [FTADIMIBMENIZFHLLA D X by
WAV Y IURDBEGRARAAERELET [AN—2a0TREVETEZER
THE TNUBROYIUROBEFREARAADNTRTEMESNTOEL Rz, IBIC,
TB&E (Play)l » IRBIEDAU AR ILAVKZY I FZEO—F (Load Sounds for
Unassigned Instruments)1%:&IiRT5&. TDRDBY DREEENERITINET,
BHEIURRAUPEY S TOHRNAV R AV HDIHEE . FTLLEY HTH
BESN . BUGYIURDRARENET

VST A2 RRYILAVCDEZRIZER: TZVRFRAURDERE (Endpoint Setup) 1D
A7B7IZTZRT (Name)IDT4—ILEDBFHLGEMENFEL Z, COF AT ZME
VHTICIE. BEE—F®D VST AV RMLAVMSRILTHED TSI/ DEET
AaAVFEDI)IILET  ANALE=RTRINE, VST AV ARG ARSIV ES X H—D
mAICRREINDLSIHYET,

VST AV ARSI AU REB ST BEE—FD VST AV RARYILAURSRILDE
TSTAVIZIZBEN TN, TST AV D1V RIRFHIE, LML=
RILBESNRRINDESITHEYEL e RIDAVARIIAVNTZT A DESIE
BEN021TY , INIFANO/—LD V) yIIZERSNS DoricoBeep 735542 D
BEEMNEEILITHS=HTT . BEICE. ThETNDTSTAUEXAILTHEAIL
PILFTEILEUNDEKEIEHYE R A FNRILADT ST AU FHREZTE
Tt A,

FELILEWL VST 41U RRYILAVR: FIBTELRL VST AV RRYILAVNETOD TS
FASEBLTWSAIES. BEE—KR®D VST AV RRYILAVRARILIZEELGZWNTS
A DEEN., LRINBREF THEN-IRETRTINET, fi: ! Kontakt !1]

BETUIL—EER BEFETYIL—D 1 D (RED HSSE+HSO (Pro)
BETUTIL—MEE) MEAINDE B1UARYILAURIDULNT HALion Sonic
SE DEAVABVAIZGRAREND Y IURE, AV RRYIILAVFDERIETIERL
AA7IBICEHRARAFENFT

N—=hviarvTeE8®: TBE (Play)l » [/—hvyiar3yT (Percussion
Maps)1D7 a3 /\—IZTHES (Duplicate) IR A FLBIMEN , BEFD/3—
HvarTyTEBRLTHLWLAA—Dy 3oty T DOR—RITTESLSITHYEL
T=o
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ENRIE—F

ENRIZLE 2—TD#E:: [Home] E1=I% [End] ZRI LT, HIRITLE 2—DF
PR —TUFEERBER—VICEEBB TELLIITAYFEL, BSF—HR—F3
—rOVrEFERTIEER. BREREDIF—FR—Fa—Frhvk (Key
Commands)|DR—OTERI (Print)1OATI)—I2H5. THIRFLE 2 —0OF
3 R— (Print Preview First Page) 18 &UTHIRIFLE 2a—DHJER— (Print
Preview Last Page)IDaIYURIZH T HMED S I— IV ERTEET .

JooMMER

IFoozHMER (Project Info)IDF A 7O MNKIBIZHEYESH, E—FLRIZH
YEL: (REBFOERIFF47OTZMAW-FELER (Apply)1x )y L TER
FTHET EXRERANVEFRICTEFEY ) X REE—FDTO—/IRILD
WREZFTRE G EHE TR T 5L, BIRDPOEHDOIO—DIERZRFFICEET
EHEITTBHHTY,

20— Rk 7P HMER (Project Info) IDA A 7RS E/DOZ7O0—1) XTI,
BHOIO—HLUVTOD I DLDEREFICERNTEET , BRI, [Shift]
LA LY voX0, [Ctrl] ZLEMNSYvY (Windows) Fiz[E [Command]
LGNS0 vY (Mac) BMERATEERET, JALDZBIRARIZRL., TOawN
—DRIVDEMEEDNUNYBEDLYET,

= [JO—%3EM (Add Flow)l[ZEIZEZTI .

» [oO—%%EH (Duplicate Flow)Jl&. I7a¥xIk (Project) st ® 70— 1 D
NEBEIRSNTNDEFEHITHBYET,

» [JO—&%FZEE (Rename Flow)]lE, IFRZ Ik (Project) 1t d70— 1 D
MNEREIN TS EEMIZRYET,

» [ E~BE) (Move Up)J/IT FAE) (Move Down)]l&, 1 DU EDT7O—AGEIRE
NTWBEEEDIZHYFETH, IFaSIk (Project) INBIRSNTLDIEEIE
ADNHYFEEA VAMNDRYIOI7O—%RIRT 5L (RYO7O0—-FFOPx
Ik (Project) kY LIZIEBENTELLV=8) [ EARE) (Move Up)IHESIZREY.,
JRAFAD®REDTIO—%ERTHETTAEE (Move Down) 1D ENIZHEYVET,

» [JO—%HIB (Delete Flow) L. TIFAS Ik (Project) ]S D 70—A 1 DL
EBIRSWTWBERMIZHRYVET,

70—%3:BM (Add Flow)1Z9)vo3 5L, 70— ALDREIZHEIO—HE
EhFET, ZO70—(ZFERIFFETEETTH, 70—B&KIEXNER (Apply)lZEY
JyHLTIELO TERENE T,

7O0—%4#8 (Duplicate Flow)&9)vo 4 5L, 70— XA TCERFOT7O—
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DHIFRIO—ABMENET

[JO0—£%ZEE (Rename Flow)|Z#7Uvod 5E, 7O—IZHLWNRARIZIEETE
BUUTIWHBE—FNEIATATNRREINET , JO—BARDERFTE. HA 470
S cl#ERA (Apply)1&2)voI L TIEILOHTERSNET,

[ EIC#E) (Move Up)lE =(EIFICEE) (Move Down)1&/)woLiz&EEIRL
70— EHELTWVEWES, 70—[FFLHon, 7O0—JRMRELTIZOED
EFYTBELES, COTH, 70—RLETOCIHNADTIA—DIEFEEERT
SEBOEEL. IERA (Apply) &2 yILTIZLO TEITSNET .

70—%HIER (Delete Flow)1&x2)v9 4 5L70—E3CIZYRMGHEIBRENE
A J0—DEEIEXHER (Apply) &2y ILTIELH TEITENFT,

BHOIO—DERELEE:. F4705 OEROTO—)RTIE, EHEEH R
[SEIRTEFT . GRID T —ILRAEHF SN, 70—[T (FAPTHIF (Project))
NERSNTVWBHEFTACIMERBEAFRLEAT) HBEOEIRTINET,
HBOME. 2FYBRFOIRTHOI7O0—/7OC Y TRICIE, 328 T5T71—
IWRIZRRSINFET , CNICIEFREBELZLEEEBELTHRON, COFEET—ILE
FEICHYFET . ERLE-70—/TOD I METRLESEIE. T—ILRIZRETF
AREYHIR (Mixed) INRFREINET , CORBTIRANELEETTSHE BIRGD
ITRTOI7A—/TAPIIMNIMELXRETEET .

4707 ORAICH I ROEE, SIEHREIE— (Copy info from)lOFOYS
A UEERTAHIETEH. 1 D2O7A—FLFTASI I LRIRPDTRTHT
A—[J{EZIE—TEFET, COURNMIF. ZROTO—) A TERSN TR D
A— (FETADVbBR) OADRRTINSH. TXATOTEERTSL. FO
wITH 9 EMaE— (Copy) IRFVIEEMICHEYET, kA TAHohbT7a—F] -
ZTATIMEERLTIOE— (Copy) &2y 6E CCTERL-DA—/T
ADIIDT RTOEL, YANTEIRPOITRTOIA—TERASNES,

EEZER: @A (Apply)1&29)vo3 5L (F1=IXTEACS (Close)1z2) v LT
RIRINDAVE—VRYIRATERBAZERT HL). REFOITRTOEEN
BHINET, ChoDHmED—EB. 7O —DEM, FEL, HIFRFEETHEREZ
[ZDWTIE, KIRBELZ RO T TIXUEE R Z SF THELINDIZEELHYET,
BEAT7ATERRENELADN BERTHIEEDS—H—VILBRTEINFET,

FLOWIERE DX —R—FIa—rhybk: TI74)L (File)l » TFASHMER
(Project Info) 112, #1#AERE D F—HR—Fa—bhvb [Ctri]+[1] (Windows) Ff=(&
[Command]+[] (Mac) S BMmEhELT=,

FERSAIL
BRAEBROBEMT: BELF T30 DRI (Staff Labels) IOR—I (2T
FANERLLIELUDAVAY LAV LD ES 1T (Numbering for similar
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instruments with different transpositions) 17 7L avEHLGEMEShELT=,
AR EEXIBMBEIZH->TEBFH+9 S (Number separately)] T, Dorico Tl&
INDEETEDONET FEXERILY inF 1.2 &KLY in D 1.2 (FRIEICES
FFENFET L5 1 DOBRTEERFRT—HEICHZSTESFIFT S (Number
together)1TY, ChlEf=EX(ERILY inF A 2 KEFRILY in D M 2 KHBiHE.

ALV inFL2 &KLY inD 3.4 12HYFET,

TUR

TUORDENX: SEIFLBEOFHRG/NEHRISHTETOROEXDKEMLE
WEINFELI,

TURDIa—b: BIRLI-TURTIEBEZWH (Suppress playback)1®D 7 0/3F
4 (IB/A—23>® Dorico TlEISa—bk (Muted)1EFEIENTULVELE:) 421255
EZDTURITBEICHELLGBYETS,

THAR

F—ooDAVTHFAMAZLI—: FFANIL—LDTHFRNITAE—RNTHY VY
5L AVTFRRMZA—MNRREIN, hTTY—bShizY TAZa—RIT(>T
VY RFIFEINTVVENFT RTOR—IY (XL {@flowstitle@} &, 70—&F
BEFERATIBEDLIN—IY) BNYRMRTRENET, A=a—hbb—I % RER
T5E ITAE—DBREDH—YIEIBIZF—IU N EAShET,

rFaozyrE# (Project Info)l, I78—1&# (Flow Info)l. TR¥ED B f+
(Current Date) ], ALz IO R#ER (Project Save Date) |, [R— (Pages) |
(R=UHHURNR—=UFE), TFEEESE (Music Symbols)IDHITAZ1—mEE
ENBEELIT TDOMBEZ GV AZ 1 —TEITEMEINET,

FBED BT (Current Date) 18 &N 7O H/FDRER (Project Save Date)]
DY TAZa—IZIRDLNDBERNEBFD—I Ik, BASRATIEGL &h—2
COEBORTHERERLTVWET, TR IMDRTER (Project Save Date)]
DAZa1—I2H, BAD BRA/BLUNRREINET , TIL—LIZERIZR TSNS H
R TIEEN S EITFRL TS,

BRIEBDM oV #HLEMEhI-F—Y Y {@flat@}. {@natural@} LU
{@sharp@} ZFALT. TFAMNIL—LDTFAMITSVM, TF1S5ILELUVY
v—JRESEEMTEDSLIICHYEL EEDORTTIH. ChoD—o2FTEH
ETX X (Music text) IOXFREA )L (#1HEZE TI& Bravura Text Z{E ) 12X
MEn T, BULGRKLESAEASNEY . I—FRAVNEM V2V ELTHEET S
Z&IZkY ., LWHVED SMUFL B BB BATEE T, 12& 21 {QU+E0S0@} TIXME
SEENMEASNET, SMUFL SESDIEEITHELZI—FRAUMNIZZESRBL T
T=&0N: https://w3c.github.io/smufl/gitbook/
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CNoBEEBSDOMIUEF, TOCIIMEBDT4—ILRICEANTEE T F2EX
(XTRALRIL (Title) IO 74— ILRIZTSymphony in B{@flat@} majorjEA AT NIE,
FSymphony in B b major]&ELVHERMNFEONAEIITLHYELT-,

HRINILDR—Y: {@staffLabelsFull@} & {@staffLabelsShort@} M k—%
UHFHLGEMEN, THFRNIL—LIZREDLATIMADTL—Y—DERIA
WEBRATEDLIICHYELZ, SNED—IVIZE>TEBIZR RSN EIL.
EROEAICRREINZIERINILVEIFEEIC—BLBEWMEENHYET . LA
TorAToarnlgER LM (Staves and Systems)IDR—IIZHDBHADE
RAZEDERATLAVIERBENTOET . CNODFHLLN—I2(F, /38—~ oA
TIORDRADR—CDELABIZKRREINDIAVARYIAV L EHTAT S
{@layoutName@} DM HOYICFERATLIEERALGEELHLIEEZONET,

ZETIXAMBED a—thvh: TEXRAMEERIZ. KXF. RABIUTROREA
IWEHR—rTZI742 0 THNIE, [Ctr]+[B]. [Ctrl]+[1]. [Ctrl]+[U] (Windows) &
f=I& [Command]+[B]. [Command]+[l]. [Command]+[U] (Mac) ZFERd 5=
TREANEGYBEZONDRIIZGYELT=,

BFHELBEWIAVEDE (704 Dorico D7ACTHMTIE, FRAIAVMIKIEL B
HNEZONTWET, LALTADIMERA—F—(TEELRZY. BloavEa
—A—THWYTIEE. 7O TCHERSNTWS I+ ZDaVE1—4
—IHFEETHIDON. ChETIIERTIHFENHYFERATL

ZhlE Windows A5 macOS [27AC I EBEILE-Y. TIZRLEY T 354812
HICRAB LG SATREME A HYE T, Windows TIE, 4+ b 4 DDIEERZA )L
(B, fHUA. KF. KFHRHK) LHVERATERW O, RSNz A DT+
VHMIEBEERDTFI)—IZRY ., =& Z LT Minion Pro Condensed Regular | (&
Windows TIXERI DT 7)) —IZ12YE T, —7F macOS TI&. I'Minion Proj 273!
—DITAMNRAALILD 1 FEELTICondensed INEENFET,

SV -EDFEHEEALNITI=-HIZ. BERTEDI£#& (General) JDR—
DIZHBIIT7AIV (Files) 1o avIz, [CHDAVEA—EF—IZTAV AP—LENTLY
BWIAIRTADCIMERASNTINSEZIEEE TS (Warn when projects
use fonts not installed on this computer) IOZF T arhFHLGBMENELT -,
CNIFFHARE TAH VIO TLET,

COFTavhFoDEEF, T7MINDHEARAAFICTADIINADT RTDT
AVRRBAI ISSTSTREALIN  XFREIA VB LUVTHFRMM R F IS
N, AVEL—F—ITHRELLBVNI AR I7I—ERBAILHSREINTLVGELDE
IMHFEREINET,

TSz OMRADT AT LEETFRAMMAVIERT 574+ bEIETHFRRR
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BAINZ S RTLEICIEEWIAVNEFERTHE0H 1 DULFAET LTS
NIGE . TNTNDITA R TFI)—ER IV E . TNESBT I T14T4—/
TATLDIATELLITYRANT YT T B ATATNRRSINET, TOKI1 &9vy
THETTTADOMERKIENTEEIN. OB EMIERIXITHhNT . J0
CrOMERIZEWEEZICHRLEENRTINET,

REITAUEIEETDICIE. TRETI7I)— (Replacement Family)1&#2')voL
TIAM A2 —FFEFET . EIRT T4 I7I ) — B DORVDBEXFEA AL
TREREEZRYAHAFT BRID T+ I73)—%FBINT 5L RAMIVEERTEFE
T (RAAILEERLEGED =B EIEIRegular IO A b EERATRERLINE
ERE

1 DUEDRBEIAURD7I—EBRLTHBIOKIZY Yy 5HE. TRV I
AR DBRIZZEBTEITATLNEHEIN KB T7I—LR2MIVESRT D
FINBYET, COHETODIUMRET HE EENKANICRESNET . &
FECHTODIMETDA—HF—ITRELIZBE. TO1I—Y—DPATLTYH
[FELENIAUF (Missing Fonts) IDA A 7RI NRRSNDETRESILIEEICE
HYET,

rJIL

FENER: MILARE 2 EOBREZRHLISHEL. MMEREERTIGST . &
BARLI-VUDIGAIZOHERTRICSNEILSICHYELT:,

FRERE BoNKRT. N—TTERTLHNILOBREEER 2 ETIEG<ER 3
ELLTRETIENDELLGDEENHYET . TFJILDOEFE (Trill interval) ]
DTONRTATIE, EFEREERTEDLSIIHYELZ RENHDIEEIETE
ALz,

VST THRFLyiarv<eyr/

M LAELEREGE VST TR TLyiar ey Tl MM LEVESREZED T L
—JEERTEDIIIHYEL =, DFEYERBEZBIRT L. BRICHEMITHST
WHEREEDSL MU LEVVERBEORILY IL—TI2H DL DIF TN TER
ROSHIBRENET HIELT. FEAEDRBAVARIILAVNES VT ILIA4TS
)—TlE (EBDI2—T v VITIFETEESBODNELNELAD), SRERDE
E % pizzicato ) &larcol(FMILLERF A, 2FY. IBTIEILKE LB TEIKE LR
FFICIZHEEFE R A BRRIZ. N\—FVILEEH T TSN EXBRDIEE.
IN—RZa—bONT YA — MR ESESFLBEOI A — M EFICIERTE
FH A

IB/N—23> D Dorico Tl&. SO K% —MHIGET —AADRLEL T, MHAFET
WMDY VT VEEILEVERBED T IL—T N ERAESN TOELD, BRE
(ZTBE (Play)l » TTORTL Y32y T (Expression Maps)IDH A 7045 TH

111 R—2 Steinberg Media Technologies GmbH



Dorico 3 /\—L a3V ERE

@ steinberg

NOFLNDTN—TEERTELLIIAYFEL -, TRILLEVERBEDT L—T
(Mutual Exclusion Groups)i®Dt49 3> TlE, ZAIZIEZEIRFD VST THRT
Lwiar Iy FICE RSN TWSHEILLELEREED T IL—T D YRR TEIN,
BRICEZDT L—TICEEFNLERTRED) AR RENET,
FRITIL—T#EBMTBIZE. EAOTHILEWEREZEDS L—F (Mutual
Exclusion Groups)IDYARDTIZHDT I avN\—DI+ 1IR3 &20)vo0.
BWION—TICEBEORREMNTET . VIL—TIEEREFEBMT SIZIE. HED
ROBEEHZEEED (Has techniques) IDYRRD TFIZHBT I3/ A—DI+]
REVEI)YHIL, RIRSNDEATATHLEMT BEEEEEEIRLET, [Cirl]
LA S2Y Y (Windows) Ff=[& [Command] #BLAMNSHYYY (Mac) &
FERYLHE. ERDBERTEERIRTEEY,

FE2DBERE —HOYUTILIA4TF)—TlE Y ATV EBDEBLAILD
HEZ, MIDI I T4=ZaF7 RAAVIA—5—&/— O TA—DEAZFEALET,
B4 (Play)) » TTH9RFLvyar<yT (Expression Maps) | DFA 7O (1§
2 M®FPFEHFHEA (Use secondary dynamic) DA TavmFHLEMEN, &
VST THRTLwLavIv T IS BMDBEERBEAN=XLEERTELSSITHYE
L=,

VST THRTLyarIvTDFroRIVDER: —EOHTILS4TS)—TIL,
TILFTAVIN— VST AVRRYILAVRD R R DAOYMEF[EF o RILIZFTRAHA
FNBRNRDNYFICIE, BLESHERHES LUV T —TaFaLl—2avhahnT
BRELFET, INOTRTOEREEICTIEATES VST THVRTLyarwyd
FERT A-OIC. BEDERREICUVBZLIBRICDLELLLIFYORIILERE
HEHELAAXHEDTAMNSIEE TED&IITHYEL,

HEXMEICEDF YU RIILEERTIE, FRTHERRENNOLNTNS/NNYFDE
BROFYyoRIVBEESEEETILENHYET . A EICEISFroRILEELZE
MBIz TTHRFLyL 3y (Expression Maps)I1DF 47045 DOIEE
RZE (Actions)1DEIL 3> DT HavN—IZHAIAbs Chax D) ILET,

HHEIZKDF YU RILERTIK. BEDFYURILE BRTIVZVINRDLN

2\ FHRHEIF o RILEDRBDEDDIBENKROONES , Fz&£A L. Tpizz. 1D

BEBESRDFYoRIICHIETNIE, CNITHEETLICKEIERLLVET,
lcol legno | DERFENRDRDF Yo R IVIZHBIGE . CNIEHEXHE21(2&D

ERICHEVET  BRHBEICKDFroRIILERZEBMT HICIE. [THVRTLyiay

Iv7 (Expression Maps) D5 4705 OIEMEAR (Actions)1DtH2 3> D7

923 N—IZHBIRel. Ch.1Z20)vILET,

A—HF—( i8—D1—R

NBDRER: —EREAVISRMEEDIOIT F—IT—EFINT—DTH
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AN AEINE LTz, F —VT—TlE. macOS 10.14 LIEDF —UE—FETE
[CEDLET. ITRTDFAT7ATIZAATOAC IR I4 VR LRBHEDRNE S L
BHBWNTFRMEFEATEELSICHRYEL , SHITFATAT ETLUR DDA
—2H A =T —ERBIIT VLN BENERINET,

EEERIRE: BREMNRBRESEY IL—TIESh - BB S E&IRLIEE,
oSN W—TRITHO T AT LNELET I EERT=HIZERINENS
— WD LEER S EEBIC, BFEICERSINSAS—ICDLTIE, AV SR &Y R
EITEDAIDITHBAESINEL-,

[TICRY 1ETBEST): THRE (Edit)] » TRITREY (Undo) 1 ETEZRAT (Redo) I 4
Za—IHBIC, RICRENSFEBERTEINIBEDLRINRIRIEINSLIITHY
FL1=,

AVAR—=NEFAEUR

Dorico Pro % Dorico Elements &7=zI& Dorico LE &LT34T: Dorico Pro D51t
D REFBIEHS . Dorico Elements EfzI& Dorico LE D#IR{FETTZ I r—3
VEERTTAGEE BEDF—FZRLENST I r—a 28T 5 ETINEE
TTEET, [Alt] #HLAEAST=E Dorico Elements &L T, [Ctrl] (Windows) F7=
(¥ [Command] (Mac) Z#L7igAN512& Dorico LE &L TREILET .
AVTIYA Y AN—F—: Dorico DAV A—JLIZHEESNDZDIE 2 DD/v7r—
DDHERYFELT=, ENLGIE Dorico 7TV r—av AV A—5—8k & EIRL
f=s3\—3> (Dorico Pro, Dorico Elements, F7=zI& Dorico LE) (I &9 52T
IALVAN—F—DHTY , AV TYA Y A—F—IZI& HALion Sonic SE 3.2 &
U HALion Sonic SE ®77Vk)—av T YMEENTLVET, Dorico Elements
LU Dorico Pro M54 . Soundiron Olympus Micro A—35 AU R EBMNTE
EFNTLVET, Dorico Pro M, HALion Symphonic Orchestra @27 V4380
TEFENFEY,

Dorico DO TD AV AL—ILH, [BIN—=230 5D T v 7T T—khH ., Dorico
Elements m5 Dorico Pro ~D7y7 4 L—F MR BYGTRTOI T
Y& HALion Sonic SE BN IEELLA VR —ILEND K5I, BitShizar Ty
VAV AN—5—%FRTTHEEETITOLET,

HMRESM R BIMRES AR (L2 1E 30 BREIDOEARS Ao RXE -
(& 1 &8 D Dorico Pro 365 514t X) ZFEALTWSIGEE. S/ XADOEHEAR
[&lDorico [Z2LVT (About Dorico) IDI 1K™ (Windows TIEIAJLT (Help)l
A=a2—H. Mac Tl&lDoricoJA=a2—WK) TWWDOTHHERTESLIITHYEL=,
FAEU AN EARIRE THAHHE . AMHAREIETEY BRL V1D TRIZRT
ENFT, FM VAN EIRTHAEE . EHHRBERIIRTSINEE A,
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0S OHYR—k
74 )LEHIBR: Dorico BNEENMRTF. N\ I TvI IOV UM F—R—Ka—thy
MeEZHIBRT HEE LD T7AILIET R THRRIBREN D TIIEL CHFE
(Windows) E£1=I$T 358 (Mac) IZ#E1an b K512 YELT=,
WHERIERD OS: Dorico DEEIZIL macOS 10.12 Sierra LIBENARBE(ZHYE
L7,
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@ steinberg

ID# Component Issue
. . Inputting an articulation on a single note in chord mode no longer incorrectly also adds
STEAM-9074  Atticulations P nd @n ameuat 'ng'e noe In char ger! y
the same articulation to the next note in that voice.
Setting the Color property on a bar number now changes the color of the bar
STEAM-9142 Bar numbers 9 , P 'p Y . 9
number’s enclosure, if one is shown.
When casting off the music, if both bars of a 2-bar repeat or all four bars of a 4-bar
STEAM-9364 Bar repeats repeat do not fit on the system, that whole repetition will no longer be forced onto the
system.
Enabling consolidation of bar repeats in very large scores no longer sometimes
STEAM-9387  Bar repeats g co P ylarg 9
causes Dorico to crash.
. It is now possible to copy a time signature and all its associated special barlines at the
STEAM-0188  Barlines WP by g P
same time.
Chord Chord symbols whose position coincides with a change from one instrument to
STEAM-9215 .
symbols another on the same system are no longer drawn twice.
STEAM-9297 Cues Dragging cue labels in Engrave mode now draws the attachment line correctly.
STEAM-9341 Cues Microtonal accidentals now appear correctly in octave-shifted cues.
Dorico no longer draws th lef in the preambile if th lef matches th faul
STEAM-9462 Cues orico oogg d.a _stecuece the preamble if the cue clef matches the default
clef of the destination instrument.
STEAM-9744 Cues A problem whereby the wrong clef could be used for a cue has been fixed.
It was sometimes mysteriously impossible to create a dynamic at a position because
STEAM-5887  Dynamics > MYy yimp , y P
an empty dynamic group had been left there; these empty groups are now removed.
Some situations in which replacing a dynamic in an existing group, or appending a
STEAM-9202 Dynamics dynamicto the end of a group, would produce an unwanted extra dynamic have been
fixed.
p Under some circumstances, gradual dynamics could move further away from the staff
STEAM-9228 Dynamics . . . . L i
in galley view during note input; this problem has now been fixed.
Dynamics at the same position that are not part of the same group now play back
STEAM-9488 Dynamics Y P P group Py
correctly.
STEAM-9192 Filters Filter Notes by Pitch now works correctly on divisi staves.
. . Fingerings on grace notes now correctly respect the Follow voice direction
STEAM-9004 Fingering . .
engraving option.
Glissando The snapping of glissando lines when the note at either end of the glissando either
STEAM-4925 . . . .
lines becomes tied or becomes notated as a single note has been improved.
STEAM-9464 Grace notes Under some C|.r.cumstances, grace_a notes in transposed pltch layouts could appear in
the wrong position on the staff; this problem has now been fixed.
Graphics . L .
STEAM-7831 export Text in exported SVG files is no longer too small (Windows only).
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ID# Component Issue
Graphics Text items in exported PDFs no longer sometimes incorrectly use the stretch value
STEAM-9117 ) . .
export defined for a different text item.
Graphi Export All Layouts as PDF no longer incorrectly exports only the first page of each
STEAM-9346 raphics P y g y exp y pag
export layout.
Holds and Under some circumstances, edits to items in the vicinity of a fermata could cause the
STEAM-9362 : . - )
pauses distance between staves to increase unexpectedly; this problem has now been fixed.
Key Custom key signatures with per-clef octave overrides for accidentals now display
STEAM-9229 ) .
signatures correctly in the preamble at the start of each system.
Instrument change warning labels now use the language as chosen on the Language
STEAM-9261 Localization page of Engraving Options, rather than the language chosen for the application’s
interface.
. Under rare circumstances, Dorico could crash when processing lyrics; this problem has
STEAM-9169  Lyrics . P 9y P
now been fixed.
Exporting a project containing a trill after the 374th quarter note (crotchet) beat as a
STEAM-9212 MIDI export MIDI file no longer causes additional unwanted notes to be exported at the start.
Notes where Playback end offset is set to a large enough negative value that the end
STEAM-9381 MIDI export . .
of the note comes before their start positions are no longer exported to MIDI.
. Drum set music exported from Dorico via MIDI and then reimported is now correctl
STEAM-9023  MIDlimport . - &P P y
identified as being for drums.
Multi-bar Dorico no longer crashes when attempting to exclude single-bar multi-bar rests from
STEAM-9213 L . .
rests spacing in the presence of local time signatures.
Multi-bar Dorico will no longer show “tacet al fine” for a multi-bar rest that goes to the end of a
STEAM-9734 . ) " ) .
rests flow if a repeat marker is positioned at the final barline.
. When changing music font using Engrave » Music Fonts, Dorico now updates all
STEAM-9361 Music fonts . .
notehead sets, rather than only those notehead sets that are used in the project.
. Selecting an implicit rest and typing. or clicking the dot button in the note input toolbox
STEAM-5364  Note input g PHCILTe bping 9 . . P
now changes the rest’s duration as expected, rather than doing nothing.
. It is now possible to navigate the caret left or right across the position where one
STEAM-8950  Noteinput . possibie 9 . orng P
instrument transitions to another in page view.
. Pasting a selection that ends with non-note items would not always correctly extend the
STEAM-9197 Note input . s ; .
flow such that the last non-note item would appear; this problem is now fixed.
Glissando lines are no longer sometimes incorrectly overwritten or removed when
STEAM-9326  Note input \ ) 9 y
copying and pasting.
. Under some circumstances, pasting or repeating notes in one voice on a percussion kit
STEAM-9328  Note input . °€s, pasting or repeating note . AP
would incorrectly overwrite music in another voice; this problem is now fixed.
Under some circumstances, paste operations (including Reduce and Paste into
STEAM-9421 Note input Voice) could cause notes to be incorrectly placed inside tuplets; this problem is now
fixed.
. It is once again possible to invoke the caret at the end of the flow by selecting the
STEAM-9450  Note input gain p y 9

automatic final barline and typing Return or Shift+N.
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ID# Component Issue
. It is now possible to paste material onto an extra staff (e.g. an ossia) belonging to an

STEAM-9514  Note input nowp 0 Pz (eg ) belonging

unpitched percussion instrument.

. Edits to system indents made in Engrave mode are now correctly respected for

STEAM-9174  Note spacing y \ 9! y resp

systems where the first spaced position comes after the very start of the system.

Overriding the Voice column index property for a cross-staff note no longer
STEAM-9036 Notes sometimes causes one or more noteheads on the cross-staff stem to become

detached.
STEAM-9245 Notes In general, editing operations that affect the duration of a note no longer remove any
STEAM-9334 Forced Duration properties from that note unless absolutely necessary.

The Rhythm dot consolidation property now correctly takes precedence over the
STEAM-9289 Notes corresponding engraving option, so setting it for a chord will cause it to always take

effect.

Rhythm moved horizontall void note fl now correctly ignore the note-
STEAM-9477 Notes yt. dots .0 ed. orizontally to avoid note flags now correctly ignore the note-dot

gap if the note itself is scaled.

It is once again possible to create an inverted turn in the Shift+O popover by typin
STEAM-9395 Ornaments . ganp pop y typing

invturn.
STEAM-9239 Page layout Wait for next frame break now works as expected if applied to a frame break on a tacet.

Setting Wait for next system/frame break now always works correctly in layouts
STEAM-9354 Page layout . . o i .

where fixed casting-off, specifically a fixed number of systems per frame, is enabled.
STEAM-8433 Performance The Mixer window now opens more quickly, and updates more quickly when
STEAM-8892 hiding/showing different faders or sections.
STEAM-9092 Performance  The speed of loading sounds in NotePerformer has been increased.
STEAM-9389 Performance Editing music in p_rojects where I_arge time signatures are drawn outside the staff at

system item positions no longer incurs a performance penalty.

Inputting notes in a layout where bar rests are hidden (via Layout Options) is no longer
STEAM-9390  Performance Po 9 y (via Layout Options) g

much slower than when bar rests are shown as normal.

Dorico is now much more resilient to being flooded with MIDI data from external
STEAM-9502 egiriance devices, so it should no longer exhibit unusually high CPU usage or hang altogether.

It is now much faster to change between the different options in View » Note and Rest
STEAM-9021 Performance

Colors.

Clicking on a note in the piano roll editor with the selection tool no longer sometimes
STEAM-9118 Play mode . . .

incorrectly results in the note being deleted.

Swing is now calculated correctly for irregular or pick-up bars that start midway through
STEAM-9338  Play mode 9 y 9 pick-up y throug

a beat.

Deleting players in Setup mode no longer causes stale information to be left behind in
STEAM-9348  Play mode g pay >tup g

the Endpoint Setup dialog.

Duplicating a plug-in in the VST Instruments rack in Play mode now correctly creates
STEAM-9397  Play mode plicating a piug y y

the appropriate MIDI channels in the Mixer.
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ID# Component Issue
Dorico no longer crashes if you attempt to change an instrument to use a different
STEAM-9403 Play mode playback device in the track header after setting the MIDI channel to an invalid value.
Keyswitches and MIDI controllers are now output in the same order in which they are
STEAM-9405 Play mode defined in the VST Expression Map.
STEAM-9410 Play mode The mouse cursor now correctly changes after choosing a different tool in Play mode.
When jumping back to an earlier place in the music from a repeat, the tempo at the
STEAM-9428  Play mode T jumping P P P
destination is now correctly chased.
If explicit CC7 or CC10 automation data is present, the initial value from the MIDI fader
STEAM-9448 Play mode . L . . .
in the Mixer is no longer output in preference to the automation when starting playback.
Playing The size of playing techniques now correctly updates immediately according to a
STEAM-9290 . -
techniques change of staff size at a system break.
. The command Export All Layouts as PDF no longer incorrectly only exports the first
STEAM-9173 Print mode
page of each layout to PDF.
. ) Saving an auto-backup no longer causes Dorico to crash if the filename of the project
STEAM-9122 Project files . 9 . P 9 . proj
being saved contains an unmatched parenthesis.
Repeat A right-aligned repeat marker positioned at the final barline of the flow no longer
STEAM-9643 g . . . " - )
markers incorrectly collides with other items positioned within the final bar.
Rhythm Dragging the end handle of a slash region that crosses a start or end repeat barline no
STEAM-9270 .
slashes longer sometimes causes a crash.
Rhvthm Under some circumstances, where rhythm slash regions are present on multiple
STEAM-9475 sIaZhes staves, a slash region starting in the middle of a bar would not show correct rests; this
is now fixed.
Rhythm slashes no longer sometimes draw in the “out of range” color for instruments
STEAM-9508  <vthm .y ond g
slashes with large transpositions.
It is no longer possible to drag an instrument from a solo player and drop it onto a
Setup mode . . . . .
section player; section players can only hold a single instrument.
Slur on cross-staff notes no longer fail to draw if a staff has been removed by a staff
STEAM-9024 Slurs
count change.
STEAM-8776 Slurs. tuplets The positioning of slurs, tuplets and articulations on notes crossed to another staff is
STEAM-9264 1P now correct when extra staves belonging to the instrument are hidden.
The Show instrument change label at start of flow option is now switched on by
STEAM-9191 Staff labels . . L
default in part layouts, and only shows a label if the player holds multiple instruments.
Tempo equations whose width to the left of the barline is greater than the width to the
STEAM-9372 Tempo left of a coincident rehearsal mark no longer cause staves to unexpectedly be forced
apart.
L r diacriti ren ition rrectly; this al rr roblems with th
STEAM-6775 Text owe diac -|t_|cs_a e qw posmq ed co. ectly; this also corrects problems with the
vertical positioning of ligatures in the Figurato font (Mac only).
STEAM-6775 Text Stretching fonts now works correctly once more (Mac only).
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ID# Component Issue
Text items at grace note positions no longer cause collision avoidance to behave as if
STEAM-9367  Text 1S at grace Note postit ger ¢ 1S
the text item were in fact positioned at the primary position.
STEAM-9380 Text The positioning o_f mgltl-llne text |tem§ above the staff when the staff itself does not
have any protruding items has been improved.
Time Under some circumstances, typing Return with a barline selected in an open meter
STEAM-9193 . . ) . )
signatures could cause Dorico to crash; this problem is now fixed.
Tokens for resolving dates that show the day of the month as digits no longer include
STEAM-9115  Tokens g dates y g g
an extra space for single-digit days.
Resetting the beaming of a single-note tremolo no longer incorrectly causes that note
STEAM-9140 Tremolos g . 9 9 g y
to stop playing back.
Resetting the beaming of notes with two-note tremolos now correctly causes them to
STEAM-9178  Tremolos Seting nJ S W S now correctly catises
play back as normal, non-tremolo notes.
STEAM-9179 Tremolos Itis no longer possible to set both a single-note and multi-note tremolo on the same note.
STEAM-9253 Tremolos Clearing tremolos using the Shift+R popover now redoes correctly when undone.
Tremolos on up-stem notes on single-line percussion instruments are no longer
STEAM-9337 Tremolos P 9 . P . 9
needlessly snapped upwards to avoid staff lines that are not drawn.
STEAM-9113 User interface The status bar regd-out for theT transposit?qn of the current layout no longer sometimes
gets out of step with changes in transposition.
STEAM-9189 User interface Dorico will n(_)w correctly na\_/ig.ate. to the start of a. flow when clicking on its card in the
Flows panel in Setup mode if its first bar number is greater than 1.
STEAM-9207 User interf Navigating left or right through the music in galley view with Home/End no longer
i e I incorrectly uses the total width of the first flow to determine the amount to move.
. The Use custom player order control on the Players page of Layout Options is now
STEAM-9222 User interface . .
always correctly enabled or disabled as appropriate.
. Key commands typed while a modal Open or Save dialog is open no longer
STEAM-9279 User interface ) S
unexpectedly edits the project in the background (Mac only).
STEAM-9349 User interface .It is no Ionger possible to try to switch to galley view when no layout is currently visible
in the music area.
. It is no longer possible to resize the Mixer beyond the maximum size of its displayed
STEAM-9368  User interface . . ger poss 'z Xer bey Ximum size o 1is dispiay
faders.
. When switching to Play mode from Engrave mode, the buttons from the Engrave mode
STEAM-9397  User interface witehing fo ey naray he bu grav
toolbox no longer incorrectly appear in the toolbox in Play mode.
STEAM-9496 User interface Clicking one of the buttons in the toolbox in Engrave mode when no layout is currently

visible in the music area no longer causes Dorico to crash.
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